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前言

本用户指南介绍如何安装和使用 Sun StorEdge Configuration Service 程序，以对 Sun 
StorEdge FC 阵列进行配置、监控和管理。 

除非另有指定，否则 Sun StorEdge FC 阵列以下将称为阵列。本手册还参照了 Sun 
StorEdge 3000 Family Diagnostic Reporter，它是 Sun StorEdge 3000 Family 
Configuration Service 程序的一个伴随实用程序，能够向主机和阵列发送并接收来自主
机和阵列的系统消息。有关安装和使用 Diagnostic Reporter 的详细信息，请参阅 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南。

本手册是为已经熟悉 Sun 的硬件和软件产品的有经验的系统管理员编写的。

本书的组织结构
本书包含下列主题：

第 1 章介绍 Sun StorEdge 3000 系列 Configuration Service 特性。

第 2 章列出要遵循的步骤，以在安装和使用 Configuration Service 之前，确保阵列已
配置妥当。

第 3 章提供了在运行 Solaris™ 操作环境的系统上安装 Configuration Service Console 
和 Agent 的系统要求和过程。

第 4 章提供了在 Microsoft Windows NT/2000 操作系统上安装 Configuration Service 
Console 和 Agent 的系统要求和过程。

第 5 章提供了在运行 Linux 操作环境的系统上安装 Configuration Service Console 和 
Agent 的系统要求和过程。

第 6 章包含 Configuration Service 的设置过程。

第 7 章提供了配置阵列的指导。
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第 8 章介绍如何创建 LUN 过滤器，以维护共享公共存储设备的大型光纤信道网络。

第 9 章说明如何监控阵列。

第 10 章 说明如何维护阵列的完整性。

第 11 章说明如何对当前阵列配置进行更改或添加。

附录 A 提供基本的 RAID 信息。

附录 B 解释如何监控固件以及将其下载到独立的 JBOD （仅限 SCSI）。

附录 C 提供有关设置群集配置的信息。

附录 D 介绍如何确定运行 Solaris 操作环境和 Microsoft Windows NT 的系统上的主机
全球广域名称 (WWN)。

附录 E 解释如何设置完整的事件监控和电子邮件通知功能。

附录 F 提供针对一系列症状的故障检修建议。

附录 G 包含一个 Configuration Service 错误代码和消息列表。

词汇表包含一个与 Configuration Service 有关且在本用户指南中用到的缩略语和名词
术语列表。
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使用 UNIX 命令
本文档可能没有包含有关基本 UNIX® 命令和步骤的信息，诸如关闭系统、引导系统以
及配置设备。

有关该信息，请参阅以下一个或多个文档：

■ Solaris Handbook for Sun Peripherals
■ Solaris 操作系统的 AnswerBook2™ 联机文档
■ 您的系统附带的其他软件文档

印刷惯例

字体*

* 您所用浏览器的设置可能与这里的设置不同。

意义 示例

AaBbCc123 命令、文件和目录的名称；计算
机屏幕输出

编辑您的 .login 文件。

使用 ls -a 来列出所有的文件。

% You have mail.

AaBbCc123 键入内容，与计算机屏幕输出相

区别

% su

Password:

AaBbCc123 书名、新词或新术语、要进行强
调的词。使用真正的名称或值替

换命令行参数。

请阅读 《用户指南》的第 6 章。

这些称作类 选项。

必须 是超级用户才能执行此操作。

要删除文件，请键入 rm 文件名。
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Shell 提示符

相关文档

Shell 提示符

C shell 机器名称 %

C shell 超级用户 机器名称 #

Bourne shell 和 Korn shell $

Bourne shell 和 Korn shell 超级用户 #

标题 部件号

Sun StorEdge 3000 Family Release Notes 816-7301

Sun StorEdge 3000 系列安装、操作和维护手册 816-7300

Sun StorEdge 3000 系列最佳做法手册 816-7325

Sun StorEdge 3000 Family Release Notes 816-7301

Sun StorEdge 3000 Family RAID Firmware User's Guide 816-7934

Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南 816-7932

Sun StorEdge 3000 系列机架安装指南 816-7320

Sun StorEdge 3000 系列 FRU 安装指南 816-7326

Sun StorEdge 3000 系列安全性、管制性和遵从性手册 816-7930
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技术支持
要获得最新的新闻和故障检修的提示，请检查位于相应目录中的与您的阵列相关的 
Release Notes： 

www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/3510

要获得对基于 Web 支持解决方案的 24 小时的访问，请访问联机支持中心，位于： 

www.sun.com/service/online

要获得全球支持电话号码以及如何在线提交支持请求的信息，请拨打 1-800-USA-4SUN 
或访问站点：

www.sun.com/service/contacting

联机访问 Sun 文档
所有的 Sun StorEdge 3510 FC 阵列文档都以 PDF 和 HTML 两种格式存放于以下两个
位置：

http://www.sun.com/products-n-solutions/ 
hardware/docs/Network_Storage_Solutions/Workgroup/3510

注意 – 您可以在上述位置一次下载完整的 HTML 文档。

http://www.sun.com/documentation

也可以在网上订购印刷的 Sun StorEdge 3510 FC 阵列手册：

http://corppub.iuniverse.com/marketplace/sun
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508 可访问特性
Sun StorEdge 文档中提供了符合 508 标准的 HTML 文件，通过使用辅助技术程序，那
些视觉有障碍的人员也可以使用这些文件。您的产品文档 CD 以及第 xxi 页的 “联机
访问 Sun 文档”下介绍的 Web 站点中提供了这些文件。此外，软件和固件应用程序还
提供了键盘导航和快捷键功能，这些功能在用户指南中进行介绍。

Sun 欢迎您提出意见和建议
Sun 乐于对其文档进行改进，欢迎您提出意见和建议。您可以通过下面的电子邮件地址
将意见发给 Sun：

docfeedback@sun.com

请在电子邮件的主题行中包含文档的部件号 (817-2773-10)。
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第 章1

介绍

本节简要概述了 Sun StorEdge 3000 系列 Configuration Service 功能。

注意 – Sun StorEdge 3000 系列 Configuration Service 以下被称为 Configuration Service 
或 该程序。

Configuration Service 是一个基于 Java™ 编程语言的复杂程序，它将存储配置、资源分
配、维护和监控工具集成到一个应用程序中，实现对阵列的集中管理。

仅通过网络中的单一控制台，系统管理员就能够通过直观的图形用户界面 (GUI) 初始化
网络存储设备，更改配置，监控状态并调度例程维护。

管理员还可以根据随全网络存储需求变化而改变的存储要求，动态地分配、重新分配或
扩展容量。  

一旦状态发生变化，Configuration Service 就通过控制台显示、电子邮件或数字字符寻
呼机发送警示。 Configuration Service 还可以将警示发送到任何简单网络管理协议 
(SNMP) 企业管理器 （例如 HP OpenView）。  
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Configuration Service 由两部分组件构成：

■ Configuration Service Agent － Solaris 8 和 Solaris 9 操作环境、Microsoft Windows 
NT 和 Windows 2000、 Sun™ Linux 5.0 以及 Red Hat Linux 7.2 和 7.3。

此代理监控连接的磁盘存储设备，并向控制台报告这些设备的状态。需要在作为 
Configuration Service 网络一部分的每台独立服务器上安装代理软件。可以从网络
中的单一工作站通过远程方式完成安装。 

■ Configuration Service Console － Solaris 8 和 Solaris 9 操作环境、 Microsoft 
Windows NT 和 Windows 2000、 Sun Linux 5.0 以及 Red Hat Linux 7.2 和 7.3。

控制台是由 Configuration Service 的 GUI 部分构成的，用来显示代理报告的信息。
控制台还提供了从单一工作站对设备进行远程配置和管理的功能。需要将 
Configuration Service Console 安装在网络中管理服务器的计算机上。
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第 章2

开始之前

本章包含了一些在安装和使用 Configuration Service 程序以及使用用户指南之前必须
了解的重要信息。本章包含以下主题：

■ 第 3 页的 “哪个版本的 Configuration Service 适用于您的阵列？”
■ 第 4 页的 “关于示例屏幕”
■ 第 4 页的 “Solaris 操作环境”
■ 第 4 页的 “Microsoft Windows NT/2000 操作系统”
■ 第 4 页的 “超级用户 / 管理员特权”

哪个版本的 Configuration Service 适用于
您的阵列？
下表显示了各版本的 Configuration Service 对于各种 Sun StorEdge 阵列的适用情况。

表 2-1 适用的 Configuration Service 版本

Configuration 
Service 版本 适用的 Sun StorEdge 阵列 注释

1.0 Sun StorEdge 3310 SCSI 阵列 最初的仅支持 SCSI 的 Configuration Service 
版本。

1.2 Sun StorEdge 3510 FC 阵列 Configuration Service 程序和用户指南已经通
过光纤信道功能 （其中包括 LUN 过滤功能）

进行了更新。
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关于示例屏幕
本指南中提供了许多示例屏幕以演示 Configuration Service 程序。这些屏幕在输出中
可能会标识出 Sun StorEdge 3310 阵列或 Sun StorEdge 3510 阵列。除非特别声明某项
功能 （及其示例屏幕）是 Sun StorEdge 3510 FC 阵列所特有的，否则表示该功能对两
种阵列都适用。

Solaris 操作环境
在将 Configuration Service 安装在运行 Solaris 操作环境的系统之前：

■ 确保安装有 Configuration Service Agent 的主机服务器已连接到一个分配有主信道 
ID 的信道上。请参考适用于您的阵列的 Sun StorEdge 3000 系列安装、操作和维护
手册，了解控制器默认值和初始配置信息。

■ 对于 Sun StorEdge 3310 SCSI 阵列，请确保操作环境能够识别同一 ID 下的多个 
LUN。您可能需要为附加的主机 LUN 分配修改 /kernel/drv/sd.conf。有关如
何修改此文件的信息，请参考适用于您的 SCSI 阵列的 Sun StorEdge 3000 系列安
装、操作和维护手册。如果您对 sd.conf 文件做了任何修改，则需要重新引导工作
站才能使所作的修改生效。

Microsoft Windows NT/2000 操作系统
在将 Configuration Service 安装在 Microsoft Windows 操作系统之前：

■ 确保安装有 Configuration Service Agent 的主机服务器已连接到一个分配有主信道 
ID 的信道上。请参考适用于您的阵列的 Sun StorEdge 3000 系列安装、操作和维护
手册，了解控制器默认值和初始配置信息。

■ 确保服务器已连接到操作系统，而且服务器能够识别存储设备。

超级用户 / 管理员特权
必须拥有超级用户或管理员特权才能够安装 Configuration Service 并运行 
Configuration Service Console。
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第 章3

将 Configuration Service 安装在运行 
Solaris 操作环境的系统上

本章提供了在运行 Solaris 操作环境的系统上安装 Configuration Service Console 和 
Agent 的过程。本章包含下列主题：

■ 第 5 页的 “系统要求”
■ 第 6 页的 “安装 Configuration Service 之前”
■ 第 7 页的 “安装软件”
■ 第 13 页的 “用户和密码”
■ 第 15 页的 “卸装 Configuration Service”
■ 第 15 页的 “恢复配置”

系统要求
■ Netscape™ 4.0 或更高版本 － 用于查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 － 每个 Configuration Service Console 必须具有符合 
TCP/IP 的网络接口 （诸如以太网或令牌环网卡，或带有调制解调器的串行线路）。 

■ Configuration Service Console 在设置为 800 x 600 像素显示器分辨率和 256 色时可
获得最佳查看效果。有关控制台的其他要求，请参阅下表。
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■ 符合 TCP/IP 的代理网络接口 － 每个 Configuration Service Agent 必须具有支持 
TCP/IP 协议的网卡接口和驱动程序集 （包含在操作环境中）。有关其它代理要求，
请参阅下表。

安装 Configuration Service 之前
在安装 Configuration Service 及其它相关软件组件前，应注意以下必需的过程和附加
选项。

■ 请务必阅读适用于您的阵列的 Sun StorEdge 3000 Family Release Notes。

■ 安装操作环境更新程序。要在运行 Solaris 操作环境的系统上使用 Configuration 
Service，需要安装 Sun 建议的最新操作环境修补程序和用于 Solaris 8 和 Solaris 9 
操作环境的 Java 修补程序。有关 Sun 所建议修补程序的列表，请参阅适用于您的阵
列的 Sun StorEdge 3000 Family Release Notes。 

■ 如果操作环境包含企业管理控制台，则可以选择将 Configuration Service Agent 配
置为通过 SNMP 服务将陷阱事件发送到控制台。 SNMP 服务是操作环境附带的，并
在安装 TCP/IP 协议栈后安装。

■ 如果要让网络上的 Configuration Service 服务器将 SNMP 陷阱发送到企业管理控制
台，请参阅第 211 页的 “电子邮件和 SNMP”。

■ 可选项。要安装并使用 Sun StorEdge Diagnostic Reporter （这是 Configuration 
Service 的一个协作实用程序，能够将存储系统事件报告给指定的邮件地址），请参
阅 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

注意 – 必须是超级用户才能够安装 Configuration Service 并运行 Configuration 
Service Console。

表 3-1 控制台系统要求 

Solaris 操作环境版本 内存 磁盘空间

安装了 Sun 所建议的修补程
序的 Solaris 8 和 9。
（有关 Sun 建议的修补程序
的列表，请参阅适用于您的

阵列的 Sun StorEdge 3000 
Family Release Notes。）

建议 64 MB 16 MB 的最小可用磁盘空间

表 3-2 代理系统要求 

Solaris 操作环境版本 内存 磁盘空间

Solaris 8 和 Solaris 9 128 MB （最少） 1 MB （可用磁盘空间）（最少）
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安装软件
Configuration Service 软件由下列组件构成：

■ Configuration Service Agent

■ Configuration Service Console

■ Diagnostic Reporter （可选实用程序 － 有关安装和操作的详细信息，请参阅 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南）

Configuration Service 安装软件包

Configuration Service 安装软件包包含在 Sun StorEdge 300 Family Professional 
Storage Manager CD 上，其中包括下列文件：

■ SUNWscsd － Configuration Service Agent
■ SUNWscsu － Configuration Service Console
■ SUNWscsa － Diagnostic Reporter Agent
■ SUNWscui － Diagnostic Reporter Config Tool (UI)
■ SUNWsccli － Command Line Interface (CLI)
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▼ 安装 Configuration Service Agent 和 Console 
在作为 Configuration Service 一部分的每台服务器上安装代理。在计划用于管理和维
护存储系统的计算机或工作站上安装控制台。

Configuration Service 管理控制台软件包 (SUNWscsu)，可以安装在服务器或任何客户
机系统上。 Configuration Service Agent 软件包 (SUNWscsd)，必须安装在连接存储设
备的服务器上。

完成下列步骤以安装代理、控制台，或者两者都安装。必须至少安装一个代理和一个控
制台以使 Configuration Service 运行。

注意 – 确保在要安装 Configuration Service 的计算机或工作站上已安装了 Java 运行时
环境 1.2 或更高版本。 

注意 – 在升级控制台或代理时，必须卸装 Configuration Service。有关卸装 
Configuration Service 的详细信息，请参阅第 15 页的 “卸装 Configuration 
Service”。

1. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 并键入

2. 使用下列方式之一安装软件包：

a. 如果只安装代理，则应键入

b. 如果只安装控制台，则应键入

c. 如果安装所有软件包，则应键入

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWscsu

# pkgadd -d . all
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d. 要从菜单中选择要安装的软件包，应键入

e. 如果只安装两个代理 （Configuration Service 和 Diagnostic Reporter），请键入

3. 在每个标准安装提示出现时，提供相应的响应。

安装提示都是标准的 pkgadd -d 提示，用于控制所要安装的软件包以及处理脚本的
方式 （使用超级用户特权）。

a. 在 Select 软件包提示处，根据安装方法的不同键入相应的响应。 

例如，如果选择 2a 或 2b，则键入 1 并按 Return。

b. 如果您以前安装过该代理，则将询问您是否要恢复其配置。

键入 y 可以恢复配置。如果键入 n，则需要重新启用管理服务器。

注意 – 卸装 Configuration Service 时会删除用户密码。如果有以前的配置，则必须重
新输入 ssmon、 ssadmin 和 ssconfig 密码，如第 13 页的 “用户和密码”中所述。

c. 如果您以前安装过该控制台，则将询问您是否要恢复其配置。

按 y 可以恢复配置。如果键入 n，需要重新添加服务器信息。

# pkgadd -d .

# pkgadd -d .SUNWscsd SUNWscsa

Select package(s) you wish to process (or ‘all’ to process all 
packages). (default:all) [?,??,q]: 1

The previous configuration was saved.User passwords must be 
reentered.Do you want to restore the configuration [y,n,?,q]:y

The previous configuration was saved.Do you want to restore the 
configuration [y,n,?,q]:y
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d. 要继续安装，请键入 y 并按 Return。

安装完代理以后，将显示以下信息，指示代理已经成功安装并且已经启动。 

安装程序检查是否安装了 Java 运行时环境 1.2 或更高版本。如果未能发现该运行时环
境，将要求您指定路径。如果您确定已经安装了 Java 运行时环境 1.2.2、 1.3 或 1.4，而
安装程序却没有找到它，请检查 /usr 目录以确认存在从 Java 到最新版本的链接，而
不是 Java 1.1。要获得有关创建链接的指示，请参阅第 223 页的 “故障检修”。

Configuration Service Agent 和 Configuration Service Console 安装在下面的目录中：
/opt/SUNWsscs/sscsconsole。

Do you want to continue with the installation [y,n,?] y

Configuring and starting Sun StorEdge(tm) Configuration Service 
agent daemons:
       The configuration is complete.
       Sun StorEdge(tm) Configuration Service agent server daemon 
has started.
       Sun StorEdge(tm) Configuration Service agent monitor daemon 
has started.
Sun StorEdge(tm) Configuration Service agent startup is complete.

Installation of <SUNWscsd> was successful.
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4. 要访问 Configuration Service 联机帮助，您需要指定指向 Web 浏览器 （Netscape 
4.0 或更高版本）的路径。

a. 转到 /opt/SUNWsscs/sscsconsole 并键入 

b. 键入指向 Web 浏览器的绝对路径。

注意 – 可以随时配置浏览器路径名称；但是，如果不指定某一点的浏览器路径名称，
将无访问联机帮助。

5. 对于 Sun StorEdge 3310 SCSI 阵列，请编辑 /kernel/drv/sd.conf，条件是：

■ 使用带有多个驱动器和多个 LUN 的第三方 HBA
■ 使用光纤设备
■ 所有的 LUN 都具有相同的 ID

根据您的配置为逻辑单元号 (LUN) 添加行。 LUN 可以编号为 0 到 31。一般来说，添
加的 LUN 定义不应多于实际计划的数目，因为这样会增加扫描每个 SCSI 总线花费的
时间，而无论存储设备是否连接。有关修改 sd.conf 文件的信息，请参阅适用于您的 
SCSI 阵列的 Sun StorEdge 3000 系列安装、操作和维护手册。

6. 编辑完 sd.conf 文件之后，请执行重新配置重新引导。

./config_sscon
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▼ 启动或停止 Configuration Service Agent
通过在 /etc/init.d/ssagent 中使用运行命令脚本可以手动停止和启动 
Configuration Service Agent。

1. 要启动代理，请键入

注意 – 要启动代理，必须具有超级用户特权并且必须使用 Bourne shell。

如果使用 start 之前，没有先使用 stop，则脚本将重新启动所有已经停止的代理。
如果所有的代理都已经停止 （如使用了 stop 选项），则脚本将在重新启动代理之前重
新配置运行时环境。

2. 要停止代理，请键入

3. 要确定代理是否正在运行，请键入

ssmon 和 ssserver 两者都会显示在输出中。如果已经启用了 SNMP 陷阱生成，则还
会看到名称 sstrapd。

4. 如果在初始引导后没有显示存储系统，则应停止代理，并在命令行提示符处运行

5. 为需要的磁盘加卷标，然后重新启动 Configuration Service Agent。

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# format
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用户和密码

管理 （用户）安全级别和准则

如果在使用 Solaris 操作环境的系统上运行 Configuration Service 应用程序，则将在安
装过程中自动创建管理员安全级别。只需要根据所需的权限级别设置密码并指定用户。 

Configuration Service 管理功能要求访问登录名和密码，以防止某个管理员未经授权重
新分配或删除了属于其他客户机或主机的存储资源。 

应为 Configuration Service 程序的三个安全级别分别指定密码。这是通过在具有由 
Configuration Service 管理的存储设备代理上创建三个用户实现的。这三个用户是在安
装 Configuration Service Agent 过程中自动添加的。

Configuration Service 安全级别必须具有以下三个名称： 
■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule Parity Check 
以及监控功能的访问。 

■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些登录名称。安装后，必须为每个安全名称分配密码。

ssmon、ssadmin 和 ssconfig 是只对应到 Configuration Service 内安全级别的登录
名。对于 UNIX 操作环境 （Solaris/Linux 操作环境），这些帐户的默认 Shell 将被指
定为 /bin/false，以防止用户 ID 被用于交互式登录。

可以设置 Configuration Service，从而使监控不需要用户键入 ssmon 密码。这可以通
过在 Configuration Service Console 上将服务器添加到 Managed Servers 列表时选择 
Auto Discovery 选项来实现。可以在每台服务器上以本地方式设置这三个登录名称和
密码。（如果需要，这些帐户可以在每台服务器上具有不同的密码。） 

只要在这些被管理的代理上设置了这三个登录名，系统管理员通常就能够通过向员工分
配相应的密码提供对 Configuration Service 的用户访问。例如，为特定服务器上具有
管理特权的每个用户都分配为用户 ssadmin 建立的相同密码。

注意 – 要将服务器添加到 Managed Servers 列表，请参阅第 37 页的“添加服务器”。
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▼ 创建密码和权限

要为每个新用户创建密码，应键入 

管理员可能还想更改组权限，组权限位于安装期间创建的 
/opt/SUNWsscs/sscsconsole 目录内的 svrlist.dat 文件中。 

Configuration Service Console 是基于 Java 的实用程序，因此不能提供用于控制 
Configuration Service 创建的文件的权限和所有权的功能。svrlist.dat 文件容易被
不同形式的 ASCII 文本处理器读取。其中包括用户 ssmon 的加密密码，也可以解密。 

注意 – 在添加所监控的所有代理之后，不要更改 svrlist.dat 的权限以及组所有权。

# passwd user-name
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卸装 Configuration Service 
在升级控制台或代理时，必须卸装 Configuration Service。注意有些文件不会被删除，
因为它们是在安装后创建的，并且仍对升级环境有效。

▼ 卸装 Configuration Service
使用 pkgrm 命令 （后面跟有想要卸装的 Configuration Service 软件包）、 SUNWscsu
（控制台）或 SUNWscsd（代理）。 

恢复配置
如果重新安装代理或控制台，则在安装过程中将询问您是否要恢复配置。如果选择恢复
配置，则将从下列文件中恢复信息：

■ /var/opt/SUNWsscs/sscsagt.cfg.tar － Configuration Service Agent

■ /var/opt/SUNWsscs/sscscon.cfg.tar － Configuration Service Console

注意 – 如果要永久性地删除 Configuration Service，您可能需要手动删除这些文件；
但是，如果您重新安装 Configuration Service，将不能恢复代理和控制台配置。

# pkgrm SUNWscsu

# pkgrm SUNWscsd
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第 章4

将 Configuration Service 安装在 
Microsoft Windows NT/2000 操作
系统上

本章提供了 Configuration Service Consoles 和 Agent 在 Windows NT/2000 操作系统
上的系统要求和安装过程。本章包含下列主题：

■ 第 17 页的 “系统要求”
■ 第 18 页的 “安装 Configuration Service 之前”
■ 第 18 页的 “安装软件”
■ 第 20 页的 “用户和密码”
■ 第 22 页的 “卸装 Configuration Service”

系统要求
■ Netscape 4.0 或更高版本，或者 Microsoft Internet Explorer 4.0 或更高版本 － 用于

查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 － 每个 Configuration Service Console 必须具有符
合 TCP/IP 的网络接口 （诸如以太网或令牌环网卡，或串行线调制解调器）。有关
其它控制台要求，请参阅下表。

表 4-1 控制台系统要求

操作系统版本 内存 磁盘空间

Microsoft Windows NT 4.0
（SP 3 或更高版本）

Microsoft Windows 2000

32 MB （最少）

建议 64 MB
20 MB 的最小可用磁盘空间

建议 40 MB
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■ 符合 TCP/IP 的代理网络接口 － 每个 Configuration Service Agent 必须具有 
TCP/IP 功能网卡接口和驱动程序集 （包括在操作系统中）。有关其它代理要求，请
参阅下表。

安装 Configuration Service 之前
在安装 Configuration Service 及其它相关软件组件前，应注意以下必需的过程和附加
选项。

■ 请务必阅读适用于您的阵列的 Sun StorEdge 3000 Family Release Notes。

■ 如果操作环境包含企业管理控制台，则可以选择将 Configuration Service Agent 配
置为通过 SNMP 服务将陷阱事件发送到控制台。 SNMP 服务是操作环境附带的，并
在安装 TCP/IP 协议栈后安装。

■ 如果想要让网络上的 Configuration Service 服务器将 SNMP 陷阱发送到企业管理控
制台，请参阅第 211 页的 “电子邮件和 SNMP”。

■ 可选项。要安装并使用 Sun StorEdge Diagnostic Reporter （这是一个 
Configuration Service 附带应用程序，能够将存储系统事件报告给指定的邮件地
址），请参阅 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

注意 – 必须是管理员才能够安装 Configuration Service 并运行 Configuration Service 
Console。

安装软件
Configuration Service 软件包含下列组件：

■ Configuration Service Agent

■ Configuration Service Console

表 4-2 代理系统要求

操作系统版本 内存 磁盘空间

Microsoft Windows NT 4.0
（Service Pack 3、4、5 或 6）
Microsoft Windows 2000

32 MB （最小），建议使用 64 MB 或更多
内存。要求是由其他诸如数据库等大型应用

程序决定的。

2 MB （可用磁
盘空间）
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■ Diagnostic Reporter （可选实用程序 － 有关安装和操作的详细信息，请参阅 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南）

在每台由 Configuration Service 管理其存储设备的服务器上安装代理。在计划用于管
理和维护系统存储的计算机或工作站上安装控制台。

Configuration Service 安装软件包

Configuration Service 安装软件包 (setup.exe) 包含在 Sun StorEdge 3000 Family 
Professional Storage Manager CD 上，其中包括下列组件：

■ Sun StorEdge Configuration Service Agent

■ Sun StorEdge Configuration Service Console

■ Sun StorEdge Diagnostic Reporter

■ Sun StorEdge Command Line Interface

▼ 安装 Configuration Service Agent 和 Console 
需要在每台由 Configuration Service 管理其存储设备的 Microsoft Windows NT/2000 
服务器上安装 Configuration Agent。 

注意 – 确保在要安装 Configuration Service Console 的计算机或工作站上已安装了 
Java 运行时环境 1.2 或更高版本。 

1. 为确保软件安装实用程序工作最优化，须关闭所有的 Windows 应用程序。

2. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 并转到 \
product\windows 目录。

3. 双击 setup.exe 并选择要安装的软件组件：SUNWsscs Agent 或 SUNWsscs 
Console。

4. 在 Choose Destination Location 窗口上，安装默认文件夹并单击 Next。代理将安装
在 C:\Program Files\Sun\ssagent 中；控制台将安装在 C:\Program Files\
Sun\sscs 中。

要安装到不同的文件夹，可以单击 Browse，选择另一个文件夹，并单击 Next。 

安装完成后，代理将自动启动。
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▼ 启动或停止 Configuration Service Agent

Microsoft Windows NT 服务器

要在服务器上启动 Configuration Service Agent 软件，必须重新引导服务器或启动三
个 Configuration Service 服务：SUNWscsd Startup、 SUNWscsd Server 和 
SUNWscsd Monitor （位于 Settings → Control Panel → Services。） 

要停止 Configuration Service Agent，须转到 Settings → Control Panel → Services，
选择想要停止的代理，单击 Stop。

Microsoft Windows 2000 Server 服务器

1. 选择 Start → Administrative Services → Computer Management。 

2. 单击 Services & Applications。

3. 右键单击要启动或停止的服务 （SUNWscsd Monitor、 SUNWscsd Server、
SUNWscsd Startup）。 

另外也可以使用 Start → Settings → Control Panel → Admin Tools → Computer 
Management。 

用户和密码 

管理员 （用户）安全级别和准则

Configuration Service 管理功能要求访问登录名和密码，以防止某个管理员未经授权重
新分配或删除了属于其他客户机或主机的存储资源。应为 Configuration Service 的三
个安全级别指定独立的密码。这是通过在具有由 Configuration Service 管理的存储设
备代理上创建三个用户实现的。 

Configuration Service 安全级别必须具有以下三个名称： 
■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule Parity Check 
以及监控功能的访问。 
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■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些名称。安装后，必须为每个安全名称分配密码。

ssmon、 ssadmin 和 ssconfig 是只对应到 Configuration Service 内安全级别的
登录。

可以设置 Configuration Service，从而使监控不需要用户输入 ssmon 密码。这可以通
过在 Configuration Service Console 上将服务器添加到 Managed Servers 时选择 Auto 
Discovery 选项来实现。可以在每台服务器上以本地方式设置这三个登录名称和密码。
（这些帐户可以在每台服务器上具有不同的密码。） 

只要在这些要被管理的代理上设置了这三个登录名，系统管理员通常就能够通过向员工
分配相应的密码提供对 Configuration Service 的用户访问。例如，为特定服务器上具
有管理特权的每个用户都分配了为用户 ssadmin 建立的相同密码。

注意 – 要将服务器添加到 Managed Servers 列表，请参阅第 37 页的“添加服务器”。

多台服务器上的全局密码

如果已经具有一个庞大的网络，而不想单独设置登录名，并且可以接受在多台服务器上
使用相同的密码，则可以在 Microsoft Windows 下的域服务器上建立三个登录名。从
而使 Microsoft Windows 域中的其他所有服务器都能够用它们相应的密码访问三个登
录名。

▼ 创建 Microsoft Windows NT 用户

1. 使用 NT User Manager 程序添加用户。 

2. 选择 Policies 然后选择 User Rights。 

3. 选择 Show Advanced User Rights。

4. 向 NT User Administrator（NT 用户管理员）赋予作为操作系统的一部分行事的权限。

5. 在 User Properties 下，取消选择 User Must Change Password at Next Login。

6. 在 User Properties 下，选择 User Cannot Change Password 和 Password Never 
Expires。

7. 如果计划在域服务器上建立用户名从而不需要多服务器设置，应确保要管理的服务器属
于在其中建立 Configuration Service 用户帐户的域。

请参阅 Microsoft Windows NT 文档，以获得详细信息。
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▼ 创建 Microsoft Windows 2000 用户

1. 在 Under Settings → Control Panel → Administrative Tools → Computer Management → 
System Tools → Local Users and Groups 下，选择 Users。

2. 右键单击 Users 文件夹并选择 New User 以增加三个用户 （ssmon、 ssconfig 和 
ssadmin）。

3. 在 User 名称下添加其中一个用户。如果需要可以在 Description 下输入说明。

4. 输入密码，如果需要，可以选择 User Cannot Change Password 和 Password Never 
Expires。

卸装 Configuration Service
使用 Windows Add/Remove Programs 实用程序从 Microsoft Windows Console 删除 
Configuration Service。 

▼ 卸装 Configuration Service
1. 转到 Start → Settings → Control Panel → Add/Remove Programs。

2. 选择 Configuration Service Agent 并选择 Add/Remove。对提示做出相应的响应。

3. 选择 Configuration Service Console 并选择 Add/Remove。对提示做出相应的响应。
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第 章5

将 Configuration Service 安装在运行 
Linux 操作环境的系统上

本章提供了在运行 Sun Linux 或 Red Hat Linux 操作环境的系统上安装 Configuration 
Service Console 和 Agent 的过程。本章包含下列主题：

■ 第 23 页的 “系统要求”
■ 第 24 页的 “安装 Configuration Service 之前”
■ 第 24 页的 “安装软件”
■ 第 28 页的 “用户和密码”
■ 第 30 页的 “卸装 Configuration Service”

系统要求
■ Netscape™ 4.0 或更高版本 － 用于查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 － 每个 Configuration Service Console 必须具有符合 
TCP/IP 的网络接口 （诸如以太网或令牌环网卡，或串行线调制解调器）。 

■ Configuration Service Console 在设置为 800 x 600 像素显示器分辨率和 256 色时可
获得最佳查看效果。有关其它控制台要求，请参阅下表。

表 5-1 控制台系统要求 

 Linux 版本 内存 磁盘空间

Sun Linux 5.0
Red Hat® Linux 7.2 和 7.3

256 MB （最少） 10 MB
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■ 符合 TCP/IP 的代理网络接口 － 每个 Configuration Service 代理必须具有 TCP/IP
功能网卡接口和驱动程序集（包括在操作环境中）。有关其它代理要求，请参阅下表。

安装 Configuration Service 之前
在安装 Configuration Service 及其它相关软件组件前，应注意以下必需的过程和附加
选项。

■ 请务必阅读适用于您的阵列的 Sun StorEdge 3000 Family Release Notes。

■ 如果操作环境包含企业管理控制台，则可以选择将 Configuration Service Agent 配
置为通过 SNMP 服务将陷阱事件发送到控制台。 

■ 如果想要让网络上的 Configuration Service 服务器将 SNMP 陷阱发送到企业管理控
制台，请参阅第 211 页的 “电子邮件和 SNMP”。

■ 可选项。要安装并使用 Sun StorEdge Diagnostic Reporter （这是一个 
Configuration Service 附带应用程序，能够将存储系统事件报告给指定的邮件地
址），请参阅 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

注意 – 必须是超级用户才能够安装 Configuration Service 并运行 Configuration 
Service Console。

安装软件
Configuration Service 软件由下列组件构成：

■ Configuration Service Agent

■ Configuration Service Console

■ Diagnostic Reporter （可选实用程序 － 有关安装和操作的详细信息，请参阅 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南）

表 5-2 代理系统要求 

Linux 版本 内存 磁盘空间

Solaris 8 和 Solaris 9 128 MB （最少） 1 MB
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Configuration Service 安装软件包

Configuration Service 安装软件包包含在 Sun StorEdge 300 Family Professional 
Storage Manager CD 上，其中包括下列文件：

■ SUNWscsu.rpm － Configuration Service Console
■ SUNWscsd.rpm － Configuration Service Agent
■ SUNWscsa.rpm － Diagnostic Reporter Agent
■ SUNWscui.rpm － Diagnostic Reporter Config Tool (UI)
■ SUNWsccli.rpm － Command Line Interface (CLI)

▼ 安装 Configuration Service Agent 和 Console 
在作为 Configuration Service 一部分的每台服务器上安装代理。在计划用于管理和维
护存储系统的计算机或工作站上安装控制台。

Configuration Service 管理控制台软件包 (SUNWscsu.rpm)，可以安装在服务器或任何
客户机系统上。 Configuration Service Agent 软件包 (SUNWscsd.rpm)，必须安装在
连接存储设备的服务器上。

完成下列步骤以安装代理、控制台，或者两者都安装。必须至少安装一个代理和一个控
制台以使 Configuration Service 运行。

注意 – 确保在要安装 Configuration Service 的计算机或工作站上已安装了 Java 运行时
环境 1.2 或更高版本。 

1. 如果正在其上安装 Configuration Service 的计算机或工作站上没有安装 Java 运行时
环境 1.2 或更高版本，请立即安装。

2. 如果您的文件系统上尚未安装 CD ROM，请先安装它。

3. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 并键入

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux
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4. 使用下列方式之一安装软件包：

a. 如果只安装代理，则应键入

b. 如果只安装控制台，则应键入

5. 要访问 Configuration Service 联机帮助，则必须在安装控制台的系统上安装 Web 浏
览器。如果没有检测到 Web 浏览器，将要求您指定指向 Web 浏览器 （Netscape 4.0 
或更高版本）的路径。

a. 转到 /opt/SUNWsscs/sscsconsole 并键入 

b. 键入指向 Web 浏览器的绝对路径。

注意 – 可以随时配置浏览器路径名称；但是，如果不指定某一点的浏览器路径名称，
将无访问联机帮助。

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm

./config_sscon
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安装完代理以后，将显示以下信息指示组件已经成功安装并且已经启动。 

安装完控制台以后，将显示以下信息指示组件已经成功安装并且已经启动。

Configuration Service Agent 和 Console 安装在下面的目录中：
/opt/SUNWsscs/sscsconsole。

▼ 启动或停止 Configuration Service Agent
通过在 /etc/init.d/ssagent 中运行命令脚本可以手动停止和启动 Configuration 
Service Agent。

1. 要启动代理，请键入

或者

注意 – 要启动代理，必须具有超级用户特权。

如果使用了 start 前，没有先使用 stop，则脚本将重新启动所有已经停止的代理。
如果所有的代理都已经停止 （如使用了 stop 选项），则脚本将在重新启动代理之前重
新配置运行时环境。

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon 
add user ssadmin add user ssconfig Configuring and starting Sun 
StorEdge(tm) Configuration Service daemons[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent monitor 
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%] 
Installation completed successfully!

# /etc/init.d/ssagent start

# service ssagent start
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2. 要停止代理，请键入

3. 要确定代理是否正在运行，请键入

或者

ssmon 和 ssserver 两者都会显示在输出中。如果已经启用了 SNMP 陷阱生成，则还
会看到名称 sstrapd。

用户和密码

管理 （用户）安全级别和准则

如果在使用 Solaris 操作环境的系统上运行 Configuration Service 应用程序，则在安装
过程中自动创建管理员安全级别。只需要根据所需的权限级别设置密码并指定用户。 

Configuration Service 管理功能要求访问登录名和密码，以防止某个管理员未经授权重
新分配或删除了属于其他客户机或主机的存储资源。 

应为 Configuration Service 程序的三个安全级别分别指定密码。这是通过在具有由 
Configuration Service 管理的存储设备代理上创建三个用户实现的。这三个用户是在安
装 Configuration Service Agent 过程中自动添加的。

Configuration Service 安全级别必须具有以下三个名称： 
■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule Parity Check 
以及监控功能的访问。 

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些名称。安装后，必须为每个安全名称分配密码。

ssmon、ssadmin 和 ssconfig 是只对应到 Configuration Service 内安全级别的登录
名。对于 UNIX 操作环境 （Solaris/Linux 操作环境），这些帐户的默认 shell 将被指
定为 /bin/false，以防止用户 ID 被用于交互式登录。

可以设置 Configuration Service，从而使监控不需要用户键入 ssmon 密码。这可以通
过在 Configuration Service Console 上将服务器添加到 Managed Servers 列表时选择 
Auto Discovery 选项来实现。可以在每台服务器上以本地方式设置这三个登录名称和
密码。（如果需要，这些帐户可以在每台服务器上具有不同的密码。） 

只要在这些被管理的代理上设置了这三个登录名，系统管理员通常就能够通过向员工分
配相应的密码提供对 Configuration Service 的用户访问。例如，为特定服务器上具有
管理特权的每个用户都分配了为用户 ssadmin 建立的相同密码。

注意 – 要将服务器添加到 Managed Servers 列表，请参阅第 37 页的“添加服务器”。

▼ 创建密码和权限

要为每个新用户创建密码，应键入 

管理员可能还想更改组权限，组权限位于安装期间创建的 
/opt/SUNWsscs/sscsconsole 目录内的 svrlist.dat 文件中。 

# passwd user-name
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Configuration Service Console 是基于 Java 的实用程序，因此不能提供用于控制 
Configuration Service 创建的文件的权限和所有权的功能。svrlist.dat 文件容易被
不同形式的 ASCII 文本处理器读取。其中包括用户 ssmon 的加密密码，也可以解密。 

注意 – 在添加所监控的所有代理之后，不要更改 svrlist.dat 的权限以及组所有权。

卸装 Configuration Service 
在升级控制台或代理时，必须卸装 Configuration Service。注意有些文件不会被删除，
因为它们是在安装后创建的，并且仍对升级环境有效。

▼ 卸装 Configuration Service
使用 rpm -e 命令 （后面跟有要卸装的 Configuration Service 软件包）、
SUNWscsu.rpm（控制台）或 SUNWscsd.rpm（代理）。 

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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第 章6

设置 Configuration Service 

本章说明了设置 Configuration Service 的一般过程。本章包含下列过程：

■ 第 32 页的 “启动 Configuration Service”
■ 第 37 页的 “添加服务器” 
■ 第 43 页的 “登录和注销”
■ 第 44 页的 “选择用于管理控制器的服务器” 
■ 第 48 页的 “配置代理参数 （可选）” 
■ 第 51 页的 “验证存储配置” 
■ 第 53 页的 “保存逻辑驱动器配置” 
■ 第 54 页的 “在服务器上创建分区” 

启动 Configuration Service

注意 – 必须是超级用户 / 管理员才能运行 Configuration Service Console。

注意 – 因为 Configuration Service Console 只有在运行时才能够接收到事件警示，所
以在对该阵列进行配置后，一定要让 Configuration Service 在 Configuration Service 
Console 工作站上以最小化 模式运行。或者，与 Configuration Service Console 程序
保持在前台运行不同，可以使用 Diagnostic Reporter，它是 Configuration Service 的一
个伴随实用程序，作为后台服务运行，能够从主机和阵列将消息发送到指定的电子邮件
地址。有关详细信息，请参阅 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。
有关另一种接收事件警示的方法，请参阅第 222 页的 “发送 SNMP 陷阱而不使用 
Configuration Service”。

注意 – 为了 Configuration Service 能够查看和管理阵列，每个 HBA 卡必须连接到主
控制器。
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▼ 启动 Configuration Service

Solaris/Linux 操作环境

在命令提示符处，键入

Microsoft Windows NT/2000 操作系统

选择 Start → Programs → Sun StorEdge 3000 Family → Configuration Service。 

首次使用前后的主窗口
当 Configuration Service 首次初始化时，配置主窗口为空。 Add Server 窗口显示，允
许您将服务器添加到正在使用的 Configuration Service Console 的 Managed Servers 
列表。要获得有关添加服务器的详细信息，请参阅第 37 页的 “添加服务器”。

在首次启动 Configuration Service 之后，以及选择过 Managed Servers 之后，再次启
动 Configuration Service 时，Configuration Service 主窗口会为 Managed Servers 列
表中的服务器显示服务器图标。单击 OK 或 Cancel 以继续。

在配置了新阵列并引导了工作站之后，只有在为逻辑驱动器添加卷标后程序才能够发现
阵列，因为 Configuration Service 使用本机 Sun 驱动程序。

# ssconsole
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如果 Console 在使用过程中锁死

在运行 Solaris 或 Linux 操作环境的系统上，如果 Configuration Service Console 在使
用过程中锁死，您可以停止 Configuration Service，然后关闭并重新打开窗口，这样做
不会对 Configuration Service Agent 构成影响。

▼ 停止 Configuration Service

1. 在命令提示符处，键入

2. 重新运行程序。 

重新显示窗口，而不会影响 Configuration Service Agent。

菜单、工具条和选项卡

详细了解 Configuration Service 主窗口很有用，因为它包括菜单栏、选项卡和一个用
于访问主要功能的工具条。

# ssconsole stop
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菜单栏

下图显示各主菜单选项。

工具栏

菜单栏下面的工具栏提供了一些供您快速访问常用功能的图标。选择一个图标可以启动
其功能。根据 Configuration Service 主窗口中可用资源的不同，工具条图标可能显示
为活动或非活动 （灰色）。

图标 说明

服务器列表设置。添加由 Configuration Service Console 管理的
服务器，编辑服务器信息，或指定存在可以管理的服务器。

事件日志。查看诸如存储设备状态更改、硬件状态更改或操作通
知等事件。

保存事件日志。显示 Save Event Log File 对话框，通过该对话框

可以方便地保存事件日志，而无需打开 Event Log 窗口。

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

Configure Host/WWN (Fibre Channel only) 

LUN Filter Properties (Fibre Channel only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check

Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management

Display HDD under LD
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删除事件日志。手动删除 eventlog.txt 文件的内容。（在事件数量
达到 10,000 之前， Configuration Service 将一直收集事件。如果

事件数量达到了 10,000，事件日志将被自动减少到最新的 500 个
事件。）

保存报告。创建一个文本文件，其中包含选定服务器上每个存储
组件到当前日期为止的 Configuration Service 数据。

标准配置。在选定的阵列控制器上创建一个或多个具有一个 
RAID 级别的逻辑驱动器。如果您希望使用一个预定义的配置，
而在该配置中 Configuration Service 会自动配置存储设备，此时

可以使用标准配置。

自定义配置。提供了多种选择，用于在选定的阵列控制器上对具

有各种 RAID 级别的逻辑驱动器或逻辑卷进行配置或重新配置。
当您希望手动定义配置时可以使用此项功能，例如设置或更改控

制器 ID 和参数，定义或修改 RAID 集和备用驱动器等。

图标 说明
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选项卡

位于工具条下的选项卡能够让您快速移动到其他 Configuration Service 视图。

物理 （硬盘）驱动器

随着阵列配置的不断完备，Configuration Service 主窗口将显示多个组件。默认情况下
将显示组成逻辑驱动器的物理驱动器；但是，要使 Configuration Service 主窗口更加
容易管理和浏览，可以选择不显示物理 （硬盘）驱动器，方法是取消选择 View → 
Display HDD under LD。 

导航 Configuration Service
Configuration Service 符合标准的 Java 编程语言键盘和导航操作。

选项卡 说明

单击可以转到 Configuration Service 主窗口。

单击可以转到 Resource Allocation 视图。（留作将来使用。）

单击可以转到 LUN Filter 视图。（仅对光纤信道。）
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▼ 添加服务器

在监控和配置服务器之前，需要通过 Server List Setup 将服务器添加到 Managed 
Servers 列表中。

1. 如果还没有运行 Configuration Service，应启动它。

2. 选择 File → Server List Setup。 

Server List Setup 窗口显示。

3. 将服务器组织到组中：

a. 单击 Server List Setup 窗口中的 Groups。 

Group List Setup 窗口显示。

b. 在 Group Name 字段中键入名称并单击 Add。

c. 要删除组，请从 Available Groups 列表中选择组名称并单击 Delete。
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d. 在添加或删除完组后，单击 OK。 

Server List Setup 窗口显示。

4. 添加服务器：

a. 单击 Available Servers 列表下的 Add。 

Add Server 窗口显示。

b. 对于 Solaris，应在 Server name 字段中键入服务器的名称并按 Return。对于 
Microsoft Windows NT/2000，请在 Server name 字段中输入服务器的名称并按 
Enter。 

这是用于标识服务器的名称。如果该名称在网络的名称服务器数据库中，
Configuration Service 将确定服务器的 IP 地址并将其显示在 IP 地址字段中。

如果 Configuration Service 无法找到该名称的 IP 地址，可能是因为名称键入不正确
或者该名称没有记录在服务器的名称数据库中。

c. 如有必要，请在 IP Address 字段中键入服务器的 TCP/IP 地址。

例如：192.168.100.1。

如果 Configuration Service 还没有显示 IP 地址 （如上一步骤所示），应手动键入 
IP 地址。

选择 IP Address 字段下的 Get IP Address by Name，也可以让 Configuration 
Service 搜索并自动显示 IP 地址。如在先前步骤中提到的，只有网络具有名称服务
器数据库并且您键入了该数据库中记录的服务器名称时，它才起作用。否则，必须
手动键入 IP 地址。
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5. 选择或取消选择服务器的 Automatic Discovery （自动恢复）：

a. 如果需要一个非常安全的环境，在该环境中即使对服务器库存数据进行访问都要受
到限制，则应为 Auto Discovery 选择 No。

如果选择了 No，Configuration Service 不会在启动时检索服务器信息。服务器的图
标显示为白颜色编码 （而不是亮紫色），以表示它未被发现。双击一个未被发现的
服务器时， Configuration Service 提示用户输入 ssmon 用户密码。另外，也可以选
择服务器，然后选择 File → Login。

为 Auto Discovery 选择 Yes 以在 Configuration Service Console 启动时检索该服务
器的所有可用信息。 

b. 如果为 Auto Discovery 选择了 Yes，应键入先前在服务器 （或如果有域或 DNS 
树，则为服务器组）上建立 ssmon 用户时键入的密码。

如果已经使用 Auto Discovery 建立了服务器，则在登录到 Configuration Service 
时不需要键入 ssmon 密码；您自动拥有监控特权。

但是，无论何时在选择了执行管理或配置命令的操作后，都会提示用户键入先前建
立的 ssadmin 或 ssconfig 用户的密码。

c. 单击 OK。

6. 设定电子邮件地址： 

a. 如果要让 Configuration Service 使用电子邮件发送事件消息，可以选择 Mailing 
Lists 选项卡并继续执行下列操作。 

用户可能想要键入自己的电子邮件地址或选定用户的地址，以实现接收关于服务器
关键事件信息的目的。

注意 – 与 Configuration Service Console 程序保持在前台运行不同，可以使用 
Diagnostic Reporter，它是 Configuration Service 的一个伴随实用程序，作为后台服务
运行，能够从主机和阵列将消息发送到指定的电子邮件地址。有关详细信息，请参阅 
Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。有关另一种接收事件警示的方
法，请参阅第 222 页的 “发送 SNMP 陷阱而不使用 Configuration Service”。
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b. 对于每一个用户，将电子邮件地址键入 Mail Address 字段中。

c. 在 Severity 列表框中，滚动严重级别列表，选择下列项目之一：

Critical － 要求网络管理员干预的消息，例如设备、电源或风扇的故障。

Warning － 一般用来指示内部程序事件的消息。如果看到大量的此类消息，可能表
示服务器或网络存在问题。 

Informational － 有关服务器上的设备的消息，不需要网络管理员的干预。

无论选择的级别如何，都会接收到该级别以及任何更高严重级别的事件消息。例如，
如果选择了 Informational，则将向您通知所有类型的故障。相反，如果只需要在发
生紧急情况时获得通知，可以选择 Critical，这样就不会获得任何 Informational 或 
Warning 事件通知了。

d. 单击 Add to List。

要从列表上删除用户，请选择邮件地址并单击 Delete from List。

e. 指示要使用的邮件服务器。 

注意 Setup Mail Server 按钮与 Change Mail Server 按钮可根据以前是否已经定义
了邮件服务器而相互切换。

对于新设置，请单击 Setup Mail Server。将显示类似下面的 Mail Server Setup 
窗口。
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f. 键入简单邮件传输协议 (SMTP) 邮件服务器的 IP 地址或名称 （该服务器用于将电
子邮件消息传输到先前所指定的目标地址）。

g. 如果对 Mail Server 窗口中的信息满意，请单击 OK。 

Add Server 窗口显示，其中有 Mailing Lists 选项卡。

7. 完成 Add Server 功能：

a. 如果想让该服务器成为组的一部分，可选择 Grouping 选项卡。 

Add Server 窗口显示。

b. 选择列表框，以查看可用选项。 

c. 选择需要的组并释放鼠标按钮。

d. 单击 OK 以注册更改。

8. 如果要添加更多的服务器，应为每台服务器重复步骤 3 到 7。
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9. 将想要受此控制台控制的服务器移动到 Managed Servers 列表 （请参阅第 37 页的
“添加服务器”）。

■ 如果要让该控制台管理所有可用的服务器，应单击对话框顶部的 Add All。

■ 要将单独服务器移动到受管理列，应单独选择每台服务器并单击两个列表框之间的 
Add。

■ 如果在添加服务器过程中，需要进行修改，请参阅第 178 页的 “编辑服务器条目”。

10. 在添加完服务器后，单击 OK 返回到主窗口。

注意 – 如果阵列连接到多个主机，且每个主机上都安装有 Configuration Service 
Agent，则必须输入每个主机的 IP 并添加到 Managed Servers 列表。
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▼ 登录和注销

Configuration Service 的登录和注销功能提供了程序内的安全性。安全性级别是通过设
置三个用户来建立的：ssmon、 ssadmin 和 ssconfig，每个用户都带有密码。

■ ssmon 代表软件的监控级别，它显示来自控制器的警示。  

■ ssadmin 代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule 
Parity Check 以及监控功能的访问。 

■ ssconfig 代表配置级别，它提供了对配置命令和程序所有方面的访问。

1. 要登录，请选择 File → Login。

仅在作为监控用户时才保持连续访问。在选择需要管理级别或配置级别的命令时，将显
示登录对话框，您可以使用相应的密码登录到该级别。在完成活动后，注销。

2. 要注销，选择 File → Logout。 

如果从管理或配置级别注销，将为您提供选项，以选择注销到监控模式还是从服务器完
全注销。
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▼ 选择用于管理控制器的服务器

要管理和监控阵列， Configuration Service Agent 需要访问一个已映射到逻辑驱动器
（已分配给阵列的主控制器）分区的主机 LUN。  

Configuration Service Agent 忽略所有已映射到逻辑驱动器 （已分配给冗余配置阵列
中的辅助控制器）分区的主机 LUN。

注意 – 请参阅第 181 页的“RAID 基本知识”，了解针对逻辑驱动器和 LUN 的讨论。 

如果同一阵列连接到了多台服务器，则能够让运行在每台服务器上的 Configuration 
Service Agent 尝试管理和监控同一阵列。因为限制一次只能有一台服务器将监控命令
发送到阵列控制器，因此如果多台服务器同时发送监控命令，有些监控命令可能会失
败。这可能会导致报告不准确，或者 Configuration Service 进程停止响应。要防止发
生这种情况，可以将 Configuration Service Agent 配置为在服务器上启用 / 禁用阵列
监控。

通过控制台分配控制器

可以从 Configuration Service Console 执行下列过程以为控制器分配服务器控制。

1. 请确保所有直接连接的服务器都是依照第 37 页的“添加服务器”中的指示进行添加的。 

这可以确保两个主机名都出现在 Controller Assignments （控制器分配）下。

2. 从 Configuration Service 主窗口，单击 Array Administration → Controller 
Assignment。 

Assign Server to Manage a RAID Controller 窗口显示。 

3. 从 Server to manage this controller 列表选择一台服务器，单击 Apply。

这可以让所选定的服务器对阵列控制器进行管理。还禁止所有列出的其他服务器管理同
一阵列。
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4. 单击 Close 以关闭视图。

Configuration Service 主窗口只将阵列控制器设备图标显示在已为阵列启用监控功能的
服务器下。 
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更改服务器分配 

当分配一台服务器来管理控制器时，将会生成有关该管理服务器的信息。
Configuration Service 将该信息存储在控制器上，并使用该信息来跟踪管理服务器。如
果关闭了服务器 （例如进行维护时），而您尝试分配另一台服务器来管理该控制器，此
时 Configuration Service 会从该控制器上读取存储过的服务器信息，并警告您已在对
该控制器进行管理。

注意 – 如果希望强制使用新的服务器分配，则可以覆盖当前的服务器分配。

可以查看管理服务器的名称，方法是使用固件应用程序菜单 view and edit Host luns 
→ Edit Host-ID/WWN Name List。

例如，您由于正在将阵列移到新位置而希望更改服务器分配，则在移动该阵列之前，需
要根据第 47 页的 “取消分配管理服务器”中所述的步骤取消分配管理服务器。 

如果已经移动了阵列，则当该阵列启动时，您可能会看到一条警告信息，该信息指示该
控制器正在由另一台服务器管理。您需要按照第 47 页的 “使用终端窗口手动删除服务
器”中所述的步骤手动删除该服务器。有关访问固件应用程序的信息，请参阅适用于您
的阵列的 Sun StorEdge 3000 Family RAID Firmware User's Guide。

Configuration Service 以
ASCII 字符集的十六进制值的形式
存储服务器名称。
46 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



▼ 取消分配管理服务器

1. 从 Configuration Service 主窗口，单击 Array Administration → Controller 
Assignment。

2. 选择您要为其取消服务器分配的阵列控制器。

3. 从 Server to manage this controller: 列表框中，选择 none。

当显示以下警告信息时单击 Close，确认不再通过服务器对选定的控制器进行管理。

4. 按照第 44 页的 “通过控制台分配控制器”中所述的步骤选择希望用于管理控制器的服
务器。

▼ 使用终端窗口手动删除服务器

有关访问固件应用程序的信息，请参阅适用于您的阵列的 Sun StorEdge 3000 Family 
RAID Firmware User's Guide。

1. 在主菜单上，选择 view and edit Host luns，然后按 Return。

2. 选择 Edit Host-ID/WWN Name List，然后按 Return。

3. 从 Name List 中选择 sscsMgr，然后按 Return。

4. 选择 Delete Host-ID/WWN Name List，然后按 Return。

5. 选择 Yes，然后按 Return。
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▼ 配置代理参数 （可选）

本节提供了配置代理参数的步骤，其中包括轮询时间、周期性设备发现时间、智能监控
和带外存储管理 （使用 View → Agent Options Management 命令）。 

1. 从主窗口中，选择 View → Agent Options Management。 

Agent Options Management 窗口显示。

注意 – 如果已经配置了一个或多个组，并且在主窗口中选择了其中一个，则 Agent 
Options Management 不可用。要启用它，选择一个图标，而不是一个组，然后单击 
View。

2. 对于 Monitoring Frequency in Seconds，以秒为单位键入所需的数值。

该值是 Configuration Service Agent 连续向设备、阵列控制器和机箱监控轮询状态更
改的间隔。默认值为 60 秒。如果想要 Configuration Service Console 更频繁地更新设
备状态更改，可以减小该值。

注意 – 增加轮训间隔可能会对高 I/O 负载时的错误消息传递造成负面影响。
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3. 对于 Periodic Device Discovery，以分钟为单位键入希望 Configuration Service 检
查新设备的时间值。

Configuration Service 使用周期性设备发现值确定扫描每个设备 ID 以发现新设备的频
率。默认值 0 代表 Configuration Service 不扫描新设备。注意，数字值增加时，设备 
ID 的扫描频率降低。

反之，数字值降低时，设备 ID 的扫描频率提高。 5 分钟是最小值。

4. 对于 Interval of trap generation，键入发送两个陷阱消息之间间隔的时间量 （以秒为
单位）。 

如果值为 60 秒或更大，则 Configuration Service 按照这个时间间隔为该特定陷阱发送
消息，直到事件得到清除或更正为止。例如，如果风扇发生故障，则每隔 60 秒发送一
条关于风扇故障的消息，直到修复为止。

如果值为 0，则 Configuration Service （以及 Diagnostic Reporter）对于特定事件只
发送一个消息。例如，如果发生风扇故障，则只发送一封电子邮件。

5. 对于 Timeout of heartbeat lost，设置发送故障服务器消息之间以分钟为单位的等待
时间。 

默认值为 15 分钟，取值范围为 1 到 30 分钟。 

6. 要启用 SMART Monitoring，选择该复选框。

SMART 监控是报告硬盘驱动器预测故障的方法。大多数磁盘供应商都提供带有此功能
的驱动器。Configuration Service Agent 通过主动发出请求传感数据，对该功能进行监
控。如果该请求与底层的主机操作环境和系统设备驱动程序冲突，则可以将 SMART 监
控功能关掉。

7. 如果选择了前面的任何选项，单击 OK 以保存更改。
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显示 Setting Agent Options 通知消息框，指示服务器的 TCP/IP 地址。

8. 单击 OK 以完成过程。

要获得有关 Controller Primary Agent Information 的详细信息，请参阅第 120 页的
“带外存储管理”。

▼ 启用 JBOD 支持 （仅对 SCSI）
对于 Sun StorEdge 3310 SCSI 阵列，仅在有直接连接到工作站的 JBOD 时，才可以使
用简单磁盘捆绑 (JBOD) 支持。这使得您能够监控外围设备的状况和事件。如果有连接
到 RAID 阵列的 JBOD， RAID 控制器为您监控 JBOD 条件和事件。 

注意 – 启用 JBOD 支持可能会影响 I/O。

1. 按照第 48 页的 “配置代理参数 （可选）”中的步骤操作。

2. 选择 Enable JBOD support。

要获得有关监控 JBOD 的详细信息，请参阅第 197 页的“监控 JBOD（仅用于 SCSI）”。
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▼ 验证存储配置

只要安装了 Configuration Service，并且添加了所有的存储服务器让 Configuration 
Service 进行管理，就需要对存储配置进行验证。 

注意 – 大多数阵列都预先进行了配置。如果想要完全删除现有配置并重新开始，请参
阅第 59 页的 “完全配置”。如果想要更改现有的配置或者在其中添加内容，请参阅第 
141 页的 “更新配置”。

1. 确保服务器图标是联机的 （即服务器符号是紫色的）。  

在重新开机过程中， Configuration Service 自动启动。

2. 观察 Configuration Service 主窗口并检查存储配置。

3. 如果有多个受管服务器，选择要检查的服务器。 

如果服务器图标不是紫色的，则应确定服务器的状态 （请参阅表 9-1）。如果服务器图
标附有一个盘式卫星天线 ，则服务器可能正处于发现进程中，在短暂延迟后将变为
可用。  

4. 单击要检查其存储设备的服务器左面的容器符号 。

如下图所示 Configuration Service 以图形方式显示了连接到服务器的每个阵列控制器。 

5. 要查看其他详细信息，单击要查看其存储设备的阵列控制器旁的容器符号 。

如果还没有配置阵列，则不显示逻辑驱动器 （对于控制器为 LUN）。

如果已经完全配置了阵列，Configuration Service 显示与选定的阵列控制器相关的设备
和逻辑驱动器。它的外观与下图中显示的设备相似。  
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选择任何逻辑驱动器左侧的容器符号 能够显示其分配的物理驱动器。

注意 – 可以选择查看组成逻辑驱动器的物理 （硬盘）驱动器，方法是选择或取消选择 
View → Display HDD under LD。

根据您安装的阵列产品的不同，配置可能与前面图中显示的有很大的差别。

如果没有配置阵列，请参阅第 59 页的 “完全配置”，以获得配置阵列的指令。

6. 检查 RAID 级别和逻辑驱动器结构。

7. 如果已经配置了阵列，并且配置符合您的要求，则应继续下一节。 

如果想要更改配置，请参阅第 59 页的 “完全配置”。 
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▼ 保存逻辑驱动器配置

即便逻辑驱动器配置信息存储在阵列控制器或连接到它们的物理驱动器上，还可能发生
火灾等极端情况，这些情况都会造成控制器和驱动器的损坏。须在软盘或阵列以外的外
部介质上保留当前逻辑驱动器 （或 LUN）配置的多个备份副本。至少应该将一个备份
副本保存在密室或其他远离现场的安全地点。配置的备份副本用于将配置恢复到新控制
器，而不必完全重新配置阵列。如果没有当前配置的备份副本，则数据可能会丢失。

无论下列何种情况下，都应随时将阵列控制器配置保存到文件：

■ 安装新的存储系统机箱或更改现有机箱中控制器的 SCSI ID

■ 更换阵列控制器

■ 重新配置或将逻辑驱动器添加到阵列控制器

■ 从故障驱动器将数据重建到备用驱动器

要从文件中恢复配置，请参阅第 135 页的 “恢复逻辑驱动器配置”。

1. 选择带有要保存其配置的控制器。

2. 选择 Configuration → Save Configuration。 

Save Configuration 窗口显示。

3. 转到所要求的驱动器和文件夹，以找到要更新的配置文件，该文件是由 .cfg 扩展名
表示的。

将文件保存到软盘或阵列以外的驱动器。也就是说，在远离现场的地方保存这些配置文
件的副本。

4. 指定配置文件名称，然后单击 Save。 

Save Configuration 窗口显示。
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5. 为要保存的配置键入一段说明，然后单击 OK。

Configuration Service 将控制器配置信息保存到 .cfg 文件。

▼ 在服务器上创建分区

如果对存储配置满意，可以为操作环境进行存储阵列分区。 

Solaris 操作环境

下列步骤是通用性准则。要获得详细信息，请阅读 Sun Solaris 操作环境手册中关于创
建分区和文件系统的内容。
54 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



1. 键入以下命令为 LUN 加卷标

format 命令显示系统磁盘以及连接到阵列的其他驱动器。

在设置新的 LUN 供阵列使用之前，必须使用 format 命令为其加卷标。启动 format 
命令时，将显示可用的 LUN 和硬盘。  

2. 选择要使用的设备。 

如果提示，则为设备加卷标。

3. 键入 partition 以查看现有的分区表。

4. 根据需要编辑分区表，并在完成更改后为其加上卷标。

5. 使用 newfs 命令在分区上创建文件系统。

6. 使用 mount 命令，或通过编辑 /etc/vfstab并使用 mountall 命令，可以安装文件
系统。

# format
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Microsoft Windows NT 分区 

在开始本节前，需要重新启动计算机，以便 Microsoft Windows NT 识别新的存储容
量。下面列出的步骤是一般性准则；要获得详细信息，请参阅 Microsoft Windows NT 
文档。

注意 – 不能远程完成此步骤。必须在服务器上执行此步骤。

1. 选择 Start → Programs → Administrative Tools → Disk Administrator。

2. 在每个 Disk Administrator 消息框中选择 Yes。

3. 将光标移动到水平条，然后单击鼠标左键，选择逻辑驱动器。

4. 选择 Disk Administrator Partition → Create。

显示提示窗口，询问是否要创建默认容量为整个逻辑驱动器容量的分区。

5. 如果想要在逻辑驱动器上创建多个分区，应输入需要的分区大小。

重复该步骤直到使用了所有逻辑驱动器容量为止。

6. 选择 Disk Administrator Partition → Commit Changes Now。

此功能用于格式化并使用逻辑驱动器，而无需重新启动 Windows NT 操作系统。

7. 选择新创建的逻辑驱动器分区。

8. 选择 Disk Administrator Tools → Format。选择 NTFS （NT 文件系统）格式。

重复步骤 7 和 8 格式化每一个在逻辑驱动器上建立的分区。

9. 在格式化完成后，关闭 Disk Administrator。
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Microsoft Windows 2000 分区

下面列出的步骤是一般性准则；要获得详细信息，请参阅 Microsoft Windows 2000 
文档。

1. 选择 Settings → Control Panel → Administrative Tools → Computer Management → Disk 
Management。

确保在 Disk Management 下能够看到由磁盘图标 所标记的新驱动器。

2. 右键单击要为其写入签名的磁盘，然后选择 Write Signature。

3. 选择要为其创建分区的磁盘，然后单击 OK。

4. 右键单击该驱动器 （其中显示了驱动器容量），然后选择 Create Partition。

5. 对分区向导提示做出相应的响应。 

右键单击要为其写入
签名的磁盘。

右键单击要为其创建
分区的驱动器。
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下一步骤

现在已经安装、设置并就绪可以使用 Configuration Service （控制台和代理）了。请
参阅后面的章节，以了解其他任务：

■ 第 89 页的“监控阵列”，可以获得如何使用 Configuration Service 监控存储设备的
信息。

■ 第 127 页的 “维护阵列”，可以获得有关维护阵列的信息。其中包含详细的信息，
说明奇偶校验、调度奇偶校验、重建故障驱动器以及从备份文件恢复配置。

■ 第 141 页的 “更新配置”，用于想要更新存储阵列配置时使用。其中还包括了更改
控制器功能、建立或更改备用驱动器以及编辑关于可用服务器的信息。
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第 章7

完全配置

在提供软件前 Sun 在阵列上预先配置了逻辑驱动器。只有在阵列尚未配置，或者想要
完全 删除现有配置而重新开始时才应参阅本章。如果要更改现有配置，请参阅第 141 
页的 “更新配置”。

完全配置包括以下主题：

■ 第 60 页的 “配置逻辑驱动器和逻辑卷”

■ 第 60 页的 “使用标准配置来对逻辑驱动器进行配置”

■ 第 62 页的 “使用自定义配置对逻辑驱动器和逻辑卷进行配置”

■ 第 72 页的 “创建和分区逻辑卷”

■ 第 74 页的 “清除配置”

■ 第 74 页的 “从配置级别注销”

■ 第 74 页的 “主机 LUN 分配”

■ 第 75 页的 “添加 （映射）主机 LUN”

■ 第 76 页的 “删除 （取消映射）主机 LUN”

■ 第 76 页的 “配置文件”

■ 第 77 页的 “将配置保存到备份文件”

如果计划设置群集配置，请参阅第 203 页的 “使用群集配置”。

如果诸如奇偶校验等阵列管理进程正在运行，则可能会暂时禁用 Configuration 菜单命
令和工具条图标。在 Configuration Service Console 正在刷新服务器上的库存时菜单
命令也被停用。在刷新过程中，盘式卫星天线图标将附加到服务器图标上。

警告 – 在配置阵列之前将所有现有的数据备份到外部设备。重新配置将覆写所有现有
的逻辑驱动器配置。在覆写现有逻辑驱动器配置时，所有数据都将被彻底删除。
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配置逻辑驱动器和逻辑卷
根据要使用一个还是多个 RAID 级别，可以使用标准配置或自定义配置来配置逻辑驱动
器。逻辑卷只能使用 Custom Configuration 进行创建。 

注意 – 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。 

▼ 使用标准配置来对逻辑驱动器进行配置

通过 Standard Configuration Options 使用一个 RAID 级别快速配置连接到阵列控制
器的所有存储设备。所需提供的全部信息就是 RAID 控制器和 RAID 级别。还需要指
定是否需要备用驱动器。然后 Configuration Service 自动为您配置存储设备，根据 
RAID 级别和可用的驱动器数创建一个或多个逻辑驱动器。在默认情况下，回写缓存是
选定的。可以在配置完成前查看结果，并选择接受或拒绝。

警告 – 在使用 Standard Configuration （标准配置）之前，应将所有现有的数据备份
到外围设备。标准配置将覆写任何现有的逻辑驱动器配置。在覆写现有逻辑驱动器配置
时，所有数据都将被彻底删除。

1. 以 ssconfig 用户身份登录。

2. 在 Configuration Service 主窗口中选择所需的 RAID 控制器。

3. 选择 Configuration → Standard Configure。 

Standard Configuration 警告消息显示。单击 OK 继续。

Standard Configuration Options 窗口显示。如果当前还没有作为 ssconfig 登录，将
显示登录对话框。 
60 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



根据可用的驱动器数以及服务器上的系统运行的是 Solaris 操作环境还是 Microsoft 
Windows NT 操作系统，窗口中的选项可能被禁用。

NT 群集选项创建一个仲裁 RAID 5 逻辑驱动器 (100 MB)，然后将剩余容量分配在两个
大 RAID 5 逻辑驱动器上。要获得该选项，需要三个或更多物理驱动器。

4. 验证显示在窗口顶部的服务器和控制器 ID 是否正确。

如果显示在窗口顶部的服务器和控制器不正确，应单击 Cancel 退出配置窗口并返回到 
Configuration Service 主窗口。选择相应的设备，并再次选择该窗口。

5. 指示是否要使用其中一个驱动器作为备用驱动器。

如果选择了 Use a standby drive，则 Configuration Service 将停用不使用备用驱动器
的 RAID 级别。（例如， RAID 0 没有容错功能，因此备用驱动器没有益处。）

6. 从可用的 RAID 级别中，为要配置的逻辑驱动器选择适合的 RAID 级别。

有关 RAID 级别的定义，请参阅第 181 页的 “RAID 基本知识”。

如果选择了 RAID 3 或 5，则 Standard Configuration 通常会配置一个大逻辑驱动器。
但是，如果阵列中的物理驱动器数量多于 31 个，将创建一个以上的逻辑驱动器。另
外，最少需要 3 个驱动器才能使用 RAID 3 或 5。

如果选择了 RAID 1，则每个逻辑驱动器至少需要两个物理驱动器，驱动器的最大数量
为 44（如果选择 4 个或更多驱动器，则会创建一个级别为 RAID 0 +1 的逻辑驱动器）。

如果选择 RAID 0 而且阵列中的驱动器数量多于 44 个，将创建多于一个的逻辑驱动器。
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7. （限于 Solaris 操作环境）。如果要将新的逻辑驱动器自动添加到操作环境而不重新引
导，可以单击 Write a new label to the new LD。

8. 选择 RAID 级别之后，单击 OK。

Confirm Configuration Operation 窗口显示，其中显示了新的配置。 

9. 单击 OK 按照指示接受配置，否则单击 Cancel 返回到 Configuration Service 
Console。

▼ 使用自定义配置对逻辑驱动器和逻辑卷进行配置

Custom Configuration 让您能够使用不同的 RAID 级别和其他 RAID 参数获得配置或
重新配置逻辑驱动器的多种选择。它还提供了可以将新创建的逻辑驱动器添加到逻辑卷
中的选项。

1. 以 ssconfig 用户身份登录。 

2. 在 Configuration Service 主窗口中选择所需的 RAID 控制器。

3. 选择 Configuration → Custom Configure。 

Custom Configuration Options 窗口显示。
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■ New Configuration － 使用不同的 RAID 级别和其他 RAID 参数配置新的逻辑驱动
器，并使您可以将新的逻辑驱动器添加到逻辑卷中。 New Configuration 命令将删
除阵列控制器上先前的配置。

■ Add LDs/LVs to the Current Configuration － 将新的逻辑驱动器/逻辑卷添加到现
有配置中。此命令不会删除已经在控制器上配置的其他逻辑驱动器。

■ Dynamically Grow and/or Reconfigure LDs/LVs － 使您可以扩展逻辑驱动器和逻
辑卷的容量，将 SCSI 驱动器添加到现有逻辑驱动器和逻辑卷中，复制并使用更高容
量的驱动器替换所有成员驱动器。

■ Make or Change Standby Drives － 添加一个或多个新的备用驱动器，使其与阵列
控制器相关。

■ Change Host LUN Assignments － 使您可以将逻辑驱动器、逻辑卷和分区分配给
主机信道。

■ Change Controller Parameters － 使您可以修改控制器参数

■ Manage Existing LDs/LVs and Partitions － 使您可以删除个别逻辑驱动器和逻辑
卷，并从现有逻辑驱动器和逻辑卷创建 / 删除分区。

■ Configure Web Server － 使您可以配置 Web 服务器，以通过 Web 服务器管理 / 监
控阵列。
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本章详细说明了 New Configuration 选项。有关配置 Web 服务器的内容在第 124 页的
“通过 Web 管理存储设备”中加以说明。剩余选项在第 141 页的 “更新配置”中加以
说明。 

New Configuration 选项

New Configuration 选项用于定制逻辑驱动器配置以满足您的环境的特定需要。可以使
用不同的 RAID 级别对一个或多个逻辑驱动器进行配置和分区。可以将 2 个或更多
（未分区的）逻辑驱动器添加到逻辑卷中，并将逻辑卷分为最多 32 个分区 （对于 
SCSI）或 128 个分区 （对于光纤信道）。

注意 – 在运行 Solaris 操作环境的系统上，如果 Configuration Service Console 在使用
过程中锁死，您可以获得进程号，然后关闭并重新打开窗口，如第 33 页的 “如果 
Console 在使用过程中锁死”中所述。

使用 New Configuration 之前

在首次使用 New Configuration 创建逻辑驱动器或逻辑卷之前，熟悉下列步骤中包含
的信息很有用。提前了解这些信息有助于创建逻辑驱动器或卷的过程顺利进行。 

1. 确定逻辑驱动器中将要包含的物理磁盘的总数量。

如果数据的安全性很重要，请将其余磁盘用作备用驱动器。

注意 – 如果逻辑驱动器的容量将超过 253 GB，请参阅第 66 页的 “准备容量超过 253 
GB 的逻辑驱动器”。

2. 确定是否将某些备用驱动器作为本地备用驱动器，还是作为全局备用驱动器。

备用驱动器是一个标为备用的驱动器，用于在与逻辑驱动器相关的物理驱动器发生故障
后支持自动重建数据。如果备用驱动器要替代另一个驱动器，其大小必须至少与故障驱
动器的大小相等。另外，故障驱动器本身也必须来自 RAID 1、 3 或 5。

本地备用驱动器是分配服务至指定逻辑驱动器的备用驱动器。当指定逻辑驱动器的某一
成员驱动器发生故障时，本地备用驱动器成为成员驱动器，自动开始重建。

全局备用驱动器不单只为一个指定的逻辑驱动器服务。当任一逻辑驱动器中的成员驱动
器发生故障时，全局备用驱动器加入该逻辑驱动器工作，自动开始重建。

3. 选择 RAID 级别； Configuration Service 自动计算可以在该 RAID 级别创建的逻辑
驱动器的最大大小。
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4. 确定是否要对逻辑驱动器进行分区。

分区 是对逻辑驱动器 （或逻辑卷）的逻辑划分。分区可以创建用于文件管理、多用户
或其他目的独立逻辑驱动器 （或逻辑卷）。

注意 – 可以在初始配置时或在创建逻辑驱动器后建立分区。

注意 – 已经分区的逻辑驱动器不能添加到逻辑卷中。

5. 理解 New Configuration 窗口中显示的磁盘容量。

■ Max Drive Size (MB) － 显示每个选定物理磁盘的驱动器的最大大小 （每个磁盘的
总容量）。 

通过减小该值可以创建较小的逻辑驱动器。日后可以通过扩展驱动器来使用剩余部
分 （如第 153 页的 “扩展逻辑驱动器或逻辑卷的容量”中所示）。

■ Available Size (MB) － 显示所有磁盘的总容量，这是逻辑驱动器或逻辑卷的总容量。

注意 – 逻辑驱动器的最大可用容量等于最小物理磁盘大小。例如，如果添加了一个 18 
GB 的磁盘然后又添加了一个 70 GB 的磁盘作为逻辑驱动器的一部分，则每个驱动器的
最大可用容量为 18 GB。

6. 确定逻辑驱动器是否为逻辑卷的一部分。 

注意 – 已经分区的逻辑驱动器不能添加到逻辑卷中。

7. 确定是否要对逻辑卷进行分区。

注意 – 可以在初始配置时或在创建逻辑卷后建立分区。

8. 确定背景率。背景率是分配给阵列管理活动 （如重建驱动器、检查奇偶校验、初始化）
的可用阵列控制器 CPU 时间的百分比。 

如果 background rate 设置为 100%，阵列管理活动比其他系统活动具有更高的优先
级。如果为 0%，则只有在阵列控制器上没有其他活动时才会进行阵列管理活动。
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▼ 准备容量超过 253 GB 的逻辑驱动器
Solaris 操作环境需要用于各种操作的驱动器几何体系，例如 newfs。为了在 Solaris 操
作环境中提供合适的驱动器几何体系以用于容量超过 253 GB 的逻辑驱动器，必须使用
固件应用程序来配置 Host Cylinder/Head/Sector Mapping Configuration。有关访问
固件应用程序的信息，请参阅适用于您的阵列的 Sun StorEdge 3000 Family RAID 
Firmware User's Guide。

1. 在固件应用程序中，选择主菜单上的 view and edit Configuration parameters。

2. 选择 Host-Side SCSI Parameters。

3. 选择 Host Cylinder/Head/Sector Mapping Configuration。

4. 选择 Sector Ranges 并指定 255。

5. 选择 Head Ranges 并指定 64。

6. 选择 Cylinder Ranges 并指定 <65536。

▼ 使用 New Configuration 创建和分区逻辑驱动器

在首次使用 New Configuration 创建逻辑驱动器和对其进行分区之前，应回顾一下第 
64 页的 “使用 New Configuration 之前”中所述的步骤。

下列步骤提供了为新的逻辑驱动器创建新配置的一个工作示例。选定了 3 个逻辑驱动器
并将它们配置到一个 RAID 5 逻辑驱动器。然后一个小逻辑驱动器被创建和分区。

警告 – 在使用 New Configuration 命令之前将所有现有的数据备份到外围设备。
Configuration Service 自动对在阵列控制器上定义的新逻辑驱动器进行初始化。

1. 以 ssconfig 用户身份登录。 

2. 在 Configuration Service 主窗口中选择所需的 RAID 控制器。

3. 选择 Configuration → Custom Configure。 

4. 单击 New Configuration。 
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显示 New Configuration Warning 消息窗口。

5. 单击 OK。 

6. 验证显示在窗口顶部的服务器和控制器是否正确。

如果显示的服务器和控制器不正确，应单击 Cancel 退出 New Configuration 窗口并返
回到 Configuration Service 主窗口。选择相应的磁盘控制器并重新选择 New 
Configuration。

7. 如果需要，为控制器设置 Background Rate （背景率）。 

8. 在 Select disks for Logical Drive 列表框中，选择第一个磁盘并单击 Add Disk。 

再添加 2 个磁盘，此时在下方的列表框中将显示 3 个磁盘。 

如果操作错误或改变了决定，可以在驱动器列表中选择驱动器并单击 Remove Disk。

注意 – 因为逻辑驱动器尚未进行分区，所以 Part Size (MB) 与 Available Size (MB) 的
值相等。一个逻辑驱动器被视为一个单独的分区。
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9. 选择 RAID Level。对于此示例，选择 RAID Level 5。

这适用于逻辑驱动器中的所有磁盘。 

在此示例中，新的逻辑驱动器由三个物理磁盘组成，总容量为 103428 MB，如 
Available Size (MB) 字段所示。

对于各个 RAID 级别，每个逻辑驱动器的驱动器最大数量为：

■ RAID 0 - 44
■ RAID 1 - 2
■ RAID 0+1 - 44
■ RAID 3 或 5 - 31

注意，如果选择 4 个或更多驱动器，将创建一个级别为 RAID 0+1 的逻辑驱动器。

Max Drive Size - 显示
每个磁盘的总容量

Available Size - 显示
所有磁盘的总容量，
即逻辑驱动器的总容量
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10. 设置 Max Drive Size。

Max Drive Size 显示每个磁盘的总容量。通过减小该值可以创建较小的逻辑驱动器。

注意 – 如果不更改 Max Drive Size 但确实更改 Partition Size，则 Configuration 
Service 按指定大小创建新的分区。剩余的逻辑驱动器大小容量移到最后一个分区。然
后可以通过扩展驱动器利用剩余容量 （如第 153 页的 “扩展逻辑驱动器或逻辑卷的容
量”所示）。在创建分区后，不能再编辑驱动器容量。

11. 从 Channel 和 SCSI ID 列表框中选择要将新逻辑驱动器映射到其上的主机信道和 
SCSI ID。

注意 – 如果此时不想映射逻辑驱动器，请从 Channel 列表框中选择 Do Not Map。

注意 – 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。

12. 这一步骤取决于您的下一步操作：

■ 如果要创建另一个逻辑驱动器，请单击 New LD 并重复步骤 1 到 11。

■ 要将此逻辑驱动器添加到一个逻辑卷中，请单击 Add to LV 并参阅第 72 页的 “创
建和分区逻辑卷”。

■ 对此逻辑驱动器进行分区，请继续以下步骤。在此示例中，一个小逻辑驱动器被创
建和分区。 

13. 要创建一个小逻辑驱动器，请在 Max Drive Size 字段中键入 2000。 

注意 – 逻辑驱动器的大小显示为 4000 MB，而不是 6000 MB，因为这是 RAID 5 级
别，您丢失了等同于一个驱动器的容量 (2000 MB) 用于奇偶校验。
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14. 要创建分区，请在 Part Size 字段中键入 1000 并单击 Add Partition。

注意 – 如果您要将逻辑驱动器添加到逻辑卷中，请不要对该逻辑驱动器进行分区。一
旦对逻辑驱动器进行分区，它就不能被添加到逻辑卷中。

要创建相同大小的多个分区，请多次单击 Add Partition，单击的次数与您希望创建的
分区数相同。您还可以在 Part Size 字段键入分区大小，并乘以 (*) 要创建的分区数目，
例如 100*128。余下的 MB 将被添加到最后一个分区中。

在添加分区时，显示在 Available Size (MB) 中的剩余容量将减去分区的大小。

如下例所示，在最初的 4000 MB 中，有 1000 MB 被分配给 Partition 0。然后其余 3000 
MB 自动移到 Partition 1。余下的可用容量显示在 Available Size (MB) 字段中。
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15. （限于 Solaris 操作环境）。如果要将新的逻辑驱动器自动添加到操作环境而不重新引
导，可以单击 Write a new label to the new LD。

16. 单击 Commit 结束对该逻辑驱动器的配置，或者单击 New LD 继续配置其他逻辑驱
动器。 

如果单击 New LD，将显示所有尚未使用的可用磁盘。

当阵列的逻辑驱动器配置完成后，单击 Commit，然后单击 OK。显示已完成的配置。 

注意 – 您单击 OK 后就不能更改逻辑驱动器的配置。  

注意 – 在初始化期间， LD/LV 的大小显示为 0 MB。
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▼ 创建和分区逻辑卷 
一个逻辑卷由 2 个或更多逻辑驱动器组成，最多可以划分为 32 个分区 （对于 SCSI）
或 128 个分区 （对于光纤信道）。操作期间，主机将未分区的逻辑卷或逻辑卷的分区作
为单个物理驱动器对待。 

1. 按照第 66 页的“使用 New Configuration 创建和分区逻辑驱动器”中步骤 1 至 11 所
述创建逻辑驱动器。

注意 – 不要对要添加到逻辑卷中的逻辑驱动器进行分区。已经分区的逻辑驱动器不能
添加到逻辑卷中。

2. 要将逻辑驱动器添加到逻辑卷，请在单击 Commit 之前，单击 Add to LV。

该逻辑驱动器便被添加到 LV Definition 框中。逻辑卷的总大小显示在 Available Size 
(MB) 字段中。 

注意 – 因为逻辑卷尚未进行分区，所以 Part Size (MB) 与 Available Size (MB) 的值相
等。一个逻辑卷被视为一个单独的分区。
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3. 要创建另一个逻辑驱动器以添加到该逻辑卷中，请单击 New LD。

4. 创建逻辑驱动器，并单击 Add to LV 将它添加到逻辑卷中。

为要添加到逻辑卷中的每个逻辑驱动器重复此步骤。

5. 要创建分区，请在 Part Size 字段中键入分区大小并单击 Add Partition。

要创建相同大小的多个分区，请多次单击 Add Partition，单击的次数与您希望创建的
分区数相同。您还可以在 Part Size 字段键入分区大小，并乘以 (*) 要创建的分区数
（例如 100*128）。

在添加分区时，显示在 Available Size (MB) 中的剩余容量将减去分区的大小。

6. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其他逻辑卷或者创建个别逻辑驱动器，
请单击 Commit LV。

如果创建完逻辑卷以后不想创建个别逻辑驱动器，请单击 Commit。

注意 – 当您创建完逻辑卷之后要退出 New Configuration 窗口时，如果不慎单击了 
Commit LV 而不是 Commit，则必须再创建一个逻辑驱动器；否则，您只能单击 
Cancel 并重新配置该逻辑卷。

要添加或删除逻辑卷，或者对现有配置中的逻辑卷进行分区，请参阅第 141 页的 “更
新配置”。

当逻辑驱动器被添加到
逻辑卷中以后，这些
逻辑驱动器将显示在
LV Definition 框中

Available Size - 显示
所有磁盘的总容量，
即逻辑卷的总容量
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▼ 清除配置

在配置过程中的任何时候如果对 New Configuration 窗口中的配置不满意，可以将其
清除。

1. 单击 Clear 从显示内容中删除所有物理驱动器和逻辑驱动器。 

2. 可以单击 New LD 定义新的逻辑驱动器，或单击 Commit。

3. 在单击 Commit 时，将显示警告提示；可以单击 OK。 

Configuration Service 在选定的阵列控制器上初始化整个配置。

注意 – 在逻辑驱动器完成初始过程后，将自动映射主机 LUN。

▼ 从配置级别注销

完成配置活动时，应登录回程序的监控级别。 

1. 选择 File → Logout。

2. 选择 Logout to monitoring mode 然后单击 OK。

主机 LUN 分配
要使服务器识别逻辑驱动器 / 逻辑卷，该逻辑驱动器 / 逻辑卷必须首先映射到一个主
机信道 /ID。当某个逻辑驱动器 / 逻辑卷映射到一个主机信道 /ID 时，该逻辑驱动器
/ 逻辑卷即成为一个 LUN。下面一节说明了如何将逻辑驱动器 / 逻辑卷映射到主机信
道以及如何将其删除。

注意 – 当首次创建逻辑驱动器 / 逻辑卷时，除非选择了 Do Not Map，否则在逻辑驱
动器 / 逻辑卷完成初始化过程之后，将自动映射主机 LUN。

注意 – 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。
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▼ 添加 （映射）主机 LUN
1. 选择 Configuration → Custom Configure。

2. 从 Custom Configuration Options 菜单，选择 Change Host LUN Assignments。 

Change Host LUN Assignments 窗口显示。

3. 使用 Select Host Channel 和 SCSI ID 列表框，选择要为其分配 LUN 的信道和 ID。

在 Partitions 下方将显示所有可用 LUN。仅供参考，Used LUNs 显示用于指定信道的
LUN 的列表，Partition Assignment 显示已为其分配分区的信道、ID 和 LUN 的列表。 

注意 – 当添加或创建逻辑驱动器 / 逻辑卷时，它将被分配为主要的或辅助的 （控制器
分配）。然后将初始化逻辑驱动器 / 逻辑卷并将其映射到主要或辅助信道 ID。如果取
消对逻辑驱动器 / 逻辑卷的映射，并将其重新映射到具有不同控制器分配的其他主机信
道 ID，您必须重置控制器。如果取消对逻辑驱动器 / 逻辑卷的映射，并将其重新映射
到具有相同 控制器分配的其他主机信道 ID，则无需重置控制器。如果逻辑驱动器 / 逻
辑卷仍然拥有已经映射的分区，则只能将未映射的分区映射到具有相同控制器分配的主
机信道 ID。

4. 从 LDs/LVs 字段中选择所需的分区，然后单击 Assign Host LUN 以接受更改。 

要映射多个分区 （最多 32 个），可选择第一个分区，滚动到最后一个分区，然后在按
住 Shift 键的同时单击，可选中两次单击位置之间的全部分区。然后单击 Assign Host 
LUN。

因此， Delete Host LUN 变为活动的。
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5. 在完成时，单击 OK 以保存更改并返回到主菜单。

注意 – 当映射主机信道时如果发生了显示错误消息的事件，应重复步骤 1 到 5。

▼ 删除 （取消映射）主机 LUN
1. 在 Change Host LUN Assignments 窗口显示时，从 Host LUN Assignments 字段中

选择要删除的 LUN。

2. 单击 Delete Host LUN。

3. 在完成时，单击 OK 以保存更改并返回到主菜单。

配置文件
在软盘或阵列之外的外围设备上保存当前配置的备份副本。即便配置信息存储在阵列控
制器或连接到它们的物理驱动器上，还可能发生火灾或洪水等情况，这些情况都会造成
控制器和驱动器的损坏。配置的备份副本用于将配置恢复到新控制器，而不必完全重新
配置存储阵列。 

无论何时发生下列情况，应随时将阵列控制器配置保存到文件：

■ 安装新的存储系统机箱或更改现有机箱中控制器的 SCSI ID

■ 更换阵列控制器

■ 重新配置或将逻辑驱动器添加到阵列控制器

■ 从故障驱动器将数据重建到备用驱动器
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▼ 将配置保存到备份文件

1. 选择带有要保存其配置的控制器。

2. 选择 Configuration → Save Configuration。

Save Configuration 窗口显示。

3. 如有必要，可以导航到保存配置的驱动器和文件夹。 

将文件保存到软盘或阵列以外的驱动器。

4. 指定配置文件名称，然后单击 Save。

Save Configuration 窗口显示。

5. 键入要保存的配置的说明。

6. 单击 OK。 

Configuration Service 将控制器配置信息保存到 .cfg 文件。
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装入配置

如果驱动器或控制器损坏并且需要替换，请参阅第 135 页的 “恢复逻辑驱动器配置”，
其中说明了如何装入配置文件，以及如何恢复逻辑驱动器配置。
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第 章8

LUN 过滤 （仅用于光纤信道） 

本章介绍如何为 Sun StorEdge 3510 光纤信道阵列创建 LUN 过滤器，以维护共享公共
存储设备的大型光纤信道网络。本章包含以下主题：

■ 第 79 页的 “概述”
■ 第 81 页的 “分配 LUN 过滤器”
■ 第 81 页的 “访问 LUN Filter 视图”
■ 第 82 页的 “手动添加 HBA 设备”
■ 第 84 页的 “删除标准主机映射”
■ 第 85 页的 “将逻辑驱动器映射到主机”
■ 第 88 页的 “删除 LUN 过滤器”

概述
有效维护存储基础结构的一个重要方面在于维护数据在任意时刻的可访问性和安全性。
在 LUN 过滤功能的支持下，Configuration Service 提供了用于对存储设备访问进行安
全的集中管理的实用程序。 

对于与同一阵列相连的多台服务器， LUN 过滤功能提供了从服务器到逻辑驱动器的独
占路径，从根本上隐藏或排除了其他连接的服务器，使它们不能看到或访问同一逻辑驱
动器。也就是说， LUN 过滤器将组织从主机设备访问和查看阵列设备的方式，而且通
常仅将阵列设备映射到一台主机，这样其他主机就不能访问和使用同一阵列设备。
LUN 过滤功能还可以使多个逻辑驱动器或分区映射到同一 LUN 编号，以允许不同的
服务器拥有各自的 LUN 0 用于启动（如果需要）。LUN 过滤功能还有助于使映射更加
清晰，当每个 HBA 能看到两倍于通过集线器查看到的逻辑驱动器时，这点尤其有用。

每个光纤信道设备都分配了一个唯一的标识符，称为全球广域名称 (WWN)。WWN 由 
IEEE 进行分配，与 IP 中的 MAC 地址或 Internet 上的 URL 类似。这些 WWN 随设备
保留，直到设备寿命到期。 LUN 过滤功能使用 WWN 指定哪台服务器独占使用特定的
逻辑驱动器。可以使用简单的拖放式方法将每个逻辑驱动器映射到主机的光纤信道 
HBA 卡，后者用 WWN 进行标识。 
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如下面的示例所示，当您将 LUN 01 映射到主机信道 0 并选择 WWN1 时，服务器 A 
对该逻辑驱动器拥有专有路径。只要没有为 LUN 02 和 LUN 03 创建过滤器，所有服务
器便都可以继续看到和访问 LUN 02 和 LUN 03。

图 8-1 LUN 过滤示例

LUN 过滤的一个好处是允许更多主机 （如 Windows NT）通过公共光纤信道端口连接
到阵列，同时可以维护 LUN 的安全性。

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B02DE2F

(3) 210000E08B22DE2F

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A B C

01
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分配 LUN 过滤器
分配 LUN 过滤器包括以下步骤：

■ 访问 LUN Filter 窗口

■ 手动添加 HBA 设备 （如果看不到所需的 HBA）

■ 删除标准映射

■ 将逻辑驱动器映射到主机

▼ 访问 LUN Filter 视图

1. 通过单击 Filter View 选项卡访问 LUN Filter 视图。 

2. 单击容器符号 以展开设备树，可在视图的左侧查看服务器详细资料，在视图右侧查
看阵列设备详细资料。 
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▼ 手动添加 HBA 设备

如果在 Hosts 下显示的项目中看不到所需的 HBA 设备，可通过 Configure 
Host/WWN 窗口手动添加 HBA 设备。

1. 选择 Configuration → Configure Host/WWN。

2. 在 Available Hosts 列表中，选择拥有要添加的 HBA 设备的主机，然后单击 Edit。

如果该主机位于 Connected Hosts 列表下，请选择它然后单击 Remove，将其置于 
Available Hosts 列表下。

3. 在 Add/Edit Host 框中，单击 Add。
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4. 在下一个 Add/Edit HBA 框中，输入新的 Adapter Name 和相应的 WWN，然后单击 
OK。

要获得有关确定 WWN 的详细信息，请参阅第 209 页的 “确定主机全球广域名称 
(World Wide Name)”。

5. 在 Configure Host/WWN 窗口中，选择编辑过的主机并单击 Add，将其移入 
Connected Hosts 列表中，然后单击 OK。 

转到 LUN Filter 视图时，新的 HBA 设备显示为灰色并可用于 LUN 过滤。 
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▼ 删除标准主机映射

标准映射允许所有主机看到所有的标准映射逻辑驱动器。 LUN 过滤功能可以将映射限
制到特定的主机。分配 LUN 过滤器之前，必须从阵列中删除标准主机映射 （由 M 卷
标指定 ）。 

1. 单击各 All Hosts 项目，并将其拖放到 Storage Pools。

2. 出现以下消息时单击 OK： 

系统将显示一条消息，确认标准主机 LUN 映射已成功删除。

3. 如果该主机不是阵列的主代理，要将设备映射到该主机，请选择该设备，然后选择 
Configuration → Configure Host/WWN。

4. 从 Available Hosts 列表中高亮显示所需主机，然后单击 Add 将其添加到 Connected 
Hosts 列表中。 

系统将显示消息以确认添加该主机服务器。 

5. 单击 Close 以保存配置信息并退出窗口。

6. 如果要将多台主机映射到一个阵列，请选择 Configuration → LUN Filter Properties，
然后从下拉菜单中选择该阵列。 

7. 选中 Hardware Filter 和 Map to Multiple Hosts 复选框并单击 OK。 

注意 – 如果取消选中 Hardware Filter 复选框，将不能创建过滤器映射；只能创建标准
映射。

Operation will delete all standard maps of Logical Drive X 
Partition X. Do you want to continue?
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▼ 将逻辑驱动器映射到主机

1. 确保处于 LUN Filter 视图；如果不是，请单击 Filter View 选项卡。

2. 从 Storage Pools 中选择一个逻辑驱动器，并将其拖放到 Hosts 下相应的 HBA 卡。 

如果不知道与该阵列相连的 HBA 卡，请将逻辑驱动器拖放至该主机。 

程序将提示您为主机中的每块 HBA 卡过滤阵列 （这表示阵列对与其相连的 HBA 卡可
见，但对其他 HBA 卡不可见）。

3. 显示确认映射的提示时，单击 OK。

Specify Map Information 窗口显示。注意，如果存在一块以上的 HBA 卡，
Configuration Service 自动将逻辑驱动器映射到主机中列出的第一块 HBA 卡。
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4. 将逻辑驱动器分配给主控制器或辅助控制器，并选择所需的信道和 LUN ID 编号，然
后单击 OK。 

将主控制器或辅助控制器分配给 HBA 卡是为初始 LUN 过滤器分配而选择的，因此只
有删除 LUN 过滤器分配并重新开始，才能进行更改。 

要将 LUN 过滤器应用到同一阵列的其他主机，请重复执行第 82 页的“手动添加 HBA 
设备”下的步骤 6 到第 85 页的 “将逻辑驱动器映射到主机”下的步骤 3。 

系统将显示警告提示，提醒您两个用户同时访问同一逻辑驱动器可能导致数据破坏；单
击 OK 将添加该附加主机。 

在下面的示例中， Sun StorEdge 3510 光纤信道设备拥有到两个独立主机的 LUN 过滤
器 （注意字母 F 代表过滤器）。
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▼ 删除 LUN 过滤器

1. 选择相关联的 WWN。

2. 将其拖放到 Storage Pools 中。 

3. 显示确认删除映射的提示时，单击 OK。 

4. 显示第二条确认信息时，单击 OK。 
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第 章9

监控阵列 

本章说明了如何使用 Configuration Service 监控阵列。其中说明了 Configuration 
Service 主窗口以及在主窗口中双击图标时出现的组件视图窗口。还解释了 Event Log 
的工作原理以及如何使用 Configuration Service 的报告功能。本章组织为下列各节：

■ 第 89 页的 “Configuration Service 主窗口”
■ 第 96 页的 “查看详细设备信息”
■ 第 110 页的 “事件日志”
■ 第 114 页的 “保存报告”
■ 第 120 页的 “查看报告”
■ 第 120 页的 “带外存储管理”
■ 第 124 页的 “通过 Web 管理存储设备”

Configuration Service 主窗口
Configuration Service 主窗口提供了所有阵列设备的基本状态。它指示与受 
Configuration Service Console 监控的服务器相连的设备和逻辑驱动器的状态。设备包
括阵列控制器、磁盘存储机箱、物理磁盘驱动器和其他 SCSI 设备。

该窗口的树状结构为连接到每台服务器的所有设备提供了详细信息。树视图左侧的  
或  容器符号代表设备的显示是展开的还是折叠的。  容器符号表示可以单击以显示
更多设备。  容器符号表示已经显示本级别和本级别以下的所有设备。
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下图显示了 Configuration Service 主窗口的扩展视图示例。 

 

注意 – SN# 代表阵列的唯一 ID。

下图显示了折叠视图的示例。

 

要获得详细信息，可以双击图标打开组件视图窗口。将在本章的后续各节中说明组件
视图。
90 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



Configuration Service 主窗口的另一个特点是设备状况是颜色编码和符号编码的，从而
能够容易地识别出处于需要引起注意状态的设备。该状态通过设备树传送，使您可以沿
设备级别跟踪查找故障。查看表 9-1 可以获得设备状态的详细信息。

联机帮助

要访问联机帮助，请选择 Help → Contents。联机帮助为 HTML 格式，可以通过 
Internet Explorer 或 Netscape 运行。其中包括有关程序主要功能的信息。

产品配置的树视图

对于每台服务器 （或服务器组），树视图中的设备都是按照层级结构排布的，服务器
（或组）位于顶端，然后是阵列控制器。剩余设备 （逻辑驱动器、物理设备和机箱）的
显示方式会根据所显示的阵列和控制器的不同而略有差别。本节提供了可以在树视图中
描述的窗口视图。

表 9-1 设备状态状况

颜色 符号 状况

紫色 无 组、服务器或设备处于联机状态。 

白色 无 用户还没有登录到此服务器。

黄色 本组或服务器中的一个或多个组件工作不正常，但是阵列
仍在工作。例如，其中一个物理驱动器发生故障的逻辑驱

动器在低性能状况下运行。

红色 本组或服务器的一个或多个组件不工作。逻辑驱动器具有

两个故障磁盘驱动器或一个机箱有三个故障风扇都会处于
危险状态。

灰色 组、服务器或设备没有响应。

?
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组

组 是设备树中服务器的逻辑集合。这一新的数据对象允许多台服务器包含在单一类
别下。 

组对象的外观 和行为类似于所有树对象。它具有一个图标化表示，用来代表服务
器的状态。下表显示了扩展为显示从属或底层服务器对象的组图标。

组是一个新数据对象，它允许多台服务器包含在单一类别下。组的概念类似于域。组能
够让您在 Configuration Service 中更好地组织服务器。代之于所有受管服务器的线性
树， Configuration Service 操作员可以将服务器组织成相似的集或组。

组的颜色和符号编码与服务器相似。使用该方案，带有对应颜色的状况具有如下优先级 ： 

■ 危险 － 红色 （最高级别）
■ 不响应 － 灰色
■ 低性能 － 黄色
■ 良好 － 紫色
■ 未登录 － 白色

服务器图标具有任何存储系统的最高状况的颜色。相似地，组图标具有其任何服务器的
最高状况，但在存在不响应或未登录服务器的情况下，有以下例外。

如果组图标禁用 （非活动），这表示所有连接到该组的服务器都不响应，如果不是组中
所有的服务器都不响应，则组图标显示为红色，这表示危险状况。例如，如果组中有四
台服务器，三台或少于三台服务器不响应，则组图标为红色颜色编码。
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当组图标的颜色编码为白色时 （未登录到 Configuration Service），这表示组中的一台
或多台服务器未完全配置，或者表示处于状态变化过程中。表 9-2 提供了一个双服务器
组的不同颜色编码示例。 

组不是必需的。例如，可以配置 Configuration Service 为无组而有 15 台服务器，或者一
个包含 10 台服务器的组而顶层另有 5 台服务器。Configuration Service 允许任何组合。

可用的组数和组内服务器的数量仅受到可用系统内存的限制。如果服务器是一个组员而
用户从组列表框删除了该组， Configuration Service 将组内的服务器重新分配给无组
类。 Configuration Service 自动地重新映射主窗口的树。

表 9-2 双服务器组颜色

服务器 1
 图标颜色

服务器 2
 图标颜色 组图标颜色

灰色
灰色

灰色
黄色、红色、紫色或白色

灰色 （不响应）
红色 （危险）

白色 白色 白色 （未登录）

白色 黄色 黄色 （低性能）

白色 红色 红色 （危险）

白色

红色

紫色

任何颜色

紫色 （良好）

红色 （危险）

黄色

紫色

黄色或紫色

紫色

黄色 （低性能）

紫色 （良好）
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Configuration Service 监控过程 
Configuration Service Console 通过与服务器上的 Configuration Service Agent 通信
来监控网络上的存储设备。

如果在配置服务器时指定了 Auto Discovery，则启动 Configuration Service 时，控制
台软件通过建立与每台受管服务器上的 Configuration Service Agent 的通信开始 运
行。如果没有指定 Auto Discovery，则必须双击每台服务器并提供密码，这样才能启
动服务器发现进程。

在控制台和每台服务器上的 Configuration Service Agent 之间建立 TCP/IP 连接并接
收库存信息可能会花费几分钟的时间，这取决于网络的复杂程度。执行这些操作时，
Configuration Service 主窗口中的服务器图标会在其右侧显示一个盘式卫星天线图标。
刷新库存后，盘式卫星天线符号将被活动服务器符号取代。

每台服务器上的代理定期扫描其库存，检查是否发生了变化。如果发生变化，代理将一
个事件发送到控制台。根据事件的不同，控制台可能从该服务器的上次扫描请求库存，
用于更新 Configuration Service 主窗口中显示的服务器。在该过程中，盘式卫星天线
图标附加到了服务器图标上，只有在刷新过程完成并且控制台主窗口更新后，才能进行
配置和执行阵列活动命令。

如果 Configuration Service 正在运行，并且服务器代理和控制台已连接，则 代理定期
发送 ping 测试信号 到控制台以验证服务器的状态。如果控制台没有从代理接收到特定
数量的连续响应 （握手），则控制台将服务器标记为离线并从服务器断开。服务器图标
变为非活动，并且旁边出现一个问号。

如果非活动服务器最初是通过 Auto Discovery 功能成为活动的，则控制台定期尝试建
立服务器的通信。

您有时可能想在两次定期状态扫描之间执行库存检查。要执行该操作，可以双击服务器
图标显示 Server View 窗口，然后单击该窗口中的 Rescan。
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Auto Discovery 选项

如果选择了 Auto Discovery 选项 （在将服务器添加到 Managed Servers 列表的过程
中，请参阅第 39 页的 “选择或取消选择服务器的 Automatic Discovery （自动恢
复）：”）， Configuration Service 在这些服务器上自动扫描并执行库存检查。不需要
提供监控密码就可以检索 Configuration Service 提供的信息。根据网络的复杂程度和
服务器数目的不同，完成发现进程可能需要几分钟时间。

但是，如果选择启动时不使用 Auto Discovery 选项，服务器的图标为白色，表示当前
没有用于这些服务器的信息。在这种情况下，需要双击每个服务器图标并指定相应的监
控密码。 

还可以选择 File → Login。为服务器指定密码以后，Configuration Service 将启动发现
进程，执行对选定服务器的库存检查。 

注意 – 如果需要一个即使对服务器库存数据进行访问都要受到限制的非常安全的环境，
则应为 Auto Discovery 选择 No （请参阅第 39 页的 “选择或取消选择服务器的 
Automatic Discovery （自动恢复）：”）。
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查看详细设备信息 
Configuration Service 提供了有关每个 Configuration Service Agent 或服务器以及与其
连接的阵列设备的详细信息。根据磁盘控制器功能的不同，每个视图上的字段有所不同。

除了位于 File 菜单下的 Save Report 和 View Report，本节介绍的命令和窗口都可以从 
View 菜单获得。

■ View Group
■ View Server
■ 查看控制器配置
■ 查看逻辑驱动器 
■ 查看物理驱动器 
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ 保存报告
■ 查看报告
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View Group 
View Group 显示组成在 Configuration Service 主窗口中选择的组的服务器。

要访问 View Group，双击 Configuration Service 主窗口中的组图标 或选择组图
标并选择 View → View Group。

Server List 显示附加到指定组的所有服务器。 

 

要查看有关列出服务器的详细信息，可以在列表中选择相应的状态记录并单击 View，
或双击状态记录。显示描述相应服务器的窗口。
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View Server 
View Server 显示 Configuration Service 主窗口中选定服务器的特性。

要访问 View Server，双击 Configuration Service 主窗口中的服务器图标 或选择服
务器图标并选择 View → View Server。

 

注意 – 将作为独立条目显示双端口 HBA，因为它们具有供设备连接的单独信道。

作为 TCP/IP 网络的一部分，套接字端口在服务器和客户机之间建立连接。

■ Rescan － 将命令发送到选定的服务器以重新扫描现有的库存并刷新控制台。通常，
每个受管服务器对其库存执行定期扫描，如果发生变化则更新控制台。如果想要对
所有分配的设备执行诊断，单击 Rescan ；选择该按钮将完全阻止状态的定期和自动
更新。

■ Probe － 将命令发送到选定的服务器以探测新的库存（例如，RAID 控制器、JBOD 
和扩展单元）。无论何时添加了新设备或更改了设备名称并想要让它立即显示在 
Configuration Service 主窗口视图中，应单击 Probe。
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■ Card List － 显示安装在或连接到指定服务器的主机适配器和阵列控制器。要查看有
关任何主机适配器或列出阵列控制器的详细信息，可以在列表中选择相应的记录并
单击 View，或双击选定的状态记录。将显示一个描述相应主机适配器或阵列控制器
的窗口。

查看控制器配置

View Controller Configuration 显示组成阵列的组件。 

要访问 View Controller Configuration，双击 Configuration Service 主窗口中的阵列
图标 ，或选择该图标并选择 View → View Controller。
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如果电池发生故障，阵列将在 Configuration Service 主窗口中显示黄色的 （低性能）
设备状态符号，并在 Battery 字段显示 Bad。 

窗口底部的选项卡提供了关于 RAID 控制器的 LUN、与之连接的物理驱动器、控制器
所在的机箱以及外围设备配置的详细信息。要获得有关视图内其他选项卡的信息，可单
击选项卡。

Controllers 选项卡

要访问该窗口，双击 Configuration Service 主窗口中的阵列图标 ，或选择该图标
并选择 View → View Controller。然后单击 Controller 选项卡。 

Controller 选项卡列出了两个控制器。要查看有关这两个控制器中任意一个的更多信
息，双击该控制器，或者选择该控制器然后单击 View。 View Primary 或 View 
Secondary Controller Configuration 窗口出现，具体取决于控制器是主控制器，还是
辅助控制器。参阅第 103 页的 “View Primary/Secondary Controller Configuration
（查看主 / 辅助控制器配置）”。
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Physical Drives 选项卡

要访问该窗口，双击 Configuration Service 主窗口中的阵列图标 ，或选择该图标
并选择 View → View Controller。然后单击 Physical Drives 选项卡。 

下图所显示的是带有 Physical Drives 选项卡的 View Controller Configuration。

Physical Drives 选项卡列出了与阵列相关的物理驱动器。要查看关于任何列出物理驱
动器的详细信息，双击该驱动器或选择驱动器并单击 View。View Physical Drive 窗口
显示。

有关 View Physical Drive 的详细信息，请参阅第 106 页的 “查看物理驱动器”。
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Enclosure Info 选项卡

要访问该窗口，双击 Configuration Service 主窗口中的 Enclosure 图标 ，或选择
阵列图标 并选择 View → View Controller。选择 Enclosure Info 选项卡。选择机
箱并单击 View。

Enclosure Info 选项卡包括电源、风扇和机箱温度的状态信息。有关 View Enclosure 
的详细信息，请参阅第 108 页的 “View Enclosure”。

View FRU

要显示阵列的现场可替换单元标识 (FRU ID) 信息，单击 View FRU。要获得示例 FRU 
ID 信息，请参阅 第 109 页的 “View FRU”。

查看控制器参数

单击 View Controller Parameters 可以查看有关 Channels、 RS 232、 Cache、 Disk 
Array、 Drive I/F、 Host I/F 和 Redundancy 的详细信息。要查看信息，单击与要查
看项目对应的选项卡。要更改控制器参数，请参阅第 165 页的 “更改控制器参数”。
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View Primary/Secondary Controller Configuration （查看主
/ 辅助控制器配置）

View Primary 和 View Secondary Controller Configuration 窗口显示在 
Configuration Service 主窗口中选择的 RAID 控制器的属性。要显示主控制器属性，
从 Configuration Service 主窗口中选择主控制器并选择 View → View Controller，或
双击主控制器。

下列两个示例显示主控制器。
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下列两个示例显示辅助控制器。
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Logical Drives 选项卡

要访问该查看窗口，双击 Configuration Service 主窗口中的主或辅助 RAID 控制器图
标 ，或选择控制器图标并选择 View → Controller。

单击 View Controller Params 可以在 RAID Controller Parameters 窗口中获得可编辑
组件参数。

要查看逻辑驱动器，从 Logical Drives 选项卡选择并双击驱动器，或选择驱动器并单击 
View。
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查看逻辑驱动器

View Logical Drive 显示在 Configuration Service 主窗口中选定的逻辑驱动器的特性。 

要访问该查看窗口，可以使用下列方法之一。 

■ 双击 Configuration Service 主窗口中的逻辑驱动器图标 。 

■ 选择逻辑驱动器图标并选择 View → View Logical Drive。 

■ 双击 RAID 控制器图标 ，选择列表框中的逻辑驱动器，然后单击 View。 

要获得有关列出的磁盘驱动器的详细信息，双击驱动器状态记录，或选择驱动器并单击 
View。 View Physical Drive 窗口显示。 

查看物理驱动器 
View ∅ View Physical Drive 显示所选物理设备的各种特性。根据选择设备的不同，显
示的查看窗口也会不同。

■ 对于磁盘驱动器 ，其名称为 View Physical Drive 窗口。
■ 对于磁带驱动器 ，其名称为 View Tape 窗口。
■ 对于 CD-ROM ，其名称为 View CD-ROM 窗口。 

要访问其中一个窗口，双击 Configuration Service 主窗口中的物理设备，或选择该设
备并选择 View → View Physical Drive。
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■ Associated Partitions － 只在选定的设备与一个或多个逻辑驱动器分区相关时才会
出现。

■ View － 存在相关的逻辑驱动器时才是活动的。

前一图显示了 View Physical Drive 窗口的示例，在该窗口中选定的物理驱动器与单
一分区相关。 

■ Remaining Size － 表示在磁盘驱动器的部分容量已经用于一个或多个逻辑驱动器时
的剩余未用容量。

■ RPM － 物理驱动器的每分钟转速。

■ SMART Drive － 表示驱动器是否具有故障预测能力。

要可以选择物理驱动器，然后选择 View。 View Logical Drive 窗口显示出来，其中没
有表格。

View Tape 和 View CD-ROM 窗口类似于前一图中显示的窗口，但是类别稍有不同。 
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View Enclosure
View Enclosure 窗口显示阵列机箱的组件和警报特性，机箱在 Configuration Service 
主窗口中选择 （由名称 Sun StorEdge 3310 A 标识； ID 始终是 14 或 15）。

1. 选择 EMU 图标 。

2. 选择 View → View Enclosure。

窗口上部的两个部分识别机箱并提供相关的信息。注意，如果有一个具有多机箱的阵
列，则可以使用 Enclosure Number 列表框 （位于窗口的右上角）来反映连接到同一
阵列控制器的另一个机箱。

要显示阵列中所有 FRU 的 FRU ID 和信息，单击 View FRU。

只在具有带 SCSI 存取容错机箱 (SAF-TE) 或 SCSI 机箱服务 (SES) 卡的阵列时，窗口的 
Alarm State 部分才适用。 

■ 如果 Alarm State 字段显示 Alarm! 并且 Reset 按钮显示为可用，则意味着存在驱
动器、风扇、电源或电池故障或者机箱中的温度异常所造成的警报状况。框中的音
频警报响起。
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■ 为使 Configuration Service 在警报条件启动后继续进行监控，必须单击该窗口中的 
Reset，或者可以单击阵列机箱上的 Reset。 

■ 只有拥有配置安全性特权的用户才能通过 Configuration Service 来 Reset （重置）
警报。更换故障组件，或者机箱内部温度异常的情况下，对机箱进行检查。

窗口的下部提供窗口中各个组件的状态。在插槽中有设备时，它由一个带有颜色的驱动
器图标和一个代表其设备状况的符号代表。

View FRU
FRU 是一个现场可更换单元。它是可用于组装新系统或维修现场系统的设备。 Sun 
FRU ID （现场可替换单元标识）程序是一个广泛应用的 Sun 解决方案，它能够获取、
传送并分析特定 FRU 配置、诊断和 FRU 上的故障信息。 

选择 View → View FRU 可以显示阵列中所有 FRU 的 FRU ID 和有关信息，其中包括 
Serial Number、 Model、 Description、 Vendor ID、 Time （FRU 的编程时间）和 
Location。

注意 – 还可以通过单击 View Controller Configuration 窗口、 View Primary 
Controller Configuration 窗口和 View Secondary Controller Configuration 窗口中的 
View FRU 查看 FRU。
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Array Administration Progress
Array Admin Progress 显示新逻辑驱动器的初始化过程。要访问该命令，选择 View 
→ Array Admin Progress。

Agent Options Management
Agent Options 允许您定制 Configuration Service Agent 选项，其中包括轮询时间、
定期设备发现时间和 SMART 监控。

要访问 Agent Options，选择 View → Agent Options Management。要获得详细信
息，请参阅第 48 页的 “配置代理参数 （可选）”。

事件日志
Configuration Service Console 接收、记录并显示由受管服务器和 Configuration 
Service Console 自身产生的事件。

大部分事件是由受管服务器上的 Configuration Service Agent 在发生下列情况时生成的：

■ 因为设备故障、功能异常或断开连接，受管服务器上的任何设备状态都在变化，其
中也包括服务器自身的变化

■ 库存变化 （设备的增加或减少）

■ 配置变化 （初始配置设置和后续配置更改）

■ 服务器上运行的阵列进程 （初始化、奇偶校验、重建）

虽然阵列进程是由 Configuration Service Console 启动的，但是操作通知事件是由服
务器代理在这些进程从服务器上启动后产生的。

Configuration Service Console 产生的事件数目相对而言很少。例如，如果它没有从受
管服务器接收到特定数目的连续脉冲信号，将生成一个事件。

控制台接收到任何事件时，它都将事件记录到 Configuration Service 的事件日志文件
eventlog.txt 中，并将其显示在 Event Log 窗口中。另外，如果事件发生在服务器上，
则事件通知被发送到服务器的操作环境或系统事件日志。在 NT 服务器上，它进入 NT 事
件日志中。另外，如果事件发生在服务器上并且服务器设置为将陷阱发送到诸如 HP
OpenView 等 SNMP 企业管理控制台，则服务器代理还将陷阱消息发送到该计算机。

根据接收事件的不同，控制台可能会启动刷新进程，从服务器上次所进行的周期性扫描
请求库存，从而使得控制台能够更新 Configuration Service 窗口中的服务器库存。 

在刷新过程中，盘式卫星天线图标将附加到服务器图标上，只有在刷新过程完成并且控
制台主窗口更新后，才能进行 Configuration Service 配置并执行阵列活动命令。
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事件日志文件

Configuration Service 的 Event Log 窗口一次最多可以显示 500 个事件。如果事件超
过了 500 个，则只有最新的 500 个显示在 Event Log 窗口中，但是 Configuration 
Service 并不会将任何事件从 Event Log 文件  eventlog.txt  删除，直到记录了超
过 10,000 条事件才会进行删除。

■ 在记录了 10,000 条事件后，Configuration Service 将 Event Log 文件减少到最新的 
500 条事件，然后开始积累事件，直到再次达到 10,000 条的限制。

■ 事件记录的每个字段由分号分隔，因此可以很容易地导入到数据库中。

■ eventlog.txt 位于安装 Configuration Service Console 程序文件的目录中。
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Event Log 窗口

要访问 Event Log，选择 View → Event Log。单击 Close 可以隐藏此窗口，并可以在
不丢失任何内容的情况下重新打开 （从 View 菜单）。

各个 Configuration Service Console 在运行时开始接收事件，而无论 Event Log 窗口
是否打开。

1. 要删除日志文件，单击 Delete Logfile。 

Confirmation 窗口显示，提示您保存日志文件。

2. 选择下列某一选项：

■ 在得到提示时选择 yes （是），选择文件夹和文件名，对日志文件进行保存。 

■ 在得到提示时选择 no （否）。

日志文件的内容将被删除。

注意 – 也可以使用工具条上的 Save Event Log 和 Delete Event Log 图标保存和删除 
eventlog.txt 文件的内容。
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每个事件记录都包含下表中显示的字段。

严重级别
■ Critical。该消息要求网络管理员加以干预，例如设备、电源或风扇发生故障。

■ Warning。警告消息一般用来指示内部程序事件。但是，如果看到大量的此类消息，
可能表示服务器或网络存在故障。

■ 信息。有关服务器上设备的消息，不需要网络管理员进行干预。

接收为选定级别和任何具有其他更高严重级别转发的警报。因此，如果选择 
Informational，则会得到有关所有警报条件的通知。但是，如果选择 Critical，则只接
收 Critical 警报。

要获得有关这些消息的详细信息，请参阅第 223 页的 “故障检修”。 

表 9-3 事件记录字段

Date 事件发生时服务器的日期。

Time 事件发生时服务器的时间。

Server 服务器的 IP 地址和服务器名称。

Card 如果适用，是事件的卡名称。

Severity
三个严重级别之一：Critical、 Warning 或 Informational。（在下面的子
节中说明了这些状况。）

Error Code 由破折号分隔的基本错误代码和扩展错误代码。

Text Message 描述事件的文本消息。
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保存报告 
使用 Configuration Service 的 Save Report 选项可以创建一个文本文件，其中包含有
关特定阵列的可以提供给 Configuration Service 的所有信息。

1. 选择 File → Save Report。 

显示 Report 对话框以确认服务器的 ID。

2. 选择 Save report。 

Save Report File 窗口显示。使用 ASCII 文本文件格式保存报告文件。 
114 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



3. 键入一个文件名 （带有用于标识文件类型的 .txt 扩展名），并单击 Save。

Configuration Service 写入报告，其中包含选定服务器及其设备的库存和状态。 

报告文件的默认保存位置是 Configuration Service 的安装目录。最好创建一个保存报
告的子目录，因为这样可以避免安装目录出现混乱。

下图显示了示例报告的节选。
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查看报告 
使用 Configuration Service 的 View Report 选项可以查看已创建的报告。

1. 选择 File → View Report。 

显示用于选择报告的 Open 对话框。

2. 选择要查看的报告，然后单击 Open。

带外存储管理 
Configuration Service 的带外存储管理功能让您能在使用 TCP/IP 的网络上监控并管理
阵列。与带内存储管理 （标准存储管理方法）不同的是，带内存储管理要求 
Configuration Service Agent 在物理连接存储器的服务器上运行，而带外存储管理不要
求 Configuration Service Agent 在物理连接存储器的服务器上运行。使用带外存储管理
就不需要在服务器上加载额外的软件；您具有从网络任何一处监控和管理存储的灵活性。
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下列各图举例说明各种带内和带外存储管理配置。

图 9-1 带内管理

图 9-2 带外管理

Configuration
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SCSI/FC SCSI/FC

Array

1.1.1.3 1.1.1.4

Agent......1.1.1.1

Service
Agent
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Array ......1.1.1.0

1.1.1.4
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Configuration
Service Agent

SCSI/FC
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▼ 使用带外管理

注意 – 在开始前，确保已经为阵列设置了静态或动态 IP 地址。

注意 – 无法通过带外管理升级控制器、 SAF-TE 和驱动器固件。

1. 选择服务器。

2. 选择 View → Agent Options Management。 

3. 在 Agent Options Management 窗口中，选中 Out-Of-Band Agent preferred over 
In-Band。 

注意 – 选择该选项后，带外成为存储管理的首选方法。如果删除了带外配置，在启动
或重新启动服务后， Configuration Service 将返回到带内存储和监控。

4. 在 IP Address 字段中输入阵列的 IP 地址，并单击 Add。

5. 为让 Configuration Service 识别带外阵列并在主窗口中显示，应选择服务器。

6. 选择 View → View Server。

7. 单击 Probe。
122 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



一个带外 HBA 显示在 Configuration Service 主窗口。
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▼ 通过带外管理删除阵列

1. 选择服务器。

2. 选择 View → Agent Options Management。

3. 选择要从 Managed Primary Agent 列表中删除的阵列，然后单击 Remove。

HBA 仍显示在 Configuration Service 主窗口中，要将其删除，需要停止 / 重新启动
服务。

通过 Web 管理存储设备 
Configuration Service 的基于 Web 的存储管理功能能够让您方便地通过 Web 管理阵
列，而不必装入整个 Configuration Service 软件包。下列步骤说明如何设置阵列以实
现基于 Web 的管理，以及如何通过 Web 浏览器对其进行访问。 

注意 – Linux 不支持此项功能；也就是说，如果代理安装在运行 Linux 操作环境的系
统上， Custom Configure 窗口上的 Configure Web Server 选项将不可用。可以使用 
Linux Web 浏览器装入控制台，但代理必须安装在运行 Solaris 操作环境的系统上。

Web 浏览器要求 

Solaris 操作环境
■ Netscape 4.76
■ Java Plug-in 1.2.2_02
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Microsoft Windows NT/2000 操作系统
■ Internet Explorer 5.0 或更高版本
■ Java Plug-in 1.2.2_02

或者

■ Netscape 4.76
■ Java Plug-in 1.2.2_02

设置阵列

尽管无需将整个 Configuration Service 软件包装入到将用于从 Web 访问阵列的计算机
上，但某些 Configuration Service 文件是必需的；因此必须将整个 Configuration 
Service 软件包安装到另一台服务器上，这样可以从该服务器向阵列传输文件。以下步
骤介绍如何方便地传输必要的文件以设置 Web 管理。

1. 确保拥有从网络到阵列的以太网连接，并且已经为阵列设置了 IP 地址。

2. 在安装有整个 Configuration Service 软件包的服务器上，选择 Configuration → 
Custom Configure。

3. 选择 Configure Web Server。

4. 验证管理代理的 IP 地址，该代理运行在直接连接到存储设备的服务器上。

5. 输入文件将被传输到的阵列的 IP 地址并单击 OK。

注意 – 默认情况下，该阵列没有设置密码。如果已经使用固件应用程序创建了密码，
则必须输入该密码。要获得有关创建或更改该密码的详细信息，请参阅适用于您的阵列
的 Sun StorEdge 3000 Family RAID Firmware User's Guide。

文件成功传输之后，将显示确认消息，现在便可以通过 Web 访问控制台了。
第 9 章 监控阵列 125



▼ 通过 Web 浏览器访问控制台

1. 打开 Web 浏览器。

2. 键入以下 URL 地址：

3. 按本指南中相应章节所示继续监控、维护和更新存储设备。

http:// ip address of workstation/esm.html
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第 章10

维护阵列 

本章说明如何使用 Array Administration 来维护阵列的完整性。本章包含下列主题：

■ 第 128 页的 “阵列管理活动”
■ 第 128 页的 “进行奇偶校验”
■ 第 129 页的 “进行奇偶校验调度”
■ 第 131 页的 “故障驱动器”
■ 第 131 页的 “使用备用驱动器自动重建驱动器”
■ 第 132 页的 “在没有备用驱动器的情况下进行设备重建”
■ 第 133 页的 “检查重建过程的进度”
■ 第 133 页的 “手动重建故障驱动器”
■ 第 135 页的 “恢复逻辑驱动器配置”
■ 第 138 页的 “重置控制器”
■ 第 138 页的 “将控制器蜂鸣器静音”
■ 第 139 页的 “让故障控制器恢复联机”
■ 第 140 页的 “显示 Performance Statistics”
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阵列管理活动
阵列管理活动 （例如初始化、驱动器重建和奇偶校验）可能会花费一定的时间，这取
决于相关的逻辑驱动器或物理驱动器的大小。

其中一个过程开始后，将显示 Controller Array Progress 窗口。如果关闭了该窗口，要
查看进度，单击 Progress Indicator 图标 或选择 View → Array Admin Progress。 

▼ 进行奇偶校验    
奇偶校验是检查容错逻辑驱动器或 LUN （RAID 3 和 5）上冗余数据完整性的过程。

1. 选择要在其上运行奇偶校验的逻辑驱动器。

2. 选择 Array Administration → Parity Check。

注意 – 需要作为 ssadmin 或 ssconfig 登录才能访问菜单上的选项。

3. 当 Logical Drive Parity Check 窗口显示时，选择想要进行奇偶校验的逻辑驱动器。
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要对多个驱动器进行奇偶校验，使用 Array Administration → Schedule Parity Check 
命令，安排在近期内 （如三分钟内）进行一次奇偶校验。当调度的奇偶校验运行时，
它将逐个自动执行校验。

4. 单击 Parity Check 按钮，启动奇偶校验过程。

奇偶校验启动后，将自动显示 Progress Indicator。如果该窗口关闭，选择 View → 
Array Admin Progress 或单击 Progress Indicator 图标就可以将其重新打开。窗口出
现，其中显示每个阵列完成进度的百分比。

▼ 进行奇偶校验调度      
选择 Array Administration → Schedule Parity Check，按照调度间隔 （例如在非高峰
时间）对所指定的逻辑驱动器阵列进行校验奇偶。

■ 您可以选择调度在受管服务器上配置的任意数目的逻辑驱动器，但是，在每一阵列
控制器上您只可建立一个调度。

■ 在调度多个逻辑驱动器时，校验按逻辑驱动器编号从低到高的顺序进行。

■ 进行奇偶校验，每 GB 存储平均需要五分钟时间。

■ 通过更改背景率，可以控制分配进行奇偶校验的系统资源量。

■ 奇偶校验开始之后，可以予以停止。此操作不会导致任何数据破坏。

注意 – 需要作为 ssadmin 或 ssconfig 登录才能访问菜单上的选项。
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1. 选择要对其调度奇偶校验的控制器。

2. 选择 Array Administration → Schedule Parity Check。

Schedule Parity Check 窗口显示。

3. 在该窗口的相应字段作出选择。

■ Listed Logical Drives － 可用的容错逻辑阵列的列表。使用 Shift 键选择多个驱动器。

■ Background Rate － 分配给阵列管理活动的可用阵列控制器 CPU 时间的百分比。
从 Custom Configuration Options 窗口选择 Change Controller Parameters 更改背
景率。

■ How Often － 指定进行奇偶校验的频率。

■ Starting Day － 指定该规划启动的每星期时间。

■ Starting Time － 指定该规划开始的启动日时间。

■ Existing Schedule － 当前的奇偶校验调度：逻辑驱动器、频率、开始日和时间。

■ Next Parity Check － 下一次奇偶校验启动的日期和时间。

4. 对调度满意之后，单击 OK。
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故障驱动器 
此节提供使用 （或不使用）备用驱动器从驱动器故障进行恢复的过程。如果因为某些
原因无法启动重建过程，还提供了在驱动器发生故障后，手动重建驱动器的指令。

警告 – 须在发生故障之前预先为每个逻辑驱动器阵列安装和配置本地或全局备用驱动
器。根据使用的 RAID 级别类型以及归档实现过程的不同，在一个或多个驱动器发生故
障时，可能丢失大量数据。另外，应在现场准备好经过测试的备用驱动器，以在发生故
障时立即替代。 

▼ 使用备用驱动器自动重建驱动器

当与容错逻辑驱动器相关的驱动器发生故障，且备用驱动器已预先安装和配置为全局或
者本地备用驱动器时，故障驱动器将被自动替换，并且使用指定的备用驱动器重建其数
据。为使该过程正确完成，备用驱动器的容量必须总是等于或大于被替代的故障驱动器。 

重建进程通常在一到两分钟内启动。该程序在后台运行，在控制器上没有其它活动的情
况下，每 GB 大约需要 8 分钟时间。

在自动重建过程中，正常活动可以继续，但是性能会降低。性能降低的程度取决于控制
器设置的背景率。

要显示重建进程的进度，选择 View → Array Admin Progress。

1. 要重新建立自动重建功能，须根据 Sun StorEdge 3000 系列安装、操作和维护手册中的
指示来更换故障驱动器。

2. 在取下故障驱动器后插入另一个新的驱动器之前，至少等待 60 秒。 

确保替换用驱动器至少等于机箱中最大驱动器的容量。将替代驱动器插入故障驱动器的
同一个插槽中 （驱动器托架），替代驱动器就可成为新的备用驱动器。

3. 重建过程完成，并且逻辑驱动器再次联机后，应将阵列控制器配置备份到外部驱动器或
软盘上的文件中。

请参阅第 53 页的 “保存逻辑驱动器配置”。
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▼ 在没有备用驱动器的情况下进行设备重建

如果在阵列中没有备用驱动器，在故障重建程序启动前，需要替代故障驱动器。

1. 如果没有备用驱动器，要恢复驱动器故障，应根据适用于您的阵列的 Sun StorEdge 3000
系列安装、操作和维护手册中的指示更换故障驱动器。 

2. 在取下故障驱动器后插入另一个新的驱动器之前，应至少等待 60 秒。 

确保替代驱动器的容量至少等于故障驱动器的容量。将替代驱动器安装于故障驱动器相
同的地址 （驱动器托架）。

3. 当在同一插槽中更换故障驱动器之后，需要对其进行扫描。

要获得在驱动器中扫描的详细指示，请参阅第 158 页的 “扫描新硬盘驱动器”。

4. 扫描驱动器后，必须通过选择 Array Administration → Rebuild 来手动对其进行重建。
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▼ 检查重建过程的进度

1. 选择 View → Array Admin Progress 或单击窗口右上角的 Progress Indicator 图标
。 

Controller Array Progress 窗口出现，其中显示重建完成的百分比。但是，如果在多个
控制器上有阵列活动（如初始化，重建或奇偶校验）发生，首先显示 Select Controller 
Progress 窗口。 

2. 选择要查看其进度的控制器，并单击 OK。 

Controller Array Progress 窗口出现，其中显示选定控制器的阵列进度。请参阅第 128 
页的 “阵列管理活动”。

▼ 手动重建故障驱动器

大多数情况下，不必使用手动重建过程，因为替代驱动器将被自动重建。 

如果备用驱动器在故障发生时不可用，或由于某些原因，驱动器无法重建，可以使用 
Rebuild 手动启动重建程序。另外，若重建程序因重新设置而中断，使用 Rebuild 重新
启动重建程序。

1. 根据适用于您的阵列的 Sun StorEdge 3000 系列安装、操作和维护手册中的指示来更换
故障驱动器。

2. 在取下故障驱动器后插入另一个新的驱动器之前，应至少等待 60 秒。 

确保替换用驱动器的容量至少等于机箱内最大驱动器的容量。 

3. 选择 Array Administration → Rebuild。 

Rebuild 窗口显示。 
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4. 选择替代驱动器的状态记录。

5. 单击 OK 以启动重建过程。

重建过程是在后台执行的，在阵列控制器上没有其他活动时，每 GB 数据大约需要处理 
8 分钟。在重建期间，虽然性能会下降，但是常规活动仍可以继续。性能降低的程度取
决于控制器设置的背景率。

6. 要检查重建过程的进度，选择 View → Array Admin Progress 或单击窗口右上角的 
Progress Indicator 图标。

Controller Array Progress 窗口出现，其中显示重建完成的百分比。

如果在多个控制器上有阵列活动（如初始化，重建或奇偶校验）发生，首先显示 Select 
Controller Progress 窗口。

7. 选择要查看其进度的控制器，并单击 OK。 

Controller Array Progress 窗口出现，显示该控制器的阵列重建状态。 
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▼ 恢复逻辑驱动器配置 
本节说明了如何从备份文件中恢复阵列配置信息。必须已经使用 Save 命令保存过备份
文件 （如第 76 页的 “配置文件”所示）。如果阵列控制器及其驱动器损坏，可以将阵
列配置恢复到新控制器，而不必完全重新配置存储阵列。

警告 – 只有当配置文件是当前的，才从文件中恢复阵列配置。恢复过时的或不正确的
配置会导致数据丢失。

如果确定备份文件包含正确的阵列配置信息，继续下列过程恢复配置。

1. 为相应的阵列选择控制器。

2. 选择 Configuration → Load Configuration。 

Select Configuration File 窗口显示。 

3. 指定备份配置文件的名称和位置，并单击 Open。
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Load Configuration 窗口显示。要查看配置树视图表示，单击 Configuration View 选
项卡。

Saveset Description 选项卡显示创建配置文件时指定的文件说明。
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4. 要装入已保存的配置，选择 OK。

Load Configuration Confirmation 窗口显示。

在做出是否继续的决定前，应仔细 检查 Load Configuration Confirmation 窗口中显示
的信息。

5. 单击 Apply 以装入此配置，或单击 Cancel 以终止此功能。

单击 Apply 将继续配置操作，并显示进度窗口。

注意 –  不要 在恢复阵列配置备份文件内容后初始化 LUN。

6. 如果正在运行 Microsoft Windows NT，应关闭并重新启动操作系统。

需要重新初始化操作系统以使逻辑驱动器配置被 Windows NT 识别。
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▼ 重置控制器

无论何时对控制器参数做出更改，都将询问是否要重置控制器以使更改生效。如果做出
多个更改，可能不想在每次更改后便停止并重置控制器。使用 Issue Reset to the 
Controller 选项在做出多个参数更改后手动重置控制器。

1. 在主窗口中选择任意存储设备图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Issue Reset to the Controller。

▼ 将控制器蜂鸣器静音

当引起控制器发出蜂鸣声的事件发生时 （例如逻辑驱动器故障、重建期间或者添加 
SCSI 驱动器），您可以将控制器蜂鸣器静音。 

1. 在主窗口选择控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Mute Controller Beeper。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Mute Beeper。
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▼ 让故障控制器恢复联机

如果控制器发生故障，可以按照下列步骤让其重新联机。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Deassert Failed Redundant Controller。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Redundancy 选项卡。

5. 从 Set Controller Config 字段，选择 Redundant Deassert Reset。
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▼ 显示 Performance Statistics
使用 Configuration Service 的 Performance Statistics，可以确定数据传输速率，也就
是阵列运行的速度。

1. 选择 Array Administration → Controller Maintenance。

2. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

3. 单击 Performance Statistics。

Performance Statistics 窗口显示。
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第 章11

更新配置

当希望更改当前配置或添加内容时，请参阅本章。本章说明了下列任务：

■ 第 142 页的 “添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷”

■ 第 146 页的 “删除逻辑驱动器或逻辑卷”

■ 第 149 页的 “创建分区”

■ 第 151 页的 “删除分区”

■ 第 153 页的 “扩展逻辑驱动器或逻辑卷的容量”

■ 第 155 页的 “将 SCSI 驱动器添加到现有逻辑驱动器”

■ 第 156 页的 “复制并替换成员驱动器”

■ 第 158 页的 “扫描新硬盘驱动器”

■ 第 159 页的 “下载 RAID 控制器固件”

■ 第 162 页的 “升级固件和引导记录”

■ 第 163 页的 “升级硬盘驱动器上的固件”

■ 第 164 页的 “升级 SAF-TE 设备的固件”

■ 第 165 页的 “更改控制器参数”

■ 第 176 页的 “将控制器蜂鸣器静音”

■ 第 176 页的 “保存已更改值”

■ 第 177 页的 “指定或更改备用驱动器”

■ 第 178 页的 “编辑服务器条目”

如果诸如奇偶校验等阵列管理进程正在运行，则可能会暂时禁用 Configuration 菜单命
令和工具图标。当 Configuration Service Console 正在刷新服务器上的库存时菜单命
令也显示为停用。在刷新过程中，盘式卫星天线图标将被附加到服务器图标 。

要使用 Configuration 选项，必须使用 ssconfig 密码登录到软件的 ssconfig 安全
级别。完成配置活动时，应登录回程序的监控级别。
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▼ 添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷

使用该选项可以向 RAID 集的现有配置添加一个或多个逻辑驱动器，或者从新的 逻辑
驱动器添加逻辑卷。要从现有的 逻辑驱动器添加逻辑卷，请参阅第 145 页的 “将现有
的逻辑驱动器添加到逻辑卷”。

注意 – 如果逻辑驱动器的容量将超过 253 GB，请参阅第 66 页的 “准备容量超过 253 
GB 的逻辑驱动器”。

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

注意 – 该选项是不活动的，除非已选择了带有可用物理驱动器的阵列。

3. 从 Custom Configuration Options 窗口选择 Add LDs/LVs to the Current 
Configuration。

4. 验证显示在窗口的顶部的服务器和控制器是否正确。

5. 选择要包括在新逻辑卷中的磁盘并单击 Add Disk。

如果操作错误或您改变了决定，选择驱动器并单击 Remove Disk。

6. 选择一个 RAID Level （RAID 级别）。 

有关 RAID 级别的定义，请参阅第 181 页的 “RAID 基本知识”。 

7. 从 Channel 和 SCSI ID 列表框中选择要将新逻辑驱动器映射到其上的主机信道和 
SCSI ID。

8. 设置 Max Drive Size。 

Max Drive Size 显示每个磁盘的总容量。通过减小该值可以创建较小的逻辑驱动器。   

注意 – 如果不更改 Max Drive Size 但更改 Partition Size，则 Configuration Service 
按指定大小创建新的分区。剩余的逻辑驱动器大小的容量移到最后一个分区。在以后可
以通过扩展驱动器利用剩余容量 （如第 153 页的 “扩展逻辑驱动器或逻辑卷的容量”
所示）。在创建分区后，不能再编辑驱动器容量。

注意 – 如果要在同一控制器上再创建一个逻辑驱动器，单击 New LD。Configuration 
Service 将创建您刚定义的逻辑驱动器并返回窗口顶部，使您可以创建另一个逻辑驱动
器。在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑驱
动器最多可以有 32 个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑
驱动器，每个逻辑驱动器最多可以有 128 个分区。 
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9. 将此逻辑驱动器添加到逻辑卷，请单击 New LD 并参阅第 144 页的 “将逻辑驱动器添
加到逻辑卷”。

10. 若对该窗口的选择满意，并且不需要定义另一个逻辑驱动器，单击 Commit。 

新的配置显示在确认窗口中。

11. 单击 OK 以接受配置。 

12. 选择 Cancel 返回到 Configuration Service Console。

这提供了额外的容错。可以根据需要随时将驱动器的状况改回可用。

注意 – 单击 OK 后就不能再更改逻辑驱动器的配置。

注意 – 在初始化期间， LD/LV 的大小显示为 0 MB。
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▼ 将逻辑驱动器添加到逻辑卷 

逻辑卷由 2 个或 2 个以上逻辑驱动器组成，最多可以划分为 32 个分区。操作期间，主
机将未分区的逻辑卷或逻辑卷的分区作为单个物理驱动器对待。 

1. 根据第 142 页的 “添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷”中步骤 1 到 8 所
述创建逻辑驱动器。

注意 – 不要对要添加到逻辑卷中的逻辑驱动器进行分区。已经分区的逻辑驱动器不能
添加到逻辑卷中。

2. 要将逻辑驱动器添加到逻辑卷，请在单击 Commit 之前，单击 Add to LV。

该逻辑驱动器便被添加到 LV Definition 框中。该逻辑卷的总大小显示在 Available 
Size (MB) 字段中。 

注意 – 因为逻辑卷尚未进行分区，所以 Part Size (MB) 与 Available Size (MB) 是相等
的。逻辑卷被视为一个单个的分区。

3. 要创建另一个逻辑驱动器以添加到该逻辑卷中，请单击 New LD。

4. 创建逻辑驱动器，并单击 Add to LV 将它添加到逻辑卷中。

为要添加到逻辑卷中的每个逻辑驱动器重复此步骤。

5. 要创建分区，请参阅第 149 页的 “创建分区”。

6. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其他逻辑卷或者创建个别逻辑驱动器，
请单击 Commit LV。

在创建完逻辑卷之后，如不想创建逻辑驱动器，请单击 Commit。

注意 – 当您创建完逻辑卷以后要退出 New Configuration 窗口时，如果不慎单击了 
Commit LV 而不是 Commit，则必须再创建一个逻辑驱动器；否则，您只能单击 
Cancel 并重新配置该逻辑卷。
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▼ 将现有的逻辑驱动器添加到逻辑卷

注意 – 在从现有的逻辑驱动器添加逻辑卷之前，必须首先取消对该逻辑驱动器的映射。

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

注意 – 该选项是不活动的，除非已选择了带有可用物理驱动器的阵列。

3. 从 Custom Configuration Options 窗口选择 Add LDs/LVs to the Current 
Configuration。

4. 验证显示在窗口的顶部的服务器和控制器是否正确。

5. 选择 Use existing LDs to create LVs。

如果在 Select a Logical Drive 下没有列出任何逻辑驱动器，则说明还没有取消对这些
逻辑驱动器的映射，因此不可选。首先必须取消对逻辑驱动器的映射。

6. 选择逻辑驱动器并单击 Add to LV。

7. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其他逻辑卷或者创建个别逻辑驱动器，
请单击 Commit LV。

在创建完逻辑卷之后，如不想创建个别逻辑驱动器，请单击 Commit。

注意 – 当您创建完逻辑卷以后要退出 New Configuration 窗口时，如果不慎单击了 
Commit LV 而不是 Commit，则必须再创建一个逻辑驱动器；否则，您只能单击 
Cancel 并重新配置该逻辑卷。
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▼ 删除逻辑驱动器或逻辑卷

使用该选项可以从 RAID 集合的现有配置中删除一个或多个逻辑驱动器或逻辑卷。

注意 – 在删除逻辑驱动器或逻辑卷之前，必须取消对所有已分配的 LUN 的映射。

1. 选择相应的阵列。

2. 查看要删除的逻辑驱动器或逻辑卷。

3. 只要任何逻辑驱动器或逻辑卷拥有主机 LUN 分配，执行步骤 4 ；如果没有，执行
步骤 8。

4. 选择 Configuration → Custom Configure。

5. 选择 Change Host LUN Assignments。

6. 选择连接到要取消映射的逻辑驱动器或逻辑卷的主机 LUN，并单击 Unmap Host 
LUN。

如果选择 Use existing LDs 
to create LVs 之后，没有列出
任何逻辑驱动器，则说明逻辑
驱动器还没有取消映射。您必
须首先取消对逻辑驱动器的
映射。
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7. 单击 OK，然后单击 Close。

8. 选择 Configuration → Custom Configure。

9. 从 Custom Configuration Options 窗口选择 Manage Existing LDs/LVs and 
Partitions。

10. 选择 LDs/LVs 选项卡。

11. 选择要删除的逻辑驱动器或逻辑卷，然后单击 Delete 并单击 OK。

删除逻辑卷时，单击 Delete 后，逻辑卷即被删除，但仍然显示组成该逻辑卷的逻辑驱
动器。

12. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，然后单击 Close。
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关于逻辑驱动器 / 逻辑卷号码

与每个逻辑驱动器相关的逻辑驱动器 / 逻辑卷号码是动态的；当创建 / 删除逻辑驱动
器时，号码会发生变化。此号码显示在某些 Configuration Service 窗口的逻辑驱动器 
(LDs/LVs) 字段，这些窗口包括 Dynamically Grow and/or Reconfigure LDs/LVs、
Change Host LUN Assignments、 Manage Existing LDs/LVs and Partitions 和 
Configuration Service 主窗口。

该号码严格用作占位符，以便能够在视觉上 跟踪逻辑驱动器和逻辑卷，因而对控制器
没有意义。也就是说，控制器并不依据该号码对逻辑驱动器或逻辑卷进行报告。例如，
如果存在四个逻辑驱动器， LD2 被删除，则现有的 LD3 动态变为 LD2，而 LD4 变为 
LD3。只有 LD/LV 号码发生变化；逻辑驱动器上的所有 LUN 映射和数据保持不变。 

控制器报告逻辑驱动器的总数目 （这里是三个），因此显示在 LD/LV 字段中的实际 
LD/LV 号码是不相关的。在本示例中，如果创建了新的逻辑驱动器，则占用已删除的
逻辑驱动器的 LD 号码，控制器报告总共有四个逻辑驱动器。所有现有的逻辑驱动器回
到原先的主 / 辅助指定。 

注意 – 如下面的示例所示，固件终端菜单选项 View and Edit Logical Drives 上的 LG 
号码在视觉上不是 动态的。删除逻辑驱动器后，您将看到空的占位符。在从控制台或
终端创建逻辑驱动器时，这一空的占位符填充为新的逻辑驱动器。

Manage Existing LDs/LVs and Partitions 窗口中的 LD 字段（右边）是动态的；
当创建 / 删除逻辑驱动器时，该字段发生变化。在本示例中，LD2 被删除并且

Drives（左边）中，LG 字段不是动态的；空的插槽表示 LD2 已被删除。
LD4 变为 LD3，LD 2 变为 LD1。在终端菜单选项 View and Edit Logical
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▼ 创建分区

注意 – 创建分区前，需要取消映射所有指定的 LUN。

1. 选择相应的阵列。

2. 查看要创建分区的一个或多个逻辑驱动器。

3. 只要任何逻辑驱动器拥有主机 LUN 分配，执行步骤 4 ；如果没有，执行步骤 8。

4. 选择 Configuration → Custom Configure。

5. 选择 Change Host LUN Assignments。

6. 选择连接到要分区的一个或多个逻辑驱动器的主机 LUN，并单击 Unmap Host LUN。

7. 单击 OK，然后单击 Close。

8. 选择 Configuration → Custom Configure。

9. 从 Custom Configuration Options 窗口中选择 Manage Existing LDs/LVs and 
Partitions。

10. 选择 Partitions 选项卡。

11. 选择要进行分区的逻辑驱动器或逻辑卷。

12. 以 MB 为单位指定 Partition Size 并单击 Create。

要创建相同大小的多个分区，请多次单击 Add Partition，单击的次数与您希望创建的
分区数相同。还可以在 Part Size 字段中键入分区大小，然后将它与您要创建的分区数
相乘 (*) （例如 100*128）。剩余的 MB 大小将添加到最后一个分区。

在添加分区时，显示在 Available Size (MB) 中的剩余容量将减去分区的大小。

13. 要更改已创建分区的大小，选择逻辑驱动器或逻辑卷，并单击 Modify Size。 

14. 在 Partition Size 字段中指定新的大小 （以 MB 为单位），然后单击 OK。
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15. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，并单击 Close。

对逻辑驱动器或逻辑卷进行分区后，如果在 Configuration Service 主窗口上打开逻辑
驱动器或逻辑卷，将显示分区  。

关于逻辑驱动器 / 逻辑卷号码

要获得有关在 Manage Existing LDs/LVs and Partitions 窗口的 LDs/LVs 字段中显示
的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 148 页的 “关于逻辑驱动器 / 逻辑
卷号码”。
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▼ 删除分区

注意 – 要删除逻辑驱动器或逻辑卷上的分区，需要取消映射所有分配的 LUN。

1. 选择相应的阵列。

2. 查看要在其上删除分区的逻辑驱动器或逻辑卷。 

只要驱动器上的任何分区已映射了 LUN，执行步骤 3 ；如果没有，执行步骤 7。

3. 选择 Configuration → Custom Configure。

4. 选择 Change Host LUN Assignments。

5. 选择已映射到要删除的逻辑驱动器或逻辑卷的分区的 LUN，并单击 Unmap Host 
LUN。

6. 单击 OK，然后单击 Close。

7. 选择 Configuration → Custom Configure。

8. 从 Custom Configuration Options 窗口中选择 Manage Existing LDs/LVs and 
Partitions。

9. 选择 Partitions 选项卡。

10. 从逻辑驱动器或逻辑卷中的最后一个分区开始选择要修改或删除的分区。

11. 单击 Delete，然后单击 OK。
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12. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，并单击 Close。
152 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



▼ 扩展逻辑驱动器或逻辑卷的容量

使用该选项可以扩展现有逻辑驱动器或逻辑卷的容量。例如，您可能当初拥有一个容量
为 18 GB 的驱动器，但只选择了 9 GB 的空间来建立逻辑驱动器。要利用剩余的 9 GB，
需要扩展逻辑驱动器。 

注意 – 要扩展逻辑卷，您必须首先扩展组成逻辑卷的逻辑驱动器。

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口中选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要扩展的逻辑驱动器或逻辑卷。

5. 选择 Expand LD/LV 选项卡。

6. 在 Maximum Drive Expand Capacity 字段中以 MB 为单位指定要在逻辑驱动器或逻
辑卷上扩展的容量，然后单击 OK。 

Maximum Drive Expand Capacity 不能超过 Maximum Available Drive Free 
Capacity。
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7. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，并单击 Close。

关于逻辑驱动器 / 逻辑卷号码

要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 148 页的 “关于逻辑驱动器
/ 逻辑卷号码”。

如果创建逻辑驱动器
时使用了其全部容量，
将显示 0 ；表示没有
空间用于扩展，除非再

添加一个逻辑驱动器。
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▼ 将 SCSI 驱动器添加到现有逻辑驱动器 
1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口中选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要添加 SCSI 驱动器的逻辑驱动器。

5. 选择 Add SCSI Drives 选项卡。

6. 从 Available disks 列表，选择要添加到逻辑驱动器的驱动器。

7. 单击 Add Disk。 

该驱动器被移到 Add disk(s) to LD 列表。

如果您操作错误或改变了决定，从 Add disk(s) to LD 列表中选择磁盘并单击 
Remove。

8. 在添加完 SCSI 驱动器后，单击 OK。

9. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，并单击 Close。
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关于逻辑驱动器 / 逻辑卷号码
要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 148 页的 “关于逻辑驱动器
/ 逻辑卷号码”。

▼ 复制并替换成员驱动器 
使用该选项，用更高容量的驱动器复制并替换现有驱动器成员。例如，逻辑驱动器原来
由三个成员驱动器组成，每一个成员具有 18 GB 的容量，如下图所示该逻辑驱动器可
由具有 36 GB 容量的新驱动器取代。

图 11-1 复制并替换成员驱动器

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口中选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要进行复制和替换操作的逻辑驱动器。

5. 在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口中选择 Copy and Replace 
Drive 选项卡。

6. 从 Drive to Copy Data From 列表，选择新的硬盘驱动器。

18 GB18 GB18 GB
新驱动器

36 GB

36 (GB)36 (GB) 36 (GB)

RAID5 (4 GB)

使用中

未使用

新驱动器
36 GB

新驱动器
36 GB

RAID5 (4 GB)
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7. 从 Drive to Copy Data To 列表，选择要替换的硬盘驱动器，然后单击 OK。

要利用新驱动器所提供的更多容量，遵照执行第 153 页的 “扩展逻辑驱动器或逻辑卷
的容量”中的操作指示。

8. 在 Confirm Configuration Operation 窗口中单击 OK 以完成操作，并单击 Close。

9. 当完成操作后，关闭进度窗口。

关于逻辑驱动器 / 逻辑卷号码

要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 148 页的 “关于逻辑驱动器
/ 逻辑卷号码”。
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▼ 扫描新硬盘驱动器

可扫描到硬盘，并且不必关闭阵列即可使用。

1. 双击相应的阵列。

2. View Controller Configuration 窗口显示。

3. 选择 Physical Drives 选项卡，然后单击 Scan SCSI Drive。

4. 选择驱动器的正确的输入 Channel （信道）和 ID。

如果扫描成功，会正确地显示驱动器并可用。
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▼ 下载 RAID 控制器固件

可以使用以下过程为单个或冗余控制器配置升级控制器固件。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。
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4. 如果仅更新固件 （而不更新引导记录），选择 Download Firmware 选项。 

Select Firmware File 窗口显示。

5. 选择要下载的固件，并单击 Open。

Confirmation Dialog 提示显示。
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6. 单击 Yes。 

将固件下载到 RAID 控制器会显示一个进度条。

7. 当进度条达到 100% 时，单击 OK。 

8. 下载固件后，检查设置，以确保配置正确。
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▼ 升级固件和引导记录

1. 转到 Array Administration → Controller Maintenance。

2. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

3. 选择 Download Firmware with Boot Record。

Select Boot Record File 窗口显示。

4. 选择引导记录并单击 Open。 

5. 选择相应的固件文件。 

Select Firmware File 显示。

6. 单击 Open。 

Confirmation Dialog 窗口显示。

7. 重复前面小节的步骤 6 到 8。
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下载用于设备的固件
该选项允许更新硬盘驱动器和 SAF-TE 设备上的固件。

▼ 升级硬盘驱动器上的固件

1. 选择相应的阵列。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for Disks 选项卡。

4. 选择 To All disks under Controller，并从菜单选择一个阵列；或者选择 To All disks 
under LD，并从菜单选择逻辑驱动器。

■ 如果有不想下载新固件的驱动器，就从 Selected Disks 将其选中，然后单击 
Remove。

■ 如果有要添加的逻辑驱动器，从 Available Disks 选择它们并单击 Add。

■ 如果有多个驱动器有不同的产品 ID，则一定要从 Product ID 列表框选择想要为其下
载固件的驱动器的产品 ID。
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5. 单击 Browse 并找到下载固件文件。 

选择 Open。

6. 选择要下载的固件文件，单击 Open，然后单击 OK。

开始下载固件。

7. 当安装进程显示为 100% 时，单击 OK。

8. 要验证固件是否已成功下载，选择 View → View Physical Drive，确保在 Product 
Revision 字段中的固件版本已更改。

▼ 升级 SAF-TE 设备的固件 

注意 – SAF-TE 设备由 SCSI 阵列使用， SES 设备由光纤信道阵列使用。

1. 选择阵列。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for SAFTE/SES Devices 选项卡。

■ 要添加设备，可以从 Available SAF-TE Devices 中选择设备，并单击 Add。
■ 要删除设备，可以从 Selected SAF-TE Devices 中选择设备，并单击 Remove。
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4. 单击 Browse 并找到下载固件文件。 

5. 选择要下载的固件文件，单击 Open，然后单击 OK。

开始下载固件。

6. 当进程显示为 100% 时，单击 OK。

7. 要验证固件是否已成功下载，选择 View → View Enclosure，确保在 Firmware Rev 
字段中的固件版本已更改。

▼ 更改控制器参数

1. 从主菜单中选择相应的阵列控制器。

2. 选择 Configuration → Custom Configure。 

如有必要，使用 ssconfig 密码登录到程序的配置级别。

3. 从 Custom Configuration Options 窗口，选择 Change Controller Parameters。 

显示 Change Controller Parameters 窗口，其中 Channel 选项卡已被选中。
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注意 – 对于 Sun StorEdge 3510 FC 阵列， CurClk 为 2.0GHz。

■ Controller Name － 如果需要设置控制器名称，选择 Controller Name 并键入想要
的名称。单击 OK 保存更改。

■ Controller Unique ID － 该 ID 是自动设置的。

Channel 选项卡

1. 从 Channel Settings 选项卡，选择要编辑的信道。

2. 单击 Change Settings。

Change Channel Settings 窗口显示。对于要识别阵列的服务器，主信道必须拥有一个
已指定给逻辑驱动器的 ID 和映射至该主信道和 ID 的逻辑驱动器。该窗口使您可以配
置主机 / 驱动器信道。

3. 从 Channel Mode 列表框，选择 Host 或 Drive。 

Drive 信道是驱动器要连接的对象（内部或外部）。Host 信道是连接到服务器的对象。

注意 – 根据控制器配置的不同，可能需要按照以下步骤说明选择主信道 ID 和辅助信道 
ID。
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4. 从 Available SCSI IDs 列表框，首先选择主信道 ID，其标识为 PID。然后单击 Add 
PID。

5. 如果您安装有两个控制器，则从 Available SCSI IDs 列表框选择辅助信道 ID，然后单
击 Add SID。

在 Fibre 配置中更改主机 ID

1. 如果希望 ID 高于 15，单击 Select SCSI ID Range 并选择需要的范围。 

注意 – 每个信道的 ID 必须在同一范围内。

2. 单击 Remove 以删除 PID 或 SID。

3. 做出选择后，单击 OK 以重新显示上一个窗口。

RS 232 选项卡

1. 完成所有信道的设置后，从 Change Controller Parameters 窗口，选择 RS 232 选
项卡。
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2. 选择所需的端口，单击 Change Settings。 

Change RS232 Port Settings 窗口显示。

3. 选择包括 9600 默认设置在内的任一所需波特率，然后单击 OK，以回到上一个窗口。 

Cache 选项卡

1. 从 Change Controller Parameters 窗口，选择 Cache 选项卡。

2. 从列表框选择 Optimization 或接受当前的设置。

该选项指示跨阵列中每个驱动器写入的数据量。 Sequential I/O 指示大数据块；
random I/O 指示小数据块。

如果某个现有的逻辑驱动器在创建时设置了 Optimization set for Random I/O，则当
更改为顺序 I/O 模式时，该逻辑驱动器无法读或写数据。反之亦同，因为每类型的带
区大小都不同。

3. 要利用 Write Back，单击列表框并选择 Enabled 或 Disabled。
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Disk Array 选项卡

1. 从 Change Controller Parameters  窗口，选择 Disk Array 选项卡。 

2. 从三个 Write Verify 列表框选择 Disabled 或 Enabled。

通常，当硬盘驱动器写数据时可能会发生错误。要避免写错误，控制器能够强制硬盘驱
动器验证写入的数据。

■ Write Verify on Initialization － 初始化逻辑驱动器时，执行写后验证。

■ Write Verify on Rebuild － 在重建过程中，执行写后验证。

■ Write Verify on Normal － 在常规 I/O 请求期间，执行写后验证。
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3. 从 Rebuild Priority 列表框中的四个可用选项中进行选择：Low、 Normal、
Improved 或 High。

该 RAID 控制器提供了后台重建能力。这意味着控制器可以在重建逻辑驱动器时实现其
它 I/O 请求。重建驱动器集要求的时间很大程序上取决于要重建的逻辑驱动器的总容
量。另外，重建过程对于主机计算机和操作环境来是完全透明的。

■ Low － 默认值，用户使用控制器的最小资源完成重建。

■ Normal － 加快重建进程。

■ Improved － 为重建进程分配更多的资源。

■ High － 使用控制器的最大资源在最短时间内完成重建过程。
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Drive I/F 选项卡

1. 从 Change Controller Parameters 窗口，选择 Drive I/F 选项卡。

2. 从 SCSI Motor Spin Up 字段，选择 Disabled 或 Enabled。

SCSI Motor Spin Up 说明如何启动磁盘阵列中的 SCSI 驱动器。当电源无法向同时通电
启动的硬盘驱动器和控制器提供足够的电流时，将各个硬盘驱动器顺序启动是耗费较低
启动电流的最佳方法之一。在默认情况下，通电时所有硬盘驱动器都起速。 

3. 从 Power Up SCSI Reset 字段，选择 Enabled 或 Disabled。

默认情况下，控制器通电时，会将 SCSI 总线重置命令发送到 SCSI 总线。如果禁用，
在下一次通电时不发送 SCSI 总线重置命令。

在将双主机计算机连接到同一 SCSI 总线时，SCSI 总线重置将中断所有正在执行的读 /
写请求。这可能会造成某些操作环境或主机计算机运行异常。通电时禁用 Power Up 
SCSI Reset 可以避免该情况发生。

4. 设置 Disk Access Latency。

本功能设定了在通电后控制器试图访问硬盘驱动器前的延迟时间。默认值为 15 秒钟。

5. 设置 Tag Count Per drive。

这是同时可发送到每个驱动器的标记的最大数目。驱动器具有内置高速缓存，用于对发送
给驱动器的所有 I/O 请求 （标记）进行排序，从而让驱动器能够更快地完成这些请求。

缓存大小和标记的最大数量根据驱动器品牌和型号不同而有所差别。使用默认设置 32。
将最大标记数更改为 Disable 会引起驱动器内部缓存被忽略 （不使用）。

控制器支持标记命令队列，可调整标记计数为 1 到 128。

6. 从 SAF-TE Polling Period (Sec) 字段，选择列表框中显示的可变时间选项，或者选择 
0.0 来禁用该功能，以便从不对所有已安装的事件记录模块 (ERM) 进行轮询。

7. 从 SCSI I/O Timeout (Sec) 字段，选择 0.5 到 10 秒之间的一个值。

SCSI I/O Timeout 是控制器等待驱动器响应的时间间隔。如果控制器试图从驱动器读
取数据或将数据写入驱动器，但驱动器在 SCSI I/O 超时值范围内没有响应，则被认为
是故障驱动器。

SCSI I/O Timeout 的默认设置为 7 秒。不要更改这个设置如果将超时设置为较低的
值，会导致驱动器仍在重新尝试或无法仲裁 SCSI 总线时，控制器将驱动器判断为发生
故障。将超时设置为较高的值，会导致控制器持续等待某一驱动器，而这有时会引起主
机超时。

如果在从驱动器盘片上读取数据时，驱动器检测到介质错误，会再次尝次前一读取操作
或再校准磁头。当驱动器遇到介质上的坏块时，会将坏块重新分配给同一磁盘驱动器上
的另一个空闲块。但是，这些操作都会花费时间。根据驱动器品牌和型号的不同执行这
些操作的时间有所差别。

在 SCSI 总线仲裁期间，具有更高优先级的设备可以先使用总线。当更高优先级的设备
持续使用总线时，较低优先级的设备有时会接收到 SCSI I/O Timeout。
第 11 章 更新配置 171



8. 从 Drive Check Period (Sec) 字段，选择 0.5 到 30 秒之间的一个值。

Periodic Drive Check Time 是控制器用来检查 SCSI 总线上设备的时间间隔，默认值为 
Disabled，该项意味着如果总线上没有活动，控制器无法知道驱动器是否故障或者已删
除。设置一个间隔，使得 Configuration Service 在没有任何阵列活动时探测驱动器故
障；但是性能会因此而降低。

Host I/F 选项卡

1. 从 Change Controller Parameters 窗口，选择 Host I/F 选项卡。

2. 设置 Max Queued IO Count。 

此功能允许用户从主机计算机以字节为单位配置控制器可接受的 I/O 队列的最大大小。
默认值为 256。预定义范围为 1 至 1024 个字节，也可以选择 Auto Computer（自动配
置）模式。

3. 设置 LUNs Per Host。

此功能用于改变每个主机 SCSI ID 的 LUN 数量。默认设置为 32 个 LUN ；预定义的可
用 LUN 范围为 1 至 32 个。
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Redundancy 选项卡

1. 从 Change Controller Parameters 窗口，选择 Redundancy 选项卡。 

显示三个只读字段：Controller Configuration、Controller Status 和 Secondary Serial 
No。

2. 从 Set Controller Config 字段选择一个选项。 

■ Redundant Deassert Reset － 如果已经有一个控制器发生故障，想让其重新联机。

■ Redundant Force Sec Fail － 如果要强制辅助控制器失效。

■ Redundant Force Pri Fail － 如果要强制主控制器失效。

注意 – 须将两个控制器都设置成 Redundant Primary （冗余主要）配置。然后控制器
决定主控制器和辅助控制器。这避免了控制器间的可能发生的冲突。

3. 要在 Change Controller Parameters 窗口保存更改，应选择 Issue Controller Reset。

4. 单击 Close 返回 Configuration Service 主菜单树。
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Network 选项卡

1. 从 Change Controller Parameters 窗口，选择 Network 选项卡。

2. 要手动配置 IP 地址、子网掩码或网关地址，单击 Change Settings。

3. 如果已在 DHCP/RARP 环境中安装了阵列，可以选择 Enable Dynamic IP 
Assignment，从而允许阵列自动从网络获得 IP 地址。 
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▼ 将控制器蜂鸣器静音

当引起控制器发出蜂鸣声的事件发生时 （例如逻辑驱动器故障、重建期间或者添加 
SCSI 驱动器），用户可以将蜂鸣器静音。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Mute Controller Beeper。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Mute Beeper。

▼ 保存已更改值

1. 在对上述参数进行过令人满意的修改之后，选择 Configuration → Custom 
Configuration。

2. 单击 Change Controller Parameters。

3. 选择 Issue Controller Reset。

4. 单击 OK，然后单击 Close 返回 Configuration Service 菜单树。
176 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



▼ 指定或更改备用驱动器

在容错 （非 RAID 0）逻辑驱动器中的物理驱动器发生故障后，备用驱动器可用于支持
自动数据重建。如果备用驱动器要替代另一个驱动器，其大小必须与故障驱动器的大小
至少相等，而且与故障磁盘相关的所有逻辑驱动器都必须是冗余的（RAID 1、3、5 或 
1+0）。

用户可使用该功能指定一个全局或本地备用驱动器，也可将一个现用驱动器状态更改为
备用或将一个备用驱动器的状态更改为可用。如现有驱动器成员故障，指定为全局备用
的驱动器将进行重建。可将一个或多个备用驱动器与阵列控制器相关。本地备用驱动器
必须被指定到一个特定逻辑驱动器，且仅用于该逻辑驱动器成员的重建。

1. 在 Configuration Service 主窗口中，选择需要的阵列控制器。

2. 选择 Configuration → Custom Configure 或单击 Custom Configuration 工具。

如有必要，使用 ssconfig 密码登录到程序的配置级别。 Custom Configuration 
Options 窗口显示。

3. 从 Custom Configuration Options 窗口选择 Make or Change Standby Drives。

Make or Change Standby Drives  窗口显示。

4. 检查窗口顶部的服务器和控制器 ID。

如果要选择其他服务器或控制器，单击 Cancel 返回至 Configuration Service 树视图，
选择正确的服务器，或树视图中的控制器，重复步骤 2 和 3。

5. 选择要分配或更改的驱动器。

6. 通过选择 Ready、 Global StandBy 或 StandBy for LD# （本地）更改或分配驱动器
状态。
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7. 单击 Modify。

8. 单击 Apply，然后单击 Close。

9. 无论何时对配置做出更改，将新配置保存到文件。（要获得有关详细信息，请参阅第 76 
页的 “配置文件”。） 

可用服务器
用户有时可能需要从 Server List Setup 窗口的 Available 或 Managed Servers 列表编
辑或删除条目。

▼ 编辑服务器条目

1. 选择 File → Server List Setup。 Server Setup 窗口显示。 

如有必要，将服务器名称从 Managed Servers 列表中移到 Server List Setup 窗口的 
Available Servers 列表中。注意，仅可以编辑 Available Servers 列表中的服务器条目。

 

2. 在 Available Servers 列表中选择服务器名称，并单击 Edit。 

Edit Server 窗口显示。
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3. 进行必要的更改。单击 OK 对更改进行登记。

要获得窗口中的字段说明，请参阅第 37 页的 “添加服务器”。 Add Server 和 Edit 
Server 窗口包含相同的字段。

IP Address 快捷方式：如果网络地址已更改，单击 Get IP Addr by Name。如果用户
键入了网络使用的名称服务所记录的服务器名称，Configuration Service 将搜索并显示
正确的 IP 地址。 

如果服务器使用的名称与服务器的网络名称不同，或者命名服务尚未更新，删除该服务
器后重新添加。

4. 将服务器名称移回 Managed Servers 列表。

5. 单击 OK 以退出 Edit Server 窗口。
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附  录 A

RAID 基本知识

本附录提供有关 RAID 的背景信息，其中概述了 RAID 术语和 RAID 级别。包括以下
主题：

■ 第 181 页的 “RAID 术语概述”
■ 第 187 页的 “RAID 级别”
■ 第 194 页的 “本地和全局备用驱动器”

RAID 术语概述
独立磁盘的冗余阵列 (RAID) 是一种用于改进存储系统处理能力的存储技术。这一技术
旨在为磁盘阵列系统提供可靠性，并利用由多磁盘组成的阵列所提供的性能优势，而这
些优势是单磁盘存储器所不具备的。

RAID 的两个主要基本概念是： 

■ 将数据分布在多个硬盘驱动器中从而提高性能

■ 正确使用多个驱动器可在任一驱动器出现故障时确保不会造成数据丢失或系统停机。

在出现磁盘故障的情况下，磁盘访问可正常进行，而且主机系统不会察觉到这一故障。
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逻辑驱动器

逻辑驱动器是一列独立的物理驱动器。通过创建逻辑驱动器，可用性、容量及性能均得
到提高。逻辑驱动器在主机上的显示与本地硬盘驱动器相同。 

图 11-2 逻辑驱动器包括多个物理驱动器

逻辑卷

逻辑卷由两个或者两个以上的逻辑驱动器组成。逻辑卷最多可划分为 32 个分区（对于 
SCSI）或 128 个分区 （对于光纤通道）。操作期间，主机将未分区的逻辑卷或逻辑卷
上的分区作为单个物理驱动器对待。

本地备用驱动器

本地备用驱动器是分配用于指定的逻辑驱动器的备用驱动器。当指定逻辑驱动器的某一
成员驱动器发生故障时，本地备用驱动器将成为成员驱动器并自动开始重建。

全局备用驱动器

全局备用驱动器不单只为一个指定的逻辑驱动器服务。当任一逻辑驱动器中的成员驱动
器发生故障时，全局备用驱动器将加入该逻辑驱动器，并自动开始重建。
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SCSI 信道

当 Wide 功能被启用 （16 位 SCSI）时， SCSI 信道 （SCSI 总线）最多可连接 15 个设
备 （不包括控制器本身）。在一个环路中，光纤信道最多可连接 125 个设备。每个设备
有一个唯一 SCSI ID。

图 A-1 阐释了这一概念。如果将文档存放到文件柜中，必须先将文档置于其中一个抽屉
里。从 SCSI 的观点来看，SCSI ID 类似于文件柜，抽屉就是 LUN（逻辑单位）。每个 
SCSI ID 最多允许 32 个 LUN。数据可以存储在 SCSI ID 的一个 LUN 中。大多数 SCSI 
主机适配器将 LUN 看作另一个 SCSI 设备。

图 A-1 SCSI ID/LUN

逻辑驱动器由一组 SCSI 或者光纤信道驱动器组成。在一个逻辑驱动器中的物理驱动器
不必来自同一个 SCSI 信道。同样，每一个逻辑驱动器可配置为不同的 RAID 级别。
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可将驱动器作为本地备用驱动器分配给一个指定的逻辑驱动器，或者作为全局备用驱动
器。备用驱动器不能用于没有数据冗余的逻辑驱动器 (RAID 0)。 

图 A-2 逻辑驱动器配置中的驱动器分配

驱动器信道 0

逻辑驱动器 1

全局备用驱动器 LD1 的本地备用驱动器

逻辑驱动器 0

驱动器信道 1

4
GB

4
GB

2
GB

2
GB

4
GB

4
GB

2
GB

2
GB

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
8 GB

RAID 3
6 GB
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可以将逻辑驱动器或者逻辑卷分为几个分区，或者将整个逻辑驱动器用作一个单独的
分区。

图 A-3 逻辑驱动器配置中的分区

逻辑驱动器 0

RAID 5 (8 GB)

逻辑驱动器 1

RAID 3 (6 GB)

分区 0 2 GB

分区 1 1 GB

分区 2 5 GB

分区 0 2.5 GB

分区 1 1.5 GB

分区 2 2 GB
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每一个分区映射到主机 SCSI ID 下或者主机信道 ID 上的 LUN。每个 SCSI ID/LUN 对
于主机来说，相当于一个独立的硬盘驱动器。

图 A-4 将分区映射到主机 ID/LUN

图 A-5 将分区映射到 ID 下的 LUN

ID 0 ID 1

LUN 0 LUN 0

LUN 1 LUN 1

LUN 2 LUN 2

逻辑驱动器 1
分区 0

逻辑驱动器 0
分区 1

逻辑驱动器 1
分区 2

逻辑驱动器 0
分区 2

逻辑驱动器 1
分区 1

逻辑驱动器 0
分区 0

2.5 GB

1 GB

5 GB

1.5 GB

2 GB

2.5 GB

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

逻辑驱动器 0 逻辑驱动器 1

主机 SCSI 信道

逻辑驱动器 1

逻辑驱动器 1
分区 0

逻辑驱动器 0
分区 2

逻辑驱动器 0
分区 0

分区 1分区 1 分区 2

4.5 GB 5 GB 2 GB

1 GB 1.5 GB 2 GB
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RAID 级别
有几种不同的方法可用于实现 RAID 阵列，可以使用镜像、带区化、复置和奇偶校验技
术的组合。这些不同的技术被称为 RAID 级别。每个级别提供不同的性能、可靠性和成
本的组合。每个级别使用不同的算法实现容错功能。

有以下 8 种 RAID 级别供选择：RAID 0、1、0+1、3、5、1+0 (10)、3+0 (30) 和 5+0 
(50)。 RAID 级别 1、 3 和 5 是最常用的级别。

下表简要概述了 RAID 级别。 

容量指可用于数据存储的物理驱动器的总数 (N)。例如，如果容量 = N-1，而且逻辑驱
动器中共有 6 个 36 MB 的磁盘驱动器，则可用于存储的磁盘空间等于 5 个磁盘驱动器
的容量 － (5 x 36 MB (180 Mbytes))。-1 指的是在 6 个驱动器上进行带区化的数量，带
区化提供了数据冗余，等于其中一个磁盘驱动器的大小。 

对于 RAID 3+0 (30) 和 5+0 (50)，容量是在物理驱动器总数 (N) 的基础上，针对卷中每
个逻辑驱动器中减去一个物理驱动器 (#)。例如，如果逻辑驱动器中共有 20 个 36 MB 
的磁盘驱动器，并且逻辑驱动器的总数为 2，则可用于存储的磁盘空间为 18 个磁盘驱
动器的容量 － 18 x 36 MB (648 MB)。

表 A-1 RAID 级别概述

RAID 级别 说明 支持的驱动器的数量 容量 冗余

0 带区化 2-44 N 否

1 镜像 2 N/2 是

0+1 镜像和带区化 4-44 （只能为偶数） N/2 是

3 带有专用奇偶校验

的带区化

3-31 N-1 是

5 带有分布式奇偶校

验的带区化

3-31 N-1 是

1+0 (10) RAID 1 逻辑驱动器

的带区化

2 至 8 个逻辑驱动器 N/2 是

3+0 (30) RAID 3 逻辑驱动器

的带区化

2 至 8 个逻辑驱动器 N-# 个
逻辑驱
动器

是

5+0 (50) RAID 5 逻辑驱动器
的带区化

2 至 8 个逻辑驱动器 N-# 个
逻辑驱
动器

是
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RAID 0
RAID 0 实现数据块带区化，其中数据被分成多个逻辑数据块，并在多个驱动器上进行
带区化。与其他 RAID 级别不同，此级别不提供数据冗余。如果发生磁盘故障，数据将
丢失。

在数据块带区化中，总磁盘容量等于阵列中所有驱动器的容量的总和。这个驱动器组合
将被系统视为单个逻辑驱动器。

RAID 0 提供了最高的性能。由于能够同时向 / 从阵列中的每个磁盘传输数据，RAID 0 
的速度很快。此外，对不同驱动器的读 / 写操作能够同时进行。

图 A-6 RAID 0 配置

RAID 1
RAID 1 实现了磁盘镜像，其中同一数据的副本被记录在两个驱动器上。通过在不同磁
盘上保存数据的两个副本，能够在磁盘故障的情况下保护数据。如果在任意时刻，
RAID 1 阵列中的一个磁盘发生故障，余下的无故障磁盘 （副本）能提供所需的所有数
据，因而不会造成停机。

在磁盘镜像中，总的未用容量等于 RAID 1 阵列中的一个驱动器的容量。因此，对 2 个
容量为 1 GB 的驱动器进行组合将创建一个总可用容量为 1 GB 的单个逻辑驱动器。这
个驱动器组合将被系统视为单个逻辑驱动器。

注意 – RAID 1 不允许扩展。RAID 级别 3 和 5 允许扩展，方法是向现有阵列中添加驱
动器。

逻辑驱动器

物理磁盘

带区化

数据块 1

数据块 2

数据块 3

数据块 5

数据块 7

数据块 1数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 4

数据块 6

数据块 8

数据块 2
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图 A-7 RAID 1 配置

RAID 1 除了提供数据保护以外，这种 RAID 级别还提高了性能。当发生多个并行 I/O 
操作时，这些 I/O 可以分布到磁盘副本中进行，从而减少了总的有效数据访问时间。

逻辑驱动器

物理磁盘

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 2

数据块 3

数据块 4

数据块 1

数据块 2

数据块 3

数据块 4

数据块 1
镜像
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RAID 1(0+1)

RAID 1(0+1) 将 RAID 0 和 RAID 1 组合使用 － 镜像和磁盘带区化。使用 RAID 1(0+1) 
能够节省时间，因为它允许在一个步骤中将大量磁盘配置为镜像。这并不是可供选择的
标准 RAID 级别选项；它不会出现在控制器所支持的 RAID 级别选项的列表中。根据
选择的磁盘的数量，控制器自动确定使用 RAID 1 还是 RAID 1(0+1)。如果选择两个磁
盘，将创建一个 RAID 1 逻辑驱动器。选择偶数个（如 4 个或更多）磁盘将创建 RAID 
1(0+1)。

图 A-8 RAID 1(0+1) 配置

物理磁盘

带区化

镜像

带区化

逻辑驱动器

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 3

数据块 5

数据块 7

数据块 1

数据块 4

数据块 6

数据块 8

数据块 2

数据块 3

数据块 5

数据块 7

数据块 1

数据块 4

数据块 6

数据块 8

数据块 2
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RAID 3
RAID 3 实现了带有专用奇偶校验的数据块带区化。此 RAID 级别将数据分成多个逻辑
数据块 （磁盘数据块的大小），然后在多个驱动器上对这些数据块带区化。一个驱动器
专用于奇偶校验。如果磁盘发生故障，可以使用奇偶校验信息和其余磁盘上的信息对原
始数据进行重构。

在 RAID 3 中，磁盘总容量等于组合中所有驱动器容量的总和减去奇偶校验驱动器的容
量。因此，对 4 个容量为 1 GB 的驱动器进行组合将创建总可用容量为 3 GB 的单个逻
辑驱动器。这个组合将被系统视为单个逻辑驱动器。

当以小数据块读取或者按顺序读取数据时， RAID 3 可以提高数据的传输速率。但是，
在没有跨越每个驱动器的写操作中，性能会降低，这是因为在每次写入新数据时，都要
重新计算和写入存储在奇偶校验驱动器中的信息，因此限制了并行的 I/O 操作。

图 A-9 RAID 3 配置

逻辑驱动器

数据块 1

数据块 2

数据块 3

数据块 1
带区化

奇偶校验 (1.2)

奇偶校验 (3.4)

物理磁盘

专用奇偶校验

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 7

数据块 5

数据块 4

数据块 2

数据块 8

数据块 6 奇偶校验 (5.6)

奇偶校验 (7.8)
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RAID 5

RAID 5 实现了带有分布式奇偶校验的多数据块带区化。此 RAID 级别使用分布在
阵列中所有磁盘上的奇偶校验信息提供冗余。数据及其奇偶校验信息从不存储于同
一磁盘上。如果磁盘发生故障，可以使用奇偶校验信息和其余磁盘上的信息对原始
数据进行重构。

图 A-10 RAID 5 配置

RAID 5 可以提高以大数据块或随机方式访问数据时的数据传输率，并减少存在大量并
行 I/O 时的数据访问时间。

逻辑驱动器 物理磁盘

带区化 + 非专用奇偶校验

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 4

数据块 1

数据块 7

奇偶校验 (5.6)

奇偶校验 (3.4)

数据块 2

数据块 8

数据块 5

奇偶校验 (3.4)

数据块 3

数据块 6

奇偶校验 (7.8)
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高级 RAID 级别

下列高级 RAID 级别要求使用阵列的内置卷管理器。这些组合 RAID 级别可以提供 
RAID 1、 3 或 5 的数据保护优势，同时又能提供 RAID 1 的性能。要使用高级 RAID，
首先创建两个或更多 RAID 1、 3 或 5 阵列，然后将它们组合起来。

RAID 1+0 (10)

使用阵列的内置卷管理器连接在一起的 RAID 1 逻辑驱动器。 

RAID 3+0 (30)

使用阵列的内置卷管理器连接在一起的 RAID 3 逻辑驱动器。 

RAID 5+0 (50)

使用阵列的卷管理器连接在一起的 RAID 5 逻辑驱动器。
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本地和全局备用驱动器
外部 RAID 控制器提供本地备用驱动器和全局备用驱动器功能。本地备用驱动器仅用于
一个指定的驱动器，而全局备用驱动器可以用于阵列上的任何逻辑驱动器。 

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时两种类型的备用驱动器同时存在，或者如果需要一个容量更大的驱动器来替换故
障驱动器，则将使用本地备用驱动器。

如果 RAID 5 逻辑驱动器中有故障驱动器，将用新的驱动器更换故障驱动器，以使逻辑
驱动器继续工作。要确定故障驱动器，请参阅适用于您的阵列的 Sun StorEdge 3000 
Family RAID Firmware User's Guide。

警告 – 如果在试图拆卸故障驱动器时错误的卸下了另一个驱动器，则无法继续访问逻
辑驱动器，因为已错误地使另一个驱动器发生了故障。

本地备用驱动器是分配用于指定的逻辑驱动器的备用驱动器。当指定的逻辑驱动器的某
一成员驱动器发生故障时，本地备用驱动器成为成员驱动器，自动开始重建。

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

图 A-11 本地 （专用）备用驱动器

本地备用驱动器
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全局备用驱动器不是仅用于一个指定的逻辑驱动器；它可以用于所有的逻辑驱动器
（请参阅图 A-12）。当任一逻辑驱动器中的成员驱动器发生故障时，全局备用驱动器将
加入该逻辑驱动器工作，自动开始重建。

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

图 A-12 全局备用驱动器

逻辑驱动器 0

全局备用驱动器

逻辑驱动器 1 逻辑驱动器 2

全局备用驱动器
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同时拥有本地和全局备用驱动器

在图 A-13 中，逻辑驱动器 0 中的成员驱动器是容量为 9 GB 的驱动器，而逻辑驱动器 1 
和 2 中的成员都是容量为 4 GB 的驱动器。 

图 A-13 混合本地和全局备用驱动器

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

在图 A-13 中，容量为 4 GB 的全局备用驱动器由于容量不足而不可能加入到逻辑驱动
器 0 中。如果逻辑驱动器 0 中的驱动器发生故障，则容量为 9 GB 的本地备用驱动器可
以提供帮助。如果故障驱动器位于逻辑驱动器 1 或 2 中，则使用容量为 4 GB 的全局备
用驱动器可以立即提供帮助。

本地备用驱动器 全局备用驱动器

(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

逻辑驱动器 0 逻辑驱动器 1 逻辑驱动器 2

(9GB)
(4GB)

(4GB)(4GB)
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附  录 B

监控 JBOD （仅用于 SCSI）

本附录仅说明如何监控以及将固件下载到仅用于 Sun StorEdge 3310 SCSI 阵列的独立 
JBOD。注意， JBOD 并不支持所有的阵列功能。本附录包含以下步骤：

■ 第 197 页的 “启用 JBOD 支持”
■ 第 199 页的 “查看组件和警报特性”
■ 第 200 页的 “升级硬盘驱动器上的固件”
■ 第 201 页的 “升级 SAF-TE 设备的固件”
■ 第 202 页的 “更换故障驱动器”

▼ 启用 JBOD 支持

要对 JBOD 的外围设备状况和事件进行监控，必须首先启用 JBOD 支持。 

1. 选择 View → Agent Options Management。 

Agent Options Management 窗口显示。

2. 选择 Enable JBOD Support 复选框。

3. 要在 Configuration Service 主窗口中立刻显示 JBOD，必须探测新的库存。选择 
View → View Server 并单击 Probe。

4. 单击 OK。 

JBOD 显示在 Configuration Service 主窗口中。

在单总线配置中， JBOD 的两个端口均连接到服务器上的一个 HBA，如下例所示。
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在双总线配置中，每个端口连接到各自的 HBA，如下例所示。

注意 – 在双总线配置中，如果每个端口连接到不同的服务器，则 Configuration 
Service 只能从连接到端口 B 的服务器对 JBOD 进行监控。
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▼ 查看组件和警报特性

View Enclosure 窗口显示 JBOD 的组件和警报特性。

1. 选择 EMU 图标 。

2. 选择 View → View Enclosure。

要显示 FRU ID 信息，请单击 View FRU。
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下载用于设备的固件
该选项用于升级 JBOD 上的硬盘驱动器和 SAF-TE 设备上的固件。

▼ 升级硬盘驱动器上的固件

1. 选择任一 JBOD 组件。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for Disks 选项卡。

4. 从 Available Disks 选择要从其下载新固件的驱动器，然后单击 Add。

如果有要删除的逻辑驱动器，从 Selected Disks 将其选中并单击 Remove。

5. 单击 Browse 并找到下载固件文件。将其选中，单击 Open，然后单击 OK。

开始下载固件。

6. 当安装进程显示为 100% 时，单击 OK。

7. 要更新 Configuration Service，选择 View → View Server。
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8. 单击 Probe，然后单击 OK。

9. 要验证固件是否已成功下载，选择 View → View Physical Drive，并确保在 Product 
Revision 字段中的固件版本已更改。

▼ 升级 SAF-TE 设备的固件

1. 选择任一 JBOD 组件。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for SAFTE Devices 选项卡。

4. 要添加设备，可以从 Available SAF-TE Devices 中选择设备，并单单击 Add。

要删除设备，可以从 Selected SAF-TE Devices 中选择设备，并单击 Remove。

5. 单击 Browse 并找到下载固件文件。将其选中，单击 Open，然后单击 OK。 

开始下载固件。

大约在进行到 70% 的时候，阵列开始发出蜂鸣声，并且 LED 开始闪烁。

6. 当安装进程显示为 100% 时，单击 OK。

7. 要更新 Configuration Service，选择 View → View Server，然后单击 Probe。

8. 单击 OK。
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9. 要验证固件是否已成功下载，选择 View → View Enclosure，确保在 Firmware Rev 
字段中的固件版本已更改。

▼ 更换故障驱动器

一个红色的设备状态符号指示驱动器故障 。在更换故障驱动器后，执行下列步骤： 

Solaris 操作环境

1. 如果驱动器自动返回联机状态 （即红色设备状态符号消失），则运行命令 

2. 运行命令

3. 如果驱动器没有自动返回联机状态 （即红色设备状态符号没有消失），则通过执行下面
的命令，进行重新配置重新引导：

Microsoft Windows NT/2000 操作系统

1. 根据 Sun StorEdge 3000 系列安装、操作和维护手册中的操作说明为阵列安装新的驱
动器。

2. 选择 View → View Server 并单击 Rescan。

3. 要验证 Configuration Service 识别新的驱动器，在 Configuration Service 主窗口将
其选中。

4. 选择 View → View Physical Drive，然后验证信息。

# devfsadm

# format

# reboot -- -r
202 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



附  录 C

使用群集配置

如果使用 Microsoft Windows NT， Configuration Service 能够监控共享的 SCSI 存
储。本节包含以下主题：

■ 第 203 页的 “规划群集配置”
■ 第 204 页的 “群集配置要求”
■ 第 204 页的 “设置群集配置”

首先，群集配置必须与适当的硬件一起配置，另外，要求具备 Service Pack 3 或 4 的 
Microsoft Windows NT Server、 Enterprise Edition 和 Microsoft Cluster Server 
(MSCS) 软件。

如果准备设置群集配置，请务必阅读本章。

规划群集配置
在设置群集配置前，必须确定所需的配置类型，因为它决定了存储设备在 
Configuration Service 中的初始配置方式。

有两种主要群集配置类型： 

■ 热备用服务器群集，该处的全部 LUN 都属于群集上两台服务器的其中一台。如果拥
有 LUN 的服务器发生故障，则 LUN 移交至第二台服务器，该服务器在此之前闲
置。该配置要求最少两个 LUN。

■ 负载平衡群集，该处某些 LUN 在一台服务器上维护，某些 LUN 在另一台服务器上
维护。两台服务器同时处理数据，但是它们在不同 LUN 上处理 I/O。 

必须最少定义三个 LUN。这允许建立一个小的 LUN 用于仲裁磁盘使用，建立一个大
的 LUN 以在群集上的每一台服务器上使用。万一服务器发生故障，仲裁磁盘维护恢复
群集必需的配置数据。
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群集配置要求
在安装 Microsoft Cluster Server 软件时，识别作为仲载磁盘使用的磁盘，该磁盘维护
群集信息。

在群集配置中，Configuration Service 同一时间仅在一台服务器上运行，即有仲裁磁盘
的服务器。如果运行有 Configuration Service 的服务器发生故障，群集管理器会自动
将第一台服务器的磁盘负载转移到第二台服务器，并在第二台服务器上启动 
Configuration Service 服务。

在双服务器的群集配置中，群集本身具有自己的 IP 地址，并会在 Configuration 
Service 的 Managed Server 列表显示为受管服务器。将群集添加到 Managed Server 
列表，最终完成群集设置，从而该群集能够与 Configuration Service 一同工作。

▼ 设置群集配置

以下是在一个配置有两台主服务器的群集上设置阵列所需的步骤概述。

1. 设置服务器。

a. 设置两台服务器，每一台具有 PCI 总线和一个引导磁盘，而不是共享 SCSI 存储的
一部分。

b. 在每台服务器上安装主机适配器卡 （如 Ultra-Wide、差分主机适配卡）并为共享 
SCSI 总线上的每个主机适配器设置唯一的 SI ID。

c. 在每台服务器上安装两个网络适配卡。

d. 在每台服务器的引导磁盘上安装 Microsoft Windows NT Server， Enterprise 
Edition 软件和 Windows NT Service Pack 3 或者更高版本。

2. 安装双活动 / 活动存储子系统，且将其连接到两个主机适配器。 

参考提供的文档，可以获得安装步骤。

3. 在每台服务器上安装 Configuration Service Agent 

a. 在另一台服务器上安装 Configuration Service 前，先停止这台服务器上的各个 
Configuration Service 服务。 

b. 确保 Configuration Service 服务已在服务器上运行，且该服务器可访问已映射到指
定的主控制器的逻辑驱动器上的主机 LUN。

c. 查阅有关的安装章节，获得安装代理的具体步骤。 

安装代理后，不需要重新引导。但是，安装了代理之后，请务必停止服务器上的 
Configuration Service 服务。
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注意 – 以下几个步骤中，将如示例所示只用一台服务器。

4. 安装 Configuration Service Console 软件。

可以在其中一台服务器或服务器所在网络的任一计算机上安装 Configuration Service 
Console。 Configuration Service 使您可以远程配置和监控阵列。查阅有关安装章节，
可获得具体安装步骤。

5. 将已启动 Configuration Service 服务的服务器添加到 Configuration Service 
Console 的 Managed Servers 列表 （请参阅第 37 页的 “添加服务器”）。

确保选择 Auto Discovery 并添加 ssmon 密码。

6. 使用 Configuration Service Console 软件来验证和配置活动服务器上的 
Configuration Service 存储，然后重新启动该服务器。

存储阵列可能在双活动 / 活动存储子系统上已预先配置。需要查看 Configuration 
Service 树视图中的配置，以确定是否存在预配置。

如果存储未配置或者希望更改配置，可在一台服务器上配置所有 LUN。然后，在 
Microsoft Cluster Server 软件安装后，可以使用 Cluster Administrator 在服务器之间
分配存储设备。

7. 使用 NT Disk Administrator 在活动服务器上创建分区并格式化 LUN。 

a. 如有必要，重新分配磁盘的驱动器号。 

注意必须以 NTFS 格式化分区。

Microsoft Windows NT 将在双活动 / 活动控制器上的 LUN 看作是在群集中的两台
服务器上。可以只在一台服务器上创建分区和逻辑驱动器。然后，安装 MSCS 后，
可以使用 Cluster Administrator 在两台服务器间分配存储设备。

用于两台服务器的共享 SCSI 存储设备的驱动器号必须相同。如果在两台服务器中只
有一台上有额外的 CD-ROM 或外部硬盘，可能需要为共享存储设备重新指定驱动器
号。完成此步骤后，检查另一台服务器上驱动器号以确保它们是相同的。

b. 写下指定给共享存储设备的驱动器号。

8. 访问第二台服务器。 

a. 启动 Disk Administrator 并确保第二台服务器与第一台服务器的驱动器号相同。 

如果驱动器号不相同，应重新分配驱动器号，以使它们在两台服务器上一致。

9. 关闭第二台服务器。

10. 在第一台服务器上安装 Microsoft Cluster Server 软件并重新启动。 

a. 安装 MSCS 后，启动 Cluster Administrator 并确保它可以识别出群集。
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11. 访问第二台服务器，通过将其连接到第一台服务器来安装 MSCS，然后重新启动。

a. 在第二台服务器上安装 MSCS 后，重新启动第二台服务器并且在 Cluster 
Administrator 中验证两台服务器是否都已包括在群集中。

12. 在 Cluster Administrator 中调整磁盘组。 

确保仲裁磁盘和其它磁盘 （如果存在）全部都在最初配置存储设备的第一台服务器下
的一个磁盘组中。参阅 Microsoft Cluster Service 文档可获得执行该步骤的详细信息。

注意 – 只要将两个 LUN 置于同一个磁盘组中，就会得到一个可删除的空磁盘组。

13. 将 Configuration Service 服务添加到第一台服务器上有仲裁磁盘的组。

a. 在两台服务器上，停止所有三个 Configuration Service 服务：Configuration 
Service Startup、 Configuration Service Monitor 和 Configuration Service 
Server，并将它们设置为手动。

b. 使用 Cluster Administrator 将每个 Configuration Service 服务作为资源安装到具
有仲裁磁盘的组。 

对于每个服务，在下面列出的顺序输入，并按照指定格式 （两个单词在一起）键入
服务名。安装完毕每一服务后，将服务恢复联机以在活动服务器上启动服务。

输入服务，作为通用服务。将要求指出每一资源的相关性。组中的相关性如下：

■ 与仲裁磁盘相关的磁盘
■ 其它磁盘 （如果要添加到该组）
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup 依赖于已在组中的两个磁盘。 Configuration 
ServiceMonitor 依赖于 Configuration Service Startup，而 Configuration 
ServiceServer 依赖于 Configuration Service Monitor。

14. 要使两个群集服务器在 Configuration Service 中的群集 IP 地址下显示为一个图标，
可编辑 CLUSTER.TXT。

该文件与 Configuration Service Console 文件位于同一目录。它在安装 Configuration 
Service Console 的计算机的系统磁盘上。如果驱动器 C 是系统磁盘，路径为：

C:\Program Files\Sun\sscs
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以下文字说明文件的内容：

15. 编辑文件最后一行，插入群集的 IP 地址，然后插入构成群集的两台服务器的 IP 地址。 

a. 删除数字符号 (#)。

16. 启动 Configuration Service Console 且将第一台服务器从 Managed Servers 列表中
删除，并将群集作为服务器添加到列表。

a. 访问 Server List Setup 功能。参阅第 37 页的 “添加服务器”。 

确保选择 Auto Discovery 并添加 ssmon 密码。如果键入群集名称，在网络具有 
DNS 的情况下， Configuration Service 会提供 IP 地址。

此时，群集配置已正确配置为能够与 Configuration Service 一起工作。如果具有 
Configuration Service 服务的服务器发生运行故障，它的磁盘组会转移到第二台服
务器，且 Cluster Administrator 会自动启动该服务器上的 Configuration Service 
服务。

注意 – 如果一台服务器发生故障，在 15 分钟内 Configuration Service Console 的群集
图标由紫色改变为灰色，且可能在 10 分钟后再改变为紫色。

如果希望某些运行在其它服务器上的存储设备具有负载平衡配置，必须使用 Cluster 
Administrator 将一个或多个磁盘组移至相应的服务器。

#Edit this file to map the NT cluster IP address to several
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example:If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure an NT cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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附  录 D

确定主机全球广域名称 (World Wide 
Name)

本附录说明了如何在运行 Solaris 操作环境和 Microsoft Windows NT 的系统上确定主
机全球广域名称 (WWN)。

▼ 确定主机全球广域名称

如果在使用 LUN 过滤功能之前，能预先确定 Sun StorEdge 3510 光纤通道阵列与 
HBA 卡之间的连接关系及分配给每块卡的 WWN，则大有裨益。

Solaris 操作环境

1. 如果计算机中安装了新的 HBA 设备，需重新启动计算机。

2. 键入以下命令

3. 向下滚动列表，查看光纤通道设备及相关的 WWN。

# luxadm probe
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Linux 和 Microsoft Windows NT/2000 

1. 启动特定的主机，并注意 BIOS 版本和连接到该主机的 HBA 卡的型号。 

2. 使用正确的命令访问 HBA 卡上的 BIOS （通常使用 Alt-q 或 Control-a）。 

如果主机上装有多个 HBA 卡，选择与存储设备连接的 HBA 卡。 

3. 扫描该卡，查找它所连接的设备 （通常使用 Scan Fibre Devices 或 Fibre Disk 
Utility）。

节点名称 （或类似标识）即为全球广域名称。

以 Qlogic 卡举例：

ID Vendor  Product Rev Node Name Port ID

0 Qlogic QLA22xx Adapter B 210000E08B02DE2F 0000EF
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附  录 E

电子邮件和 SNMP

Configuration Service 具备完整事件监控和电子邮件通知能力。Configuration Service 
Consoles 能够将 SMTP 电子邮件消息发送到指定的电子邮件地址列表。可以对诸如 
Microsoft Exchange 等电子邮件系统进行配置或编写脚本，以根据事件的不同将传呼发
送到管理人员。某些寻呼服务还可将电子邮件消息发送到寻呼机。

Configuration Service Agent 会将事件记入操作环境的错误日志。 Configuration 
Service Agent 还将关于海量存储事件的 SNMP 陷阱发送给企业管理控制台（诸如 HP 
OpenView 等）。

本附录说明了如何建立 Configuration Service Consoles 发送电子邮件消息。还说明了
如何配置服务器将陷阱发送到 SNMP 管理控制台，并且描述了陷阱格式，且给出有关 
SNMP 的背景信息。另外，还讨论了在不需要 Configuration Service 的情况下发送 
SNMP 陷阱的方法。本章包含以下主题：

■ 第 212 页的 “为每台服务器发送电子邮件消息”
■ 第 214 页的 “设置服务器发送陷阱”
■ 第 215 页的 “检查社区字符串”
■ 第 216 页的 “指定陷阱接收者”
■ 第 217 页的 “设置 Solaris 操作环境服务器”
■ 第 218 页的 “SNMP 的工作方式”
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▼ 为每台服务器发送电子邮件消息

利用 Server List Setup 功能配置控制台，来为每个受管服务器发送电子邮件消息。

1. 选择 File → Server List Setup。 

显示 Server Setup 窗口。 

 

2. 单击 Add。

如果该服务器已添加，则需要将其移到 Available Servers 列表中，并单击 Edit。

显示 Add Server 或 Edit Server 窗口。两个窗口的字段相同。

3. 如果尚未添加该服务器，则应在 Properties 选项卡中填入信息。  

要获得详细信息，请参阅第 38 页的 “添加服务器：”。
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4. 要使用电子邮件发送事件消息，选择 Mailing Lists 选项卡。 

显示 Add Server 窗口，其中 Mailing Lists 已选中。

a. 对于每位用户，将电子邮件地址键入 Mail Address 字段中。

b. 在 Severity 列表框中，滚动列表来选择所需的条目。

c. 单击 Add to List。 

要从列表中删除用户，选择邮件地址并单击 Delete from List。

d. 指定邮件服务器。单击 Setup Mail Server。 

显示 Mail Server Setup 窗口。 
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键入简单邮件传输协议 (SMTP) 邮件服务器 （该服务器用于将电子邮件消息递交到
预先指定的目的地址）的 IP 地址或名称。

e. 如果 Mail Server 窗口中的信息符合您的要求，则单击 OK。 

显示 Add Server 或 Edit Server 窗口。

5. 如果 Add Server 或 Edit Server 窗口中的信息符合您的要求，则单击 OK 。 

显示 Server Setup 窗口。

6. 如果要添加更多的服务器，为每台服务器重复步骤 2 到 5。

7. 如果需要，将一台或多台希望由该控制台控制的服务器移到 Managed Servers 列表。 

如果正在编辑服务器，必须将其移回 Available Servers 列表。

8. 单击 OK 返回 Configuration Service 主窗口。

设置服务器发送陷阱
如果网络中有企业管理控制台 （如 HP OpenView 或 IBM NetView），可以配置 
Configuration Service 服务器，将有关事件的陷阱发送至控制台。本节说明了所需的配
置步骤。

注意 – 如果希望 Configuration Service 能够将 SNMP 陷阱发送到其它企业管理控制台
时，才需要按照本节中的指导完成。

警告 – 如果 HP OpenView 安装在设置为发送陷阱的同一服务器上，为避免初始化错
误，需要重新配置系统资源。要获得更多关于重新配置系统资源的指导，请参阅故障检
修条目第 228 页的 “症状：HP OpenView 未安装或者陷阱守护程序未启动。”。
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Microsoft Windows NT 服务器

要配置 Microsoft Windows NT 服务器，以将 SNMP 陷阱发送至一个或多个企业管理
控制台，必须在服务器上配置每个 SNMP 服务，以确保：

■ 服务器列出企业管理控制台的社区字符串或者社区名称。

■ 服务器列出企业管理控制台，作为陷阱接收者，以接收来自 Microsoft Windows NT 
代理软件的陷阱。

▼ 检查社区字符串

可以使用默认社区名称或公用社区字符串。然而，选择社区名称而非公用名称提供更高
的安全性，因为它将通讯限制在具有指定社区字符串的计算机中。

要为 Microsoft Windows NT 4.0 设置社区字符串，请执行以下操作：

1. 在 Control Panle 窗口中，双击 Network 图标，然后单击 Service 选项卡 （如果该选
项卡尚未选中）。

在 Network Services 列表中，滚动至 SNMP 服务，单击一次将其选中，然后单击 
Properties。 

显示 Microsoft SNMP Properties 窗口。

注意 – 如果未安装 SNMP 服务，可以通过单击 Network 窗口中的 Add 来安装该服
务。显示 Select Network Service 窗口，可以从中选择 SNMP 服务。需要插入 
Microsoft Windows NT 4.0 CD，以使计算机能够复制 SNMP 服务所必需的文件。

2. 单击 Microsoft SNMP Properties 窗口中的 Security 选项卡，显示 Security 设置。

3. 确保希望用于服务器的社区名称或者社区字符串已在 Accepted Community Names 列
表中指定。

如果名称不在列表中，单击 Add 以显示 Service Configuration 窗口。在输入字段中键
入新名称并单击该窗口中的 Add。显示 Security 选项卡，其中新名称出现在 Accepted 
Community Names 列表中。

注意 – 社区名称或社区字符串区分大小写。
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4. ( 可选）如果需要，将 Accept SNMP Packets from Any Host 的默认设置更改为 Only 
Accept SNMP Packets from These Hosts，并添加企业管理计算机的网络地址，该计
算机接收来自服务器上的 Configuration Service Agent 的陷阱。 

使用该设置可以提供更多的安全性，因为这可以让您指定一台或多台计算机，
Microsoft Windows NT 代理从其中接收信息。

要将装有 Configuration Service 管理控制软件的计算机的网络地址添加到下一列表框，
单击 Add 以访问 Security Configuration 窗口。在 Entry 框中键入 IP 地址，并在该窗
口中单击 Add。 Security 选项卡再次出现，显示 Configuration Service 管理控制台计
算机的地址。

5. 单击 OK。 

▼ 指定陷阱接收者

在该过程中，您将列出企业管理控制台，作为接收来自服务器的陷阱的接收器。

注意 – 对于该过程，需要接收陷阱的企业管理控制台的 IP 地址。该过程还要求与前面
各节中指定的社区名称相同。

指定企业管理控制台计算机作为代理陷阱接收者的步骤如下。

1. 单击 Microsoft SNMP Properties 窗口中的 Traps 选项卡以显示 Traps 设置。 

2. 确保指定的社区名称与此前在 Security 选项中指示的名称相同。

如果需要纠正社区名称，将其键入到 Community Name 字段中，并点击 Add。如果
输入字段中已存在另一个名称，则以覆盖该名称的方式键入新的名称后，原有名称仍将
保留。要删除名称，将其选中并单击 Remove。

3. 在 Trap Destinations 列表中添加企业管理控制台的 IP 地址。

a. 单击 Add。

显示 Service Configuration 窗口。 

b. 在 Entry 字段中键入 IP 地址，并单击 Add。

显示 Traps 选项卡，其中新的网络地址出现在 Trap Destinations 列表中。

c. 按照下列格式键入每个 IP 地址：AAA.BBB.CCC.DDD

您无须键入前导零。正确地址举例：

192.168.100.1

4. 如果希望将可选 Configuration Service 陷阱发送至另一个企业管理控制台，键入管理
工作站的网络地址。

如果拥有多个企业管理控制台，每个控制台的地址都必须在这里显示出来。
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5. 单击 OK 以确认设置。

6. 单击 Close 离开 Network 窗口。

7. 退出 Microsoft Windows NT，并重新启动服务器。

如果计划安装 Configuration Service，安装完该软件后才需要重新启动。

▼ 设置 Solaris 操作环境服务器

借助用于运行 Solaris 操作环境的系统的 Configuration Service，可以通过与一个名为 
sstrapd 的 SNMP 陷阱守护程序的接口来生成 SNMP 版本 1 陷阱。在默认情况下，
在启动过程期间，该守护程序不会自动启动。以下步骤说明如何启用陷阱处理。 

1. 使用任意标准文本编辑器创建文件 
/var/opt/SUNWsscs/ssagent/sstrapd.conf。

该文件包含 SNMP 管理员控制台的名称或 IP 地址。如果有多个控制台，分行单独列出
这些地址。

2. 编辑文件 /etc/init.d/ssagent 并从与 SNMP 相关的开始部分删除注释标记。这
些行的行首使用双井号进行标记 （##）。

3. 进行上述编辑后保存该文件。

sstrapd 守护程序在下一次引导时启动，也可以通过运行以下命令立即启动。

这将启动 sstrapd 守护程序以及其它两个 Configuration Service 守护程序 （如果这
些程序当前未在运行）。无论此前是否有守护程序运行，此时每个守护程序都只有一个
实例在运行。

▼ 设置 Linux 操作环境服务器

借助用于运行 Linux 操作环境的系统的 Configuration Service，可以通过与一个名为 
sstrapd 的 SNMP 陷阱守护程序的接口来生成 SNMP 版本 1 陷阱。在默认情况下，
在启动过程期间，该守护程序不会自动启动。以下步骤说明如何启用陷阱处理。

1. 使用任意标准文本编辑器创建文件 /var/opt/SUNWsscs/ssagent/sstrapd.conf。

所创建的文件必须包含一个 SNMP 管理器控制台的系统名称或 IP 地址列表 （每行列
出一个）。该文件可以包含空行和注释行。

2. 编辑文件 /etc/init.d/ssagent，并将与 SNMP 相关的开始部分中的注释标记删除。

这些行的行首使用双井号进行标记 （##）。

/etc/init.d/ssagent uptrap
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3. 进行上述编辑后保存该文件。

sstrapd 守护程序在下一次引导时启动，也可以通过运行以下命令立即启动。

这将启动 sstrapd 守护程序以及其它两个 Configuration Service 守护程序 （如果这
些程序当前未在运行）。无论此前是否有守护程序运行，此时每个守护程序都只有一个
实例在运行。

SNMP 的工作方式
简单网络管理协议 (SNMP) 是网络管理中使用最广泛的协议之一。顾名思义， SNMP 
以相对简单的方式管理网络设备。 SNMP 是一种简单的、尚未正式认可的无连接协议。

开发 SNMP 的最初目的是在 Internet 协议组 － 主要是 TCP/IP （传输控制协议／
Internet 协议） － 传送协议下工作。从此以后， SNMP 已被用于在其他常用传输协议 
－ 如 Novell 的 IPX/SPX （Internet 数据包交换 / 顺序数据包交换）之上工作。

SNMP 陷阱消息

Configuration Service Agents 使用 SNMP 将信息发送到企业管理系统。

一旦服务器被配置为发送陷阱， Configuration Service 事件信息就流向该系统。

Configuration Service 的陷阱消息包含以下信息：

■ OID （对象标识符） 1.3.6.1.4.1.2294.1.2

■ 事件日期 （MM, DD, YY，如 01, 22, 98）

■ 事件时间 （HH:MM:SS，如 15:07:23）

■ 服务器地址和名称 （IP 地址名称，如 192.187.249.187 Administration）

■ 网卡名称

■ 事件严重性 （信息、警告、危险）

■ 文本消息

显示的信息和格式取决于正在使用的 SNMP 管理控制台。

必须将文件 RST_OID.MIB加载到企业管理控制台才能接收陷阱。在 Solaris 和 Linux 
操作环境中，该文件位于 /opt/sun/SUNWsscs/ssagent。在 Microsoft Windows 
中，该文件位于
\Program Files\Sun\ssagent。

/etc/init.d/ssagent uptrap
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代理和管理器

SNMP 软件模块由代理和管理器组成。代理是一种软件，能够监视被管理设备中的变
量。代理软件可以嵌入被管理设备，也可以与设备连接的计算机上运行。

管理器或者管理控制台是网络监控软件，使用 SNMP 将有关变量的请求发送至代理。
由于变量的值会变化，管理器将定时轮询代理。 SNMP 管理器通常分析从代理接收的
数据，并将其以图形化的方式提供给用户。数据可以存储在数据库中，用于历史性和趋
势性分析。

除了响应 SNMP 管理器的请求外，代理还可以主动发送通知或将陷阱发送至管理站。
这类似于传统软件的中断信号。

管理控制台能采取多种动作对陷阱作出响应。通常对陷阱进行日志记录，将其中的信息
通过通知计划转发给感兴趣的用户。陷阱也可能导致 SNMP 管理器启动进一步的动
作，如查询代理 （发出更多请求以查找网络实体的当前状态，或者启动应用程序）。

管理信息库 (MIB)
在网络中，每个配备 SNMP 代理的设备都有一个或多个变量或对象与之相关联。典型
变量的例子是一个跟踪设备名称的变量。这些变量或对象在一个名为 Management 
Information Base (MIB) 的文本文件中有所描述。 MIB 是被管理变量的一个精确的
文本定义。定义 MIB 的过程已经由国际标准化组织 (ISO) 的 Internet 工程任务组 
(IETF) 建立起来。

SNMP 对象

某些用于网络管理的变量对于所有局域网网络设备是通用的。许多变量已标准化，被称
为 MIB-II 变量和 MIB-II 扩展。 IETF 还为标准 MIB-II 范畴之外的 MIB 定义了过程。
这些变量在专用企业 MIB 中列出。

Configuration Service 变量在私人企业 MIB 的 Configuration Service 条目下列出。例
如，对象 ID 1.3.6.1.4.1.2294.1.2 指一个变量的对象 ID （或 OID），该变量用于跟踪在
某个 Configuration Service 的 MIB 中的代理版本。  

图 E-1 中的图表显示了如何获得 OID。该选择标志指示出 OID 中的节点。在 MIB 中，
特定变量或对象的数据位于其 OID 下。

Sun 的树节点为 2294。每个希望开发识别其设备的代理的私人企业都可以向 IETF 申请
自己的树节点。
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SNMP 请求类型

支持访问 MIB 数据的 SNMP 操作包括 Get、 GetNext 和 Set。如果给定了索引值，
Get 即从表格条目字段值检索标量值。 GetNext 用于遍历表格条目的实例，每次执行该
命令会返回用户感兴趣的栏 （或字段）中的下一个顺序值。 Set 操作用于创建或更改 
MIB 变量的值。

SNMP 安全性

设置值增加了安全性问题 SNMP V1 （版本 1）有一套简单的安全方案。每个协议数据
单元 (PDU) 包含一个社区字符串，如同用户名和密码的组合。每个代理可以面向特殊
的社区字符串进行配置。代理不响应发送给它的请求，除非在请求 PDU 中的社区字符
串与它自身配置中的社区字符串相匹配。
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图 E-1 MIB 变量的对象标识符

org (3)

dod (6)

internet (1)

directory (1)

mgmt (2)

mib-II-(1)

system (1)
interfaces (2)
at (3)
ip (4)
icmp (5)
tcp (6)
udp (7)
egp (8)
transmission (10)

experimental (3)

private (4)

enterprises (1)

RS.mib (1)

agentVersion (2)

对象 ID
1.3.6.1.4.1.2294.1.2

选中标志表明 OID 中的节点。

snmp (11)

ISO (1)

ART (2294)
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▼ 发送 SNMP 陷阱而不使用 Configuration Service
以下是发送 SNMP 陷阱的替代方法，它们不需要使用 Configuration Service。

阵列能够将关于海量存储事件的 SNMP 陷阱发送给企业管理控制台 （如 HP 
OpenView）。以下配置不要求安装 Configuration Service Agent 来发送 SNMP 陷阱。

1. 打开文本编辑器。

2. 键入以下信息，在它们用于网络时替代这些变量。

[SNMP_TRAP]
ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]
ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. 使用以下名称保存该文件 agent.ini。

4. 从你的工作站 FTP 至阵列。

5. 键入 root 用户名，按下 Return

6. 在提示输入密码时，按下 Return。

如果此前已为控制器指定了密码，则需要在提示时键入密码。

7. 一旦登录，转到 /cfg 目录。

8. 将文件从工作站放入 /cfg 目录。

9. 退出 FTP 会话。

10. 通过任何用于管理阵列的方法来重置控制器，例如 Configuration Service Console、
Telnet 或终端会话。
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附  录 F

故障检修

本章对以下症状提供了故障检修建议：

■ 第 224 页的 “症状：在安装 Configuration Service 时， java -version  返回低
于 1.2.2 的 Java 运行时环境版本，但是机器已经安装了 Java 运行时环境 1.2.2， 1.3 
或 1.4。”

■ 第 224 页的 “症状：服务器不响应，服务器已关机。”

■ 第 225 页的 “症状：当从现有的逻辑驱动器中选择添加逻辑卷时，未列出逻辑驱动
器。”

■ 第 226 页的 “症状：DHCP 环境中的某台服务器的 IP 地址已更改。”

■ 第 226 页的 “症状：无法从服务器接收陷阱。”

■ 第 228 页的 “症状：HP OpenView 未安装或者陷阱守护程序未启动。”

■ 第 228 页的 “症状：当添加或更换硬件时，控制台不显示更改。”

■ 第 228 页的 “症状：运行 Solaris 操作环境的系统上没有逻辑驱动器。”

■ 第 229 页的 “症状：环境警报无法报告”

■ 第 229 页的 “症状：Configuration Service console 运行缓慢”

■ 第 230 页的 “症状：Diagnostic Reporter 停止工作”

■ 第 230 页的 “症状：(Solaris/Linux) 未显示在线帮助”
 223



症状：在安装 Configuration Service 时，java -version  返回低于 
1.2.2 的 Java 运行时环境版本，但是机器已经安装了 Java 运行时环境 
1.2.2， 1.3 或 1.4。 

1. 检查 /usr目录以确认从 Java 到 Java 是最新版本的链接而不是 Java 1.1。

要检查 Java 版本，键入

(Solaris 操作环境）如果链接并非指向所列出的最新的 Java 版本，则键入

其中 xxx 是最新的 Java 版本。

症状：服务器不响应，服务器已关机。

确保服务器正在运行 Configuration Service 服务。

1. （Solaris 操作环境）运行以下命令

ssmon 和 ssserver 这两个名称都应在输出中出现。如果未都出现，进到步骤 2，否
则，进到步骤 4。

(Microsoft Windows NT) 转到 Settings → Control Panel → Services，验证 SUNWscsd 
Monitor、 SUNWscsd Server 和 SUNWscsd Startup 服务已经启动。如果未都启动，
进到步骤 2，否则，进到步骤 4。

(Microsoft Windows 2000) 转到 Start → Administrative Services → Computer 
Management。单击 Services & Applications，验证 SUNWscsd Monitor、
SUNWscsd Server 和 SUNWscsd Startup 服务是否已经启动。如果未都启动，进到步
骤 2，否则，进到步骤 4。

2. (Solaris 操作环境 /Linux）如第 12 页的“启动或停止 Configuration Service Agent”
中所示，停止和启动各个守护程序。

(Microsoft Windows NT/2000）通过右键单击要启动或停止的服务，将服务停止然后启动。

3. 如果守护程序或服务没有正常停止或启动，则重新配置后进行重新引导。

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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4. 确保 TCP/IP 协议软件已加载，网卡和网络连接工作正常。

要在命令行中测试 TCP/IP 连接性，键入

如果未得到回答，则 TCP/IP 协议服务有问题。联系 MIS 部门寻求帮助。

5. 确保指定了正确的服务器名称和密码。

如果名称或者密码不正确，通过编辑条目进行更正。对于 Solaris OE，请参阅第 13 页
的 “管理 （用户）安全级别和准则”。对于 Windows Microsoft NT/2000，请参阅第 
20 页的 “管理员 （用户）安全级别和准则”。对于 Linux OE，请参阅第 28 页的 “管
理 （用户）安全级别和准则”。

密码必须是通过为安装 Configuration Service 用户的程序建立的。

■ 确保已正确设置了 Configuration Service 用户 （ssmon、 ssadmin、
ssconfig）。确保用户已在 Microsoft Windows NT 中设置为拥有权限 Act as a 
part of the operating system 和 Log on as a batch job。

■ 如果正在使用命名服务 （Windows NT 域，以及 Solaris 操作环境中的 NIS 或 
NIS+），则确保用户已被正确添加到了命名服务。

■ 如果是在 Microsoft Windows NT 下的域中输入了用户名，则传播用户名需要一段
时间。

症状：当从现有的逻辑驱动器中选择添加逻辑卷时，未列出逻辑驱
动器。

如果在 Select a Logical Drive 下未列出任何逻辑驱动器，说明逻辑驱动器尚未被取消
映射，因此无法选择。必须先取消逻辑驱动器的映射。

# ping {服务器 IP 地址或服务器名称 }
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症状：DHCP 环境中的某台服务器的 IP 地址已更改。

在 DHCP 环境中，如果服务器脱机超过三天，服务器 IP 地址发生变化的可能性极小。

如果发生这种情况， Configuration Service Console 必须通知服务器的新 IP 地址，因
为控制台与服务器是通过 IP 地址通信的。

要补救这种情况，需要在 Configuration Service Console 的 Edit Server 窗口中输入新
的服务器 IP 地址。

1. 选择 File → Server List Setup。

2. 将服务器名称从 Managed Servers 列表移至 Available Servers 列表。

Edit Server 窗口显示。窗口显示配置时的服务器名称和 IP 地址。

3. 在 Available Servers 列表中选择服务器名称，并单击 Edit。

Edit Server 窗口显示。窗口显示配置时的服务器名称和 IP 地址。

4. 如果网络地址已更改，单击 Get IP Addr by Name。 

如果您提供了网络使用的服务所记录的服务器名称，Configuration Service 将搜索并显
示正确的 IP 地址。否则，必须手动键入 IP 地址。

如果服务器使用的名称与服务器的网络名称不一致，或者命名服务尚未更新，则必须手
动键入 IP 地址。

5. 一旦输入了服务器 IP 地址，单击 OK 以指定更改的地址，然后返回 Server List Setup 
窗口。

6. 将服务器名称移回 Managed Servers 列表。

7. 单击 OK 退出 Server List Setup 窗口。

症状：无法从服务器接收陷阱。

要解决为何在 SNMP 管理工作站 （如 HP OpenView）上没有从 Configuration 
Service 服务器接收到陷阱，使用下列步骤：

1. 确保 SNMP 服务已在服务器上启动。

验证 sstrapd 通过运行以下命令已运行。
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输出包括名称 sstrapd；如果没有，则请参阅第 12 页的“启动或停止 Configuration 
Service Agent”，以获得有关启动守护程序的指示。

在 Microsoft Windows NT 下，转到 Control Panel → Services，检查是否列出 SNMP 
服务并显示为已启动。如果没有，安装该服务，然后启动服务。请参阅 Microsoft 
Windows NT 文档，以获得详细信息。

2. 检查企业管理控制台的目标地址是否正确以及社区字符串是否在服务器上正确设置。

第 214 页的 “设置服务器发送陷阱”提供了在 Microsoft Windows NT 服务器上正确
设置将陷阱传送到企业管理控制台的具体步骤。

3. 确保 Configuration Service MIB 已在 SNMP 管理控制台下编译。

在 Solaris 和 Linux 操作环境中， RST_OID.MIB 文件位于 
/opt/SUNWsscs/ssagent 中。在 Microsoft Windows 上，该文件位于
\Program Files\Sun\ssagent。请参阅 SNMP 管理控制台文档，（如 HP 
OpenView 等）可以有关获得如何编译 MIB 的信息。

4. 在 Microsoft Windows NT 环境下，检查 Configuration Service 的 NT 注册表项。 

如果 Configuration Service 条目缺失，在服务器上重新安装 Configuration Service 
Agent。

a. 首先，确保 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\ 
Parameters\ExtensionAgents 

包含针对 SSAGENT 的条目。

b. 第二，检查

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration 
Service Agent\SNMP Extension Agent\Current Version

指向带有完整的路径名称的扩展代理程序： 
C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ 是默认安装目录。如果已将 Configuration Service 
安装到其它目录，请确保该注册表项指向此目录。

c. 第三，确保

SSAGENT.DLL 

位于 C:\PROGRA~1\Sun\ssagent 目录下。

# ps -e | grep ss
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症状：HP OpenView 未安装或者陷阱守护程序未启动。

如果在准备要发送 SNMP 陷阱的同一台服务器上安装了 HP OpenView，会导致没有
足够的系统资源同时运行陷阱守护程序和 HP OpenView。依照下列步骤中的解释对系
统资源进行重新配置。

1. 将以下行添加到 /etc/system 未端 .

2. 重新启动服务器。

症状：当添加或更换硬件时，控制台不显示更改。

如果添加了新设备或更换了故障设备 （诸如磁盘驱动器、磁带驱动器、电源或风扇等）
Configuration Service Console 不会总是显示最新信息。有时，树视窗与之相关的其它
视图无法反映设备的实际状态。

如果在下一个周期性扫描前，希望控制台能够识别新添加的设备，在 Server View 窗口
单击 Rescan。服务器立刻会重新扫描库存，控制台更新其服务器库存，并在树视图中
显示任何更改结果。要确保得到及时库存，可进行手动扫描。

可能必须多次单击 Rescan。当服务器在重新扫描过程中而控制台发送了库存请求时，
服务器只将最近一次更新结果发送到控制台，因为服务器尚未完成当前扫描。

症状：运行 Solaris 操作环境的系统上没有逻辑驱动器。

如果 Configuration Service 未显示逻辑驱动器，应确保已为逻辑驱动器加卷标且其未
被 Configuration Service （如果已安装）排除在外。

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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症状：环境警报无法报告

具有基于 SCSI 机箱监控功能的存储机箱 （如 SAF-TE 卡）将环境警报发送到 
Configuration Service 控制台。警报状况可能是由驱动器、风扇、电源或异常温度故障
引起的。

如果环境警报发生，必须在 View Enclosure 窗口单击 Reset 才能消除警报。必须要有
配置安全性特权才可以在软件中单击 Reset。 

警报产生后，要求用于这些存储机箱的 SAF-TE 监控规范，直到警报重置后，由此引起
的环境警报才会生成。

重置警报后，环境事件再次显示在 Event Log 中。

症状：Configuration Service console 运行缓慢

运行于 Windows NT 环境下的 Configuration Service 控制台，要求在控制台工作站上
最少有 10MB 的可用虚拟内存 （物理内存加页面文件大小）。可用物理内存越大，控制
台程序的可响应程度就较高，它将操作系统的内存分页从物理内存最小化到页面文件。

当使用的内存总量接近可用虚拟内存总量 （物理内存加页面文件总量）时，超过的分
页内容有可能引起问题，导致工作站上所有应用程序的性能降低。

增大物理内存和页面文件大小以增大整体虚拟内存。要改变页面文件大小，请选择 
Control Panel → System，然后在所显示的 System Properties 窗口中选择 
Performance 选项卡。在 Windows NT 环境中，在 Performance 选项卡窗口的 Virtual 
Memory 部分更改页面文件大小。 
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症状：Diagnostic Reporter 停止工作

如果停止从 Diagnostic Reporter 接收电子邮件消息，则其可能不再工作，可能需要将
其停止并重新启动。

（Solaris 操作环境）Diagnostic Reporter 停止工作并且不再报告其状况的情况有三种。
变通办法就是停止并重新启动 Diagnostic Reporter。

■ 如果 Configuration Service Agent 失败或者被停止和重新启动，则 Diagnostic 
Reporter 停止工作。

■ 如果 Diagnostic Reporter Config Tool 正在运行，而 Diagnostic Reporter 守护程序
停止和重新启动，则可能会发生 Diagnostic Reporter Config Tool 无法继续与守护
程序通信的情形。

■ 如果 Configuration Service Agent 失败或者被停止和重新启动，则 Diagnostic 
Reporter 守护程序没有检测到这一情况，停止发送电子邮件消息，并继续通过绿色
状态显示，显示 Diagnostic Reporter 依旧保持连接。

停止和重新启动 Diagnostic Reporter，方法是键入

症状：(Solaris/Linux) 未显示在线帮助

请确保指定了将用于显示在线帮助的 Web 浏览器的绝对路径名。

1. 转到 /opt/SUNWsscs/sscsconsole 并键入 

2. 输入 Web 浏览器的绝对路径名。

# /etc/init.d/ssdgrptd stop 
# /etc/init.d ssdgrptd start

./config_sscon
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附  录 G

错误代码和消息

本附录提供错误代码以及错误和状态消息列表。

错误代码
错误代码是在事件日志中显示和说明的，是一个八个字符长代码，其中包括四个字段，
即每个字段有两个字符构成。下列各表说明每个双字符字段中所用的错误代码。四个双
字符字段的格式为：

SSMMmmEE

其中：

SS = Severity 字段

MM = Major 字段

mm = Minor 字段

EE = Error 字段

表 G-1 Severity 字段

Severity 字段 说明

01 Critical

01 危险

02 Warning

02 警告

03 Informational

03 信息
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表 G-2 Major 字段

Major 字段 说明

01 Not Used

01 未用

03 Legacy

03 传统

04 RAIDCard Card message

04 RAIDCard Card 消息

05 JBOD (Just a bunch of disks) message

05 JBOD （简单磁盘捆绑）消息

06 SSMon monitor message

06 SSMon 监控消息

07 dll/shared library message

07 dll/ 共享库消息

08 SSserver message

08 SSserver 消息

09 HBA (Host Bus Adapter) message

09 HBA （主机总线适配器）消息

0A Server Communications message

0A Server Communications （服务器通信）消息

0B Sun StorEdge controller message

0B Sun StorEdge controller message
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下表中定义 Minor 字段。 Error 字段的定义取决于 Minor 字段的定义，因而需要参照
相应的表。

表 G-3 Minor 字段

Minor 字段 说明

01 Unknown

01 未知

02 请参阅第 234 页的 “Error 字段：系统驱动器状况”。

03 请参阅第 235 页的 “Error 字段：磁盘状况”。

04 请参阅第 236 页的 “Error 字段：SAF-TE 状况”。

05 请参阅第 237 页的 “Error 字段：磁带状况”。

06 请参阅第 239 页的 “Error 字段：冗余状况”。

07 请参阅第 240 页的 “Error 字段：内部状况”。

08 请参阅第 240 页的 “Error 字段：设备状况”。

09 请参阅第 240 页的 “Error 字段：初始化状况”。 

0A 请参阅第 241 页的 “Error 字段：客户端参数无效”。

0B 请参阅第 242 页的 “Error 字段：打开传输”。

0C 请参阅第 242 页的 “Error 字段：关闭传输”。

0D 请参阅第 242 页的 “Error 字段：内存分配”。

0E RaidCard fault detected.

0E 检测到 RaidCard 故障。  

0F 请参阅第 243 页的 “Error 字段：传输”。

10 请参阅第 244 页的 “Error 字段：命令”。

11 请参阅第 244 页的 “Error 字段：命令”。

12 请参阅第 244 页的 “Error 字段：主要通信”。

13 请参阅第 245 页的 “Error 字段：异步通信”。

14 请参阅第 245 页的 “Error 字段：通信安全”。

15 请参阅第 245 页的 “Error 字段：超时”。

16 请参阅第 246 页的 “Error 字段：管理”。

17 请参阅第 247 页的 “Error 字段：统遂”。

18 请参阅第 247 页的 “Error 字段：系统关闭”。

19 Dynamic Growth fault detected. 

19 检测到 Dynamic Growth （动态增长）故障。 
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Error 字段：系统驱动器状况

1C 请参阅第 248 页的 “Error 字段：Sun StorEdge Set Config”。

1D 请参阅第 249 页的 “Error 字段：Sun StorEdge Controller Event”。

1E 请参阅第 250 页的 “Error 字段：Sun StorEdge Drive Side Event”。

1F 请参阅第 251 页的 “Error 字段：Sun StorEdge Host Side Event”。

20 请参阅第 252 页的 “Error 字段：Sun StorEdge Logical Drive Event”。

23 请参阅第 252 页的 “服务器管理 / 监控事件错误”。

表 G-4 系统驱动器状况错误

Error 字段

01 Offline

01 脱机

02 Degraded

02 低性能

03 Online

03 联机

04 Unknown

04 未知

05 Parity Check

05 奇偶校验

06 Reconstruction

06 重建

07 Reconfiguration

07 重新配置

08 Dynamic Growth

08 动态增长

09 Nonexistent

表 G-3 Minor 字段 （续）

Minor 字段 说明
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Error 字段：磁盘状况

09 不存在

0A Initialization

0A 初始化

表 G-5 磁盘状况错误

Error 字段 说明

01 Offline

01 脱机

02 Degraded

02 低性能

03 Online

03 联机

04 Unknown

04 未知

05 SMART

05 SMART

06 Dead

06 死亡

表 G-4 系统驱动器状况错误 （续）

Error 字段
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Error 字段：SAF-TE 状况 

表 G-6 SAF-TE 状况错误

Error 字段 说明

01 Power

01 电源

02 Fan

02 风扇

03 Thermal

03 热度

04 Alarm

04 警报

05 Locked

05 已锁定

06 Slot

06 插槽

07 Unknown

07 未知

08 Unable to get SAF-TE information

08 无法获得 SAF-TE 信息

09 Battery 

09 电池

0A Invalid Number of Slots

0A 插槽数目无效

0B Environmental Data Not Available

0B 无环境数据可提供
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Error 字段：磁带状况

表 G-7 磁带状况错误

Error 字段 说明

01 Read

01 读

02 Write

02 写

03 Hard Error

03 硬性错误

04 Media Error

04 介质错误

05 Read Failure

05 读取失败

06 Write Failure

06 写入失败

07 Media Life

07 介质寿命

08 Not Upgradable

08 不可升级

09 Write Protect

09 写保护

0A Nonremoval

0A 非移动

0B Cleaning Media

0B 清洁介质

0C Unsupported Format

0C 不支持的格式

0D Snapped Tape

0D 磁带已被扯断

14 Clean Now

14 立刻清洁
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15 Clean Periodic

15 周期性清洁

16 Expired Cleaning Media

16 清洁介质已过期

1E Hardware A

1E 硬件 A

1F Hardware B

1F 硬件 B

20 Interface

20 接口

21 Eject Media

21 弹出介质

22 Down Load Fail

22 下载失败

28 Loader Hardware A

28 加载器硬件 A

29 Loader Tray Tape

29 加载器托盘磁带

2A Loader Hardware B

2A 加载器硬件 B

2B Loader Door

2B 加载器门

C8 Query Log Failed

C8 查询日志失败

C9 Inquire Tape Failed

C9 询问磁带失败

表 G-7 磁带状况错误 （续）

Error 字段 说明
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Error 字段：冗余状况

表 G-8 冗余状况错误

Error 字段 说明

01 Mode OK

01 模式正常

02 No Memory for Negotiation

02 没有内存可用于协商

03 Secondary Failure

03 辅助控制器故障

04 Secondary Removed

04 辅助控制器已被卸下

05 Detected Removal of Secondary

05 检测到辅助控制器卸下

06 Detected Insertion of Secondary

06 检测到辅助控制器插入

07 Primary Failure

07 主控制器故障

08 Primary Removed

08 主控制器已被卸下

09 Detected Removal of Primary

09 检测到主控制器卸下

0A Detected Insertion of Primary

0A 检测到主控制器插入

0B Unknown State

0B 未知状况

0C Partner Failed

0C 伙伴失败

0D Partner Inserted

0D 伙伴已插入

0E Partner Removed

0E 伙伴已移除
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Error 字段：内部状况 

Error 字段：设备状况

Error 字段：初始化状况

表 G-9 内部状况错误

Error 字段 说明

01 No Memory

01 无内存

02 Semaphore

02 信号

03 Thread

03 线程

04 No Devices

04 没有设备

表 G-10 设备状况错误

Error 字段 说明

01 Inquiry

01 查询

02 Unknown

02 未知

表 G-11 初始化状况错误

Error 字段 说明

01 dll Initializing

01 dll 初始化

02 dll Initializing Failed

02 dll 初始化失败
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Error 字段：客户端参数无效

表 G-12 客户端参数错误。

Error 字段 说明

01 Set Configuration ñ Configuration Miscompare

01 设定配置 － 配置失配

02 Set Configuration ñ Configuration Device Invalid

02 设定配置 － 配置设备无效

03 Set Configuration ñ Enquire Miscompare

03 设定配置 － Enquire 失配

04 Set Configuration ñ Enquire2 Miscompare

04 设定配置 － Enquire2 失配

05 Incorrect Application Length

05 应用程序长度不正确

06 Command not Supported

06 不支持的命令

07 Invalid Command

07 命令无效

08 Set Configuration ñ General Miscompare

08 设定配置 － 一般性失配

09 Invalid Length

09 无效长度

0A Invalid Card Identifier

0A 卡标识符无效

0B Invalid Card Name

0B 无效的卡名

0C Invalid Parameter

0C 参数无效

0D Invalid Command for Card Type

0D 卡类型命令无效

0E Set Configuration ñ Invalid Additional Parameter 

0E 设定配置 － 附加参数无效
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Error 字段：打开传输

Error 字段：关闭传输

Error 字段：内存分配

0F Set Configuration ñ Block Overlap

0F 设定配置 － 块重叠

10 Set Configuration ñ Device Information Invalid

10 设定配置 － 设备信息无效

表 G-13 打开传输错误

Error 字段 说明

01 Open Transport

01 打开传输

表 G-14 关闭传输错误

Error 字段 说明

01 Close Transport

01 关闭传输

表 G-15 内存分配错误

Error 字段 说明

01 Insufficient Memory

01 内存不足

02 Insufficient Memory for Administration Operation

02 内存不足，无法进行管理操作

表 G-12 客户端参数错误。 （续）

Error 字段 说明
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Error 字段：传输

表 G-16 传输字段错误

Error 字段 说明

01 Lock Fault

01 锁定错误

02 Insufficient Memory

02 内存不足

03 Acquire Lock Fault

03 获得锁定错误

04 Release Lock Fault

04 释放锁定错误

05 Invalid Command

05 命令无效

06 Invalid Length

06 无效长度

07 Invalid Card Name

07 无效的卡名

08 Invalid Card Identification

08 卡标识无效

09 No Cards Found

09 没有找到卡

0A No Devices Found

0A 找不到设备

0B Open Fault

0B 打开错误

0C Card Name not Found

0C 找不到卡名
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Error 字段：命令

Error 字段：主要通信

Error 字段：通信链路

表 G-17 命令代码错误

Error 字段 说明

01 Lock Fault

01 锁定错误

表 G-18 主要通信错误

Error 字段 说明

01 Socket Fault

01 套接字错误

02 Report Fault

02 报告错误

03 Thread Fault

03 线程错误

04 Lock Fault

04 锁定错误

05 System Fault

05 系统错误

表 G-19 通信链路

Error 字段 说明

01 Socket Fault

01 套接字错误
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Error 字段：异步通信

Error 字段：通信安全

Error 字段：超时

表 G-20 异步通信

Error 字段 说明

01 Socket Fault

01 套接字错误

02 Thread Fault

02 线程错误

03 Cold Link Fault

03 冷链接错误

04 Send Event Fault

04 发送事件错误

表 G-21 通信安全

Error 字段 说明

01 Security Violation

01 安全冲突

表 G-22 超时错误

Error 字段 说明

01 Configuration Update

01 配置更新

02 Lock Timeout

02 锁定超时
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Error 字段：管理

表 G-23 管理错误

Error 字段 说明

01 Set Customer Name Fault

01 设定客户名称错误

02 Set Configuration Ended

02 设定配置已结束

03 Initialize

03 初始化

04 Initialize Ended

04 初始化已结束

05 Rebuild

05 重建

06 Rebuild Ended

06 重建已结束

07 Parity Check

07 奇偶校验

08 Parity Check Ended

08 奇偶校验已结束

09 Set SAF-TE Slot State

09 设定 SAF-TE 插槽状况

0A Set SAF-TE Perform Slot

0A 设定 SAF-TE Perform Slot （执行插槽）

0B Set SAF-TE Send Global

0B 设定 SAF-TE Send Global （发送全局）

0E Schedule Parity Check

0E 调度奇偶校验

0F Schedule Parity Check Ended

0F 调度奇偶校验已结束

10 Set Controller Parameters

10 设定控制器参数
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Error 字段：统遂

Error 字段：系统关闭

11 Firmware Download

11 固件下载

12 Consistency Check for Rebuild Ended

12 一致性检查或重建已结束

表 G-24 固件下载错误

Error 字段 说明

01 Not a SAF-TE Device

01 并非 SAF-TE 设备

02 Invalid Data Length

02 数据长度无效

03 Download Failed

03 下载失败

04 Check Sum Failed

04 校验和失败

表 G-25 关闭系统错误

Error 字段 说明

01 System Shutdown Failed

01 系统关闭失败

表 G-23 管理错误 （续）

Error 字段 说明
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Error 字段：RDP 路径更改

Error 字段：Sun StorEdge Set Config

表 G-26 RDP 路径更改错误

Error 字段 说明

01 RDP Path Failed

01 RDP 路径失败

02 RDP Path Restored

02 RDP 路径已恢复

表 G-27 Sun StorEdge Set Config Errors

Error 字段 说明

01 Set Configuration Thread creation Failed

01 设定配置线程创建失败

02 Get Logical Drive List Command Failed

02 获取逻辑驱动器列表命令失败

03 Create Config Command Failed

03 创建配置命令失败

04 Init Completion Status Command Failed

04 初始化完成状态命令失败

05 Get Configuration Command Failed

05 获取配置命令失败

06 Change Volume Config Command Failed

06 更改卷配置命令失败

07 Delete Logical Drive Command Failed

07 删除逻辑驱动器命令失败
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Error 字段：Sun StorEdge Controller Event

表 G-28 Sun StorEdge Controller Event Errors

Error 字段 说明

01 Controller Reset

01 控制器已重置

02 Controller DRAM Parity Error

02 控制器 DRAM 奇偶效验错误

03 Redundant Controller Failed

03 冗余控制器故障

04 Controller Power Supply Failed

04 控制器电源故障

05 Controller Fan Failed

05 控制器风扇故障

06 Controller Temperature Alert

06 控制器温度警示

07 Controller UPS AC Power Loss

07 控制器 UPS 交流电源断电

08 Controller Initialization Complete

08 控制器初始化完成

09 Controller Power Supply Back Online

09 控制器电源恢复联机

0A Controller Fan Back Online

0A 控制器风扇恢复联机

0B Controller Temperature Normal

0B 控制器温度正常

DB Controller UPS AC Power Back On

0C 控制器 UPS 交流电源重新供电
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Error 字段：Sun StorEdge Drive Side Event

表 G-29 Sun StorEdge Drive Side Event Errors

Error 字段 说明

01 Drive Channel Select Timeout

01 驱动器信道选择超时

02 Drive Channel SCSI Bus Error

02 驱动器信道 SCSI 总线错误

03 Drive Channel Unexpected Disconnect

03 驱动器信道意外断开

04 Drive Channel Negotiation Error

04 驱动器信道协商错误

05 Drive Channel Target Timed Out

05 驱动器信道目标已超时

06 Drive Channel Parity Error

06 驱动器信道奇偶校验错误

07 Drive Channel Data Under Or Overrun

07 驱动器信道数据不足或超限

08 Drive Channel Undefined Error

08 驱动器信道未定义错误

09 Drive Channel SCSI Bus Reset Issued

09 驱动器信道 SCSI 总线重置已发出

0A Drive Channel Not Ready Error

0A 驱动器信道未就绪错误

0B Drive Channel Target HW Error

0B 驱动器信道目标 HW （硬件）错误

0C Drive Channel Target Media Error

0C 驱动器信道目标介质错误

0D Drive Channel Unexpected Unit Attention

0D 驱动器信道意外单元强调

0E Drive Channel Unexpected Sense Data

0E 驱动器信道意外传感数据
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Error 字段：Sun StorEdge Host Side Event 

0F Drive Channel Block Reassign Fail

0F 驱动器信道块重新分配失败

10 Drive Channel Block Reassign Success

10 驱动器信道块重新分配成功

11 Drive Channel SCSI Aborted Command

11 驱动器信道 SCSI 已放弃命令

12 Drive Channel SCSI Channel Fail

12 驱动器信道 SCSI 信道故障

表 G-30 Sun StorEdge Host Side Event Errors

Error 字段 说明

01 Host Channel SCSI Bus Reset

01 主机信道 SCSI 总线重置

02 Host Channel SCSI Bus Device Reset

02 主机信道 SCSI 总线设备重置

03 Host Channel Abort Tag Message

03 主机信道放弃标记消息

04 Host Channel Parity Error

04 主机信道奇偶校验错误

05 Host Channel Reselect Timeout

05 主机信道重新选择超时

表 G-29 Sun StorEdge Drive Side Event Errors （续）

Error 字段 说明
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Error 字段：Sun StorEdge Logical Drive Event 

服务器管理 / 监控事件错误

表 G-31 Sun StorEdge Logical Drive Event Errors

Error 字段 说明

01 Logical Drive SCSI Drive Fail

01 逻辑驱动器 SCSI 驱动器故障

02 Logical Drive Initialization Fail

02 逻辑驱动器初始化失败

03 Logical Drive Rebuild Fail

03 逻辑驱动器重建失败

04 Logical Drive Initialization Commenced

04 逻辑驱动器初始化已开始

05 Logical Drive Initialization Completed

05 逻辑驱动器初始化已完成

06 Logical Drive Rebuild Commenced

06 逻辑驱动器重建已开始

07 Logical Drive Rebuild Completed

07 逻辑驱动器重建已完成

表 G-32 服务器管理 / 监控事件错误 

Error 字段 说明

01 Server to Manage/Monitor has Sun StorEdge changed.

01 要管理 / 监控的服务器促使 Sun StorEdge 发生了变化。
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错误和状态消息    
许多错误和状态消息自身已作出解释。表 G-33 说明了消息中使用的术语。表 G-34 列出
了错误 / 状态消息。 

表 G-33 替代值 （第 1 张，共 2 张）

值 说明

Channel Card channel number indicating a SCSI channel. A value of 1 
indicates the first channel.

信道 卡的信道号，表示 SCSI 信道。值 1 指第一个信道。

Fan Fan number.

风扇 风扇号。

Enclosure Enclosure number.

机箱 机箱号。

LogicalArray Logical array number.

LogicalArray 逻辑阵列号。

LogicalDrive Logical Drive number.

LogicalDrive 逻辑驱动器号码。

Lun LUN number.

Lun LUN 号码。

Name A text name.

名称 文本名称。

Power Power supply number.

电源 电源号。

Slot Slot number.

插槽 插槽号。

State State of a logical array or a device or an enclosure in text. The 
values are: Critical, Online, Offline, Critical Rebuild, Non Existent, 
Low Battery, Normal

状况 以文字表示的逻辑阵列、设备或机箱的状况。其值为：Critical、
Online、 Offline、 Critical Rebuild、 Non Existent、 Low Battery、
Normal

Target A target or SCSI ID number. 
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目标 SCSI ID 的目标。 

Temperature The temperature in centigrade.

温度 以百分度表示的温度。

表 G-34  错误 / 状态消息

错误和状态消息

A tape has been left in the autoloader by a previous hardware fault. Insert an empty 
magazine to clear the fault. If the fault does not clear, turn the autoloader off and then on 
again. If the problem persists, call the tape drive supplier helpline.

上一次的硬件故障将磁带留在了自动加载器中。请插入空的介质盒以清除故障。如果没有清除

故障，请将自动加载器关闭然后重新开启。如果问题仍存在，请与磁带供应商帮助热线联系。

A user named ssconfig must be created for configuring SUNWsscs Diag Reporter.

必须创建一个名为 ssconfig 的用户才能对 SUNWsscs Diag Reporter 进行配置。

Abort/Clear-Queue/Abort-Tag Message (SCSI Channel %d, SCSI ID %d, Target Lun %d). 
Possible failure of I/O module, cable, controller, or HBA.

Abort/Clear-Queue/Abort-Tag 消息 （SCSI 信道 %d, SCSI ID %d，目标 Lun %d）。 
I/O 模块、电缆、控制器或 HBA 可能发生了故障。

Access denied for one or more servers. Log in as an ssconfig user, and then try the 
operation again.

对一台或多台服务器的访问遭到拒绝。作为 ssconfig 用户登录，然后再次尝试该操作。

Active trap events is empty.

活动的陷阱事件是空的。

Add SCSI Drive into Logical Drive information.

将 SCSI 驱动器添加到逻辑驱动器信息。

Agent Name is empty.

代理名称是空的。

An error occurred while getting data from the server.

从服务器获取数据时出错。

An existing configuration for this package is found. Do you want to restore it?

找到了该软件包的一个现有配置。是否要将其进行恢复？

An HBA card with this WWN already exists.

表 G-33 替代值 （第 2 张，共 2 张）

值 说明
254 Sun StorEdge 3000 系列 Configuration Service 1.2 用户指南 • 2003 年 4 月



WWN 与此同名的 HBA 卡已存在。

Another instance of this program is already running!

该程序的另一实例已在运行！

Are you sure you want to continue?

确实要继续吗？

Are you sure you want to continue?

确实要继续吗？

Are you sure you want to delete the log file?

是否删除日志文件？

Are you sure you want to delete the log file?

是否删除日志文件？

Are you sure you want to overwrite the file?

是否覆写该文件？

Are you sure you want to rebuild the drive?

是否重建驱动器？

Array Admin in Progress.

正在进行阵列管理。

At least one email address needs to be configured.

至少需要配置一个电子邮件地址。

Attempted to load a cartridge type, not supported by this drive. The cartridge has been 
automatically ejected. Attempted to load an unsupported tape format.

本驱动器不支持试图装入的盒式磁带类型。已自动将盒式磁带弹出。试图装入一种不支持的磁

带格式。

Attempted to write to a write-protected cartridge. Remove the write-protection or use 
another tape.

试图写入带有写保护的盒式磁带。请去掉写保护或者使用另一盒磁带。

Audible alarm has an unknown status

音频警报的状态未知。

Audible alarm has been triggered.

已触发音频警报。

Audible alarm has been turned off.

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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已关闭音频警报。

Background check or rebuild operation in progress.

正在进行后台检查或重建操作。

Background initialization in progress.

正在进行后台初始化。

Background parity check in progress.

正在进行后台奇偶校验。

Background rebuild operation in progress.

正在进行后台重建操作。

Background rebuild/check has been successfully terminated by abort command.

放弃命令已成功停止了后台重建 / 检查操作。

Background rebuild/check has failed. Cause unknown.
See additional messages.

后台重建 / 检查操作已失败。原因未知。

请参见其他消息。

Background rebuild/check has failed. Possible device failure.
See additional messages.

后台重建 / 检查操作已失败。可能是由于设备故障。

请参见其他消息。

Background rebuild/check has failed. Possible system drive failure.

后台重建 / 检查操作已失败。可能是由于系统驱动器故障。

Before starting to use SUNWsscsConsole, run /opt/SUNWsscs/sscsconsole/config_sscon 
to input the pathanme of the default Web browser to access HTML help files.

在开始使用 SUNWsscsConsole 之前，请先运行 
/opt/SUNWsscs/sscsconsole/config_sscon，以输入默认 Web 浏览器的的路径，以便访问 
HTML 帮助文件。

Begin downloading firmware to devices. Do you want to continue?

开始将固件下载到设备。要继续吗？

Block Reassignment Failure (Ch:%d,Id:%d). Defective drive. Replace.

块重新分配失败 (Ch:%d,Id:%d)。驱动器有缺陷。须进行更换。

Block Reassignment Succeeded( Ch:%d,Id:%d.) Informational message. Drive might be 
failing.

块重新分配重成功 (Ch:%d,Id:%d)。信息性消息。驱动器可能会出现故障。

表 G-34  错误 / 状态消息 （续）
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Cannot find the Java Runtime Environment $JRE_MAJOR.$JRE_MINOR or above! 
SUNWsscs Console needs JRE 1.2 or above to run. The Console will try to find it in 
/usr/java, /usr/jre, /usr/local/java, or /usr/local/jre. If you installed the JRE in a 
directory other than one mentioned above, make a link.

无法找到 Java 运行时环境 $JRE_MAJOR.$JRE_MINOR 或更高版本。 SUNWsscs Console 需
要 JRE 1.2 或更高版本才能运行。 Console 将试图在 /usr/java、 /usr/jre、 /usr/local/java 
或 /usr/local/jre 中进行寻找。如果是在上述目录以外的某个目录中安装了 JRE，则须进行
链接。

Cannot get available LUN to assign this parition.

无法为分配该分区获得一个可用的 LUN。

Cannot get configuration from controller. The operation is canceled.

无法从控制器获得配置。操作已被取消

Cannot get SAFTE device status!

无法取得 SAFTE 设备状态！

Changes made to Optimization will NOT take effect until all the logical drives are deleted 
and then the controller is RESET.

只有在检测到所有的逻辑驱动器并重置控制器后，对 Optimization 进行的更改才能生效。

Changes made to this setting will NOT take effect until the controller is RESET. Prior to 
resetting the controller, the operation may not proceed normally. Do you want to RESET 
controller?

只有重置控制器后对这一设置进行的更改才能生效。在重置控制器之前，可能无法正常继续操
作。是否要重置控制器？

Click View to select one file.

单击 View 以选择一个文件。

Collect mail canceled by user.

收集邮件操作被用户取消。

Completed Dynamic Growth.

已完成动态增长。

Configuration information saved successfully!

配置信息保存成功 !

Connect and Login command error

连接和登录命令错误

Contact Fax number format is wrong.

联系人传真号码格式错误。

表 G-34  错误 / 状态消息 （续）
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Contact Name is empty

联系人姓名是空的。

Contact Phone number format is wrong.

联系人电话号码格式错误。

Continuing Dynamic Growth － Parity Check Phase Completed.

继续动态增长 － 奇偶校验阶段已完成。

Continuing Dynamic Growth － Rebuild Phase Completed.

继续动态增长 － 重建阶段已完成。

Controller Event, Controller Init Complete. Controller has been rebooted. Informational 
message.

控制器事件，控制器初始化已完成。控制器已被重新引导。信息性消息。

Controller Event, Controller Reset.

控制器事件，控制器重置。

Controller Event, DRAM Parity Error. Likely controller error. If error persists, replace 
defective controller.

控制器事件， DRAM 奇偶效验错误。可能是由于控制器错误。如果错误继续存在，则请更换

缺陷控制器。

Controller Event, Fan Back On-line. Informational message.

控制器事件，风扇恢复联机。信息性消息。

Controller Event, Fan Failure Detected. Fan is integrated with power supply. Replace power 
supply. Check LED indicators to identify supply.

控制器事件，检测到风扇故障。风扇与电源集成在一起。更换电源。检查 LED 指示灯，看是
否有电。

Controller Event, Power Supply Back On-line. Informational message.

控制器事件，电源恢复联机。信息性消息。

Controller Event, Power Supply Failure Detected. Replace power supply. Check LED 
indicators to identify supply.

控制器事件，检测到电源故障。更换电源。检查 LED 指示灯，看是否有电。

Controller Event, Redundant Controller Failure Detected. Likely controller error. If error 
persists, replace defective controller.

控制器事件，检测到冗余控制器故障。可能是由于控制器错误。如果错误继续存在，则请更换

缺陷控制器。

Controller Event, SDRAM Error. Likely controller error. If error persists, replace defective 
controller.

表 G-34  错误 / 状态消息 （续）
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控制器事件， SDRAM 错误。可能是由于控制器错误。如果错误继续存在，则请更换缺陷控
制器。

Controller Event, Temperature Alert. Check room temperature, clogged or restricted 
airflow. Correct as necessary.

控制器事件，温度警示。检查室内温度，看空气流通是否受到阻挡或限制。进行必要的更正。

Controller Event, Temperature Back to Normal. Informational message.

控制器事件，温度恢复正常。信息性消息。

Controller Event, UPS AC Power Back On. Informational message.

控制器事件， UPS 交流电源重新供电。信息性消息。

Controller Event, UPS AC Power Loss Detected. Contact technical support.

控制器事件，检测到 UPS 交流电源断电。请与技术支持联系。

Creating Host LUN filter Entry; please waitÖ

正在创建主机 LUN 过滤器项目；请稍候 ...

Creating standard Host LUN mapping; please waitÖ

正在创建标准主机 LUN 映射；请稍候 ...

Customer Fax number format is wrong.

客户传真号码格式错误。

Customer name has been updated.

客户名称已得到更新。

Customer Name is empty.

客户名称是空的。

Customer Phone number format is wrong.

客户电话号码格式错误。

Data is at risk. Media performance of this tape is severely degraded. Copy any data you 
require from this tape. Do not use this tape again. Restart the operation with a different 
tape.

数据有危险。本磁带的介质性能严重降级。须从该磁带复制所有需要的数据。不要再使用该磁

带。请用一盒不同的磁带重新开始操作。

Data Under/Overrun(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random 
drives, possible I/O module or cable failure on drive loop.

数据不足 / 超限 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。如果是随机驱动器，则有可

能是驱动器环路上有 I/O 模块故障或电缆故障。

Decrypt mail canceled by user.

表 G-34  错误 / 状态消息 （续）
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邮件解密操作被用户取消。

Deleted disk successfully!

已成功删除磁盘！

Deleting disk; please waitÖ

正在删除磁盘；请稍候 ...

Deleting Host LUN filter Entry; please waitÖ

正在删除主机 LUN 过滤器项目；请稍候 ...

Deleting standard Host LUN mapping; please waitÖ

正在删除标准主机 LUN 映射；请稍候 ...

Device at [Channel:Target] has been marked DEAD.  

[Channel:Target] （信道 : 目标）处的设备已标为 DEAD （死亡）。  

Device at [Channel:Target] has failed the self-reliability test. Replace the device.

[Channel:Target] （信道 : 目标）处的设备自我可靠性测试失败。须更换设备。

Device information failed.

设备信息失败。

Device is being automatically replaced by device [Channel:Target].

设备正自动由 [Channel:Target] （信道 : 目标）设备替换。

Device will NOT be automatically replaced.

将不自动替换设备。

Disk at [Channel:Target] has failed. Replace the device.

[Channel:Target] （信道 : 目标）处的磁盘已发生故障。须更换设备。

Disk at [Channel:Target] is back online.

[Channel:Target] （信道 : 目标）处的磁盘已恢复联机。

Disk information is not available.

磁盘信息不可用。

Do you want to download firmware to the controller?

要将固件下载到控制器吗？

Do you want to download firmware with boot recrod to the controller?

要将没有引导记录的固件下载到控制器吗？

Do you want to save the current event log file?

表 G-34  错误 / 状态消息 （续）
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要保存当前的事件日志文件吗 ?

Do you want to set up the mail server?

要设置邮件服务器吗？

Door lock has an unknown status.

门锁处于未知状态。

Door locked.

门已锁住。

Door unlocked.

门已开锁。

Download Firmware with Boot Record.

下载带有引导记录的固件。

Downloading Firmware to the devices

正在将固件下载到设备

Downloading Firmware to the RAID Controller.

正在将固件下载到 RAID 控制器。

Drive SCSI Ch:%d Check drive seating, cables, and I/O module. Replace as required. 
Redundant controllers failed to bind.

驱动器 SCSI Ch:%d 请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。冗余控制器没

能绑定。

Drive SCSI Ch:%d; Id:%d Likely poorly seated or defective drive. If random drives, possible 
I/O module or cable failure.

驱动器 SCSI Ch:%d 驱动器可能安装不当或有缺陷。如果是随机驱动器，则有可能是有 I/O 模
块故障或电缆故障。

Dynamic Growth Add Capacity Failed.

Dynamic Growth Add Capacity （动态增长添加容量）失败。

Dynamic Growth Check Consistency Failed.

Dynamic Growth Check Consistency （动态增长检查一致性）失败。

Dynamic Growth Close Transport Failed.

Dynamic Growth Close Transport （动态增长关闭传输）失败。

Dynamic Growth Disable Controller failed.

Dynamic Growth Disable Controller （动态增长禁用控制器）失败。

Dynamic Growth has completed on logical drive LogicalDrive.

表 G-34  错误 / 状态消息 （续）
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已在逻辑驱动器 LogicalDrive 上完成动态增长。

Dynamic Growth has started on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上开始动态增长。

Dynamic Growth Kill Partner Failed.

Dynamic Growth Kill Partner （动态增长终止伙伴）失败。

Dynamic Growth Partner Status Failed.

Dynamic Growth Partner Status （动态增长伙伴状态）失败。

Dynamic Growth Rebuild Failed.

动态增长重建失败。

Email address format is wrong.

电子邮件地址格式错误。

Enclosure #Enclosure state change: Name

机箱 #Enclosure 状况更改：名称

Enclosure #Enclosure, Cache backup battery has changed from State state to State state.

机箱 #Enclosure，高速缓存备用电池已从 State 状况变为 State 状况。

Enclosure #Enclosure, Fan #Fan has changed from a State state to a State state.

机箱 #Enclosure，风扇 #Fan 已从 State 状况变为 State 状况。

Enclosure #Enclosure, Power supply #Power has changed from a State state to a State state.

机箱 #Enclosure，电源 #Power 已从 State 状况变为  State 状况。

Enclosure #Enclosure, temperature threshold has changed from a State state to a State state.

机箱 #Enclosure，温度门限已从 State 状况变为 State 状况。

Engaging firmware; a controller reset is not necessary.

使用固件；不必进行控制器重置。

Enter a Contact Name.

请输入一个联系人名称。

Enter a Customer Name.

请输入一个客户名称。

Enter a Location.

请输入一个位置。

Enter a mail address.

表 G-34  错误 / 状态消息 （续）
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请输入一个电子邮件地址。

Enter a System ID.

请输入一个系统 ID。

Enter a valid gateway address.

请输入一个有效的网关地址。

Enter a valid IP address.

请输入一个有效的 IP 地址。

Enter a valid network mask.

请输入一个有效的网络掩码。

Enter SMTP server information

请输入 SMTP 服务器信息。

Enter the login password.

请输入登录密码。

Enter the ssconfig user password to login

请输入 ssconfig 用户密码以登录

Error in writing file, please try later!

写文件时出现错误，请以后再试！

Error occurred. Reset the config file.

出现错误。请重置配置文件。

Error on RAIDFlex port inquiry.

进行 RAIDFlex 端口查询出现错误。

Expand Logical Drive information.

扩展逻辑驱动器信息。

Failed primary controller has been removed.

故障主控制器已被卸下。

Failed secondary controller has been removed.

故障辅助控制器已被卸下。

Fan #Fan has an unknown status.

风扇 #Fan 处于未知状态。

Fan #Fan is malfunctioning.

表 G-34  错误 / 状态消息 （续）
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风扇 #Fan 有故障。

Fan #Fan is not present in the system.

系统中没有风扇 #Fan 。

Fan #Fan is operational.

风扇 #Fan 操作正常。

File I/O error. Configuration could not be saved!

文件 I/O 错误。无法保存配置！

Firmware downloaded to Safte device (Ch:%d,Id:%d) failed.

固件已被成功地下载到 Safte 设备 (Ch:%d,Id:%d)。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) failed.

下载到 SCSI 驱动器 (Ch:%d,Id:%d) 的固件已失败。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) successfully.

固件已被成功地下载到 SCSI 驱动器 (Ch:%d,Id:%d)。

First select one Logical Drive!

请先选择一个逻辑驱动器！

First select one physical device.

请先选择一个物理驱动器。

First select one RAID controller.

请先选择一个 RAID 控制器。

For NRAID Logical Drive 'Expand'/'Add Drive'/'Copy and Replace' function is disabled.

对于 RAID1 逻辑驱动器， 'Add Drive'/'Copy and Replace' 功能已被禁用。

For RAID1 Logical Drive 'Add Drive'/'Copy and Replace' function is disabled.

对于 RAID1 逻辑驱动器， 'Add Drive'/'Copy and Replace' 功能已被禁用。

Forward mail canceled bu user

Forward mail canceled bu user.

Getting Agent Options failed!

Getting Agent Options （获取代理选项）已失败！

Getting Controller Parameters failed!

Getting Controller Parameters （获取控制器参数）已失败！

Getting Host LUN Assignments failed! Please try again

表 G-34  错误 / 状态消息 （续）
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Getting Host LUN Assignments （获取主机 LUN 分配）已失败！请重试。

Getting the configuration failed!

获取配置失败！

Gross Error on SCSI Bus Detected (Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

在 SCSI 总线上检测到总体错误 （逻辑驱动器 LogicalDrive, 信道
:Channel,Id:Target,Lun:Lun）。

Gross Phase/Signal Error Detected. Check drive seating, cables, and I/O module. Replace 
as required. Redundant controllers failed to bind.

检测到总体相位 / 信号错误。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。冗
余控制器没能绑定。

Group Name cannot be empty

组名称不能为空。

Host LUN filter Entry created successfully!

主机 LUN 过滤器项目创建成功！

Host LUN filter Entry deleted successfully!

主机 LUN 过滤器项目删除成功！

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is created.

主机 LUN 过滤器项目 (StorEdge SN#%d LD %d 分区 %d) 已被创建。

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is deleted.

主机 LUN 过滤器项目 (StorEdge SN#%d LD %d 分区 %d) 已被删除。

If file access is not properly coordinated when assigned to multiple hosts, data corruption 
and access contentions may occur.

在分配给多个主机时没有协调好文件访问，则可能会发生数据破坏和访问争用。

If Minimum interval is \ì0\î or \ì*\î, then Content must be \ 揈 vent\î

如果最小间隔为 \ì0\î 或 \ì*\ 敚敚敚敚敚敚敚 « \ 揈 vent\î

If the firnware download progress is interrupted the controllers/devices may become 
unusable.

如果固件下载进程被中断，则可能会导致控制器 / 设备不可用。

Initialization operations have completed.

初始化操作已完成。 

Initializaton, rebuild, expand, or add SCSI drive activities are in progress. Try again later.

正在初始化、重建、扩展或添加 SCSI 驱动器。请稍候重试。
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Inserted failed primary controller.

插入了故障主控制器。

Inserted failed secondary controller.

插入了故障辅助控制器。

Install JRE 1.2.2, 1.3, 04 1.4 before installing the console.

在安装控制台之前须安装 JRE 1.2.2, 1.3, 04 1.4。

Invalid server IP address!

服务器 IP 地址无效！

IP Address format error (must be xxx.xxx.xxx.xxx and 0 &amp;lt; xxx &amp;lt;255) !

IP 地址格式错误 （必须为 xxx.xxx.xxx.xxx 和 0 &amp;lt; xxx &amp;lt;255）！

IP Address is duplicated!

IP 地址重复！

IP Address is empty.

IP 地址是空的。

Issue Reset to the controller.

请向控制器发出重置命令。

Location is empty.

位置是空的。

Log in as \"ssconfig\" user and try the operation again.

作为 \"ssconfig\" 用户登录，然后再次尝试该操作。

Logical array LogicalArray Dynamic Growth has completed.

逻辑阵列 LogicalArray 动态增长已经完成。

Logical array LogicalArray Dynamic Growth has started.

逻辑阵列 LogicalArray 动态增长已经开始。

Logical array LogicalArray has changed from a State state to a State state.

逻辑阵列 LogicalArray  已从 State 状况变为 State 状况。

Logical array LogicalArray initialization has completed.

逻辑阵列 LogicalArray 初始化已经完成。

Logical array LogicalArray initialization has started.

逻辑阵列 LogicalArray 初始化已经开始。
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Logical array LogicalArray parity check has completed.

逻辑阵列 LogicalArray 奇偶校验已经完成。

Logical array LogicalArray parity check has started.

逻辑阵列 LogicalArray 奇偶校验已经开始。

Logical array LogicalArray scheduled parity check has completed.

逻辑阵列 LogicalArray 调度的奇偶校验已经完成。

Logical array LogicalArray scheduled parity check has started.

逻辑阵列 LogicalArray 调度的奇偶校验已经开始。

Logical Drive %d, a SCSI Drive Failed. Replace defective drive

逻辑驱动器 %d， SCSI 驱动器有故障。请更换有缺陷的驱动器。

Logical Drive LogicalDrive, Parity Check Failed. Non-recoverable error. Likely drive failure 
or a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.
Note: If you manually aborted Parity Check, there is no risk of data corruption. There is no need to 
contact technical support.

逻辑驱动器 LogicalDrive，奇偶校验失败。不可恢复的错误。可能是因为驱动器故障或者带区
上有不可恢复的错误。请在逻辑驱动器上运行奇偶校验。请与技术支持联系。 
注意：如果手动中止 Parity Check （奇偶校验），不会有数据破坏的危险。不必与技术支持联
系。

Logical Drive ID %d, Rebuild Completed. Informational message. Replace defective drive 
with new drive.

逻辑驱动器 ID %d，重建已完成。信息性消息。请用新驱动器更换有缺陷的驱动器。

Logical Drive ID LogicalDrive, Add drive paused. Informational message.

Logical Drive ID LogicalDrive, Add drive paused. Informational message.

逻辑驱动器 ID LogicalDrive，添加 SCSI 驱动器已完成。信息性消息。

Logical Drive ID LogicalDrive, Add SCSI Drv Completed. Informational message.

逻辑驱动器 ID LogicalDrive，开始奇偶校验。信息性消息。

Logical Drive ID LogicalDrive, Starting Rebuild. Informational message.

逻辑驱动器 ID LogicalDrive，开始重建。信息性消息。

Logical Drive ID LogicalDrive, Add SCSI Drv Failed. Non-recoverable error. Likely drive 
failure or a non-recoverable error on stripe. Run parity check on the logical drive. Contact 
technical support.

逻辑驱动器 ID LogicalDrive，添加 SCSI 驱动器失败。不可恢复的错误。可能是因为驱动器故
障或者带区上有不可恢复的错误。请在逻辑驱动器上运行奇偶校验。请与技术支持联系。
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Logical Drive ID LogicalDrive, Clone Completed. Informational message.

逻辑驱动器 ID LogicalDrive，克隆已完成。信息性消息。

Logical Drive ID LogicalDrive, Clone Failed. Non-recoverable error Likely drive failure or a 
non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

逻辑驱动器 ID LogicalDrive，克隆失败。不可恢复的错误。可能是因为驱动器故障或者带区上

有不可恢复的错误。请在逻辑驱动器上运行奇偶校验。请与技术支持联系。

Logical Drive ID LogicalDrive, Expand Completed. Informational message.

逻辑驱动器 ID LogicalDrive，扩展已完成。信息性消息。

Logical Drive ID LogicalDrive, Expand Failed. Non-recoverable error. Likely drive failure or 
a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

逻辑驱动器 ID LogicalDrive，扩展失败。不可恢复的错误。可能是因为驱动器故障或者带区上
有不可恢复的错误。请在逻辑驱动器上运行奇偶校验。请与技术支持联系。

Logical Drive ID LogicalDrive, Initialization Completed. Informational message.

逻辑驱动器 ID LogicalDrive，初始化已完成。信息性消息。

Logical Drive ID LogicalDrive, Initialization Failed. Informational message. Possible 
defective drive or slot. User might have aborted operation.

逻辑驱动器 ID LogicalDrive，初始化失败。信息性消息。驱动器或插槽可能有缺陷。用户可能
已放弃操作。

Logical Drive ID LogicalDrive, Parity Check Completed. Informational message.

逻辑驱动器 ID LogicalDrive，奇偶校验已完成。信息性消息。

Logical Drive ID LogicalDrive, Rebuild Failed. Informational message. Possible defective 
drive or slot. User might have aborted operation.

逻辑驱动器 ID LogicalDrive，重建失败。信息性消息。驱动器或插槽可能有缺陷。用户可能已
放弃操作。

Logical Drive ID LogicalDrive, Starting Add SCSI Drive Operation. Informational message.

逻辑驱动器 ID LogicalDrive，开始添加 SCSI 驱动器操作。信息性消息。

Logical Drive ID LogicalDrive, Starting Clone. Informational message.

逻辑驱动器 ID LogicalDrive，开始克隆。信息性消息。

Logical Drive ID LogicalDrive, Starting Expansion. Informational message.

逻辑驱动器 ID LogicalDrive，开始扩展。信息性消息。

Logical Drive ID LogicalDrive, Starting Initialization. Informational message.

逻辑驱动器 ID LogicalDrive，开始初始化。信息性消息。
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逻辑驱动器 ID LogicalDrive，开始奇偶校验。信息性消息。

Logical Drive LogicalDrive has changed from a State state to a State state.

逻辑驱动器 LogicalDrive 已从 State 状况变为 State 状况。

Logical Volume Components List. Total disks in this Logical Volume=

逻辑卷组件列表。该逻辑卷中的总磁盘数 =

Login successful

登录成功

Login unsuccessful

登录不成功

Logout command error.

注销命令错误。

Mail information is empty

邮件信息是空的。

Memory Allocation Error.

内存分配出错。

Minimum interval between emails must be one of the following formats: \"*\"   \"0\"  \
"nn\"   \"nn:mm\"

邮件之间的最小间隔必须是下列格式之一：\"*\"   \"0\"  \"nn\"   \"nn:mm\"

Minimum interval can 抰 meet Content value.

最小间隔无法满足内容值。

Minimum interval format error.

最小间隔格式错误。

Minimum interval format is HH[:MM].

最小间隔格式为 HH[:MM]。

Minimum interval is empty.

最小间隔是空的。

Multiple IP assignment mechanisms are not supported. Select only one mechanism.

不支持多重 IP 分配机制。请只选择一种机制。

Mute controller beeper failure.

控制器蜂鸣器静音故障。

Mute controller beeper.
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控制器蜂鸣器静音。

Negotiating with the secondary controller.

正在与辅助控制器协商。

Negotiation completed successfully, waiting for next ping.

协商成功完成，正在等待下一次 ping。

Negotiation Error(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

协商错误 (Ch:%d,id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

New parity check schedule has been created.

已创建新的奇偶校验调度。

No admin progress exists.

不存在任何管理过程。

No Admin progress was found. All activity should be complete!

未找到任何管理过程。应当完成所有的活动！

No array administration activity in progress!

没有任何阵列管理活动正在进行！

No more events to report.

没有更多要报告的事件。

Not Ready Error Reported by Target(Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

目标报告尚未准备就绪错误 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。驱动器插槽可能
有缺陷。

Only the last partition of a logical drive can be deleted.

仅可以删除逻辑驱动器的最后一个分区。

Operation completed successfully.

操作已成功完成。

Operation failed.

操作失败。

Operation in progress.

操作正在进行中。

Operation on one of the servers failed
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在其中一台服务器上的操作失败。

Out of the scope!

在范围之外！

Parity check could not be started on logical drive LogicalDrive.

无法在逻辑驱动器 LogicalDrive 上开始奇偶校验。

Parity check has completed on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上完成奇偶校验。

Parity check has started on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上开始奇偶校验。

Parity check or Rebuild has completed on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上完成奇偶校验或重建。

Parity check schedule has been removed.

已删除奇偶校验调度。

Parity check schedule has been updated.

已更新奇偶校验调度。

Parity Error(Ch:%d,Id:%d ). Likely poorly seated or defective drive. If random drives, 
possible I/O module or cable failure.

奇偶校验错误 (Ch:%d,id:%d)。服务器可能安装不当或有缺陷。如果是随机驱动器，则有可能

是有 I/O 模块故障或电缆故障。

Parity Error(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O module, 
cable, controller, or HBA

奇偶校验错误 (SCSI 信道 %d, SCSI ID %d, 目标 Lun %d)。 I/O 模块、电缆、控制器或 HBA 
可能发生了故障。

Partition 0 cannot be deleted.

无法删除分区 0。

Partition table is full, 'Expand Logical Drive'/'Add Drive' function is disabled.

分区表已满， 'Expand Logical Drive'/'Add Drive' （扩展逻辑驱动器 / 添加驱动器）功能已

被禁用。

Password error!

密码错误！

Password is empty

密码是空的。
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Physical drive Channel:Target rebuild has completed.

物理驱动器 Channel:Target 重建已完成。

Physical drive Channel:Target rebuild has started.

物理驱动器 Channel:Target 重建已开始。

Poll interval limited to 600 seconds (10 minutes). Specify a lower value.

轮询间隔限于 600 秒 （10 分）。请指定一个较小值。

Port is invalid (port must be between 0 and 65535)

端口无效 （端口必须介于 0 和 65535 之间）

Port is invalid (port must be between 1270 and 1273)

端口无效 （端口必须介于 1270 和 1273 之间）

Power supply #Power has an unknown status.

电源 #Power 状态未知。

Power supply #Power is malfunctioning and has been switched off.

电源 #Power 有故障，已被关闭。

Power supply #Power is malfunctioning or disabled.

电源 #Power 有故障或已被禁用。

Power supply #Power is not present in the system.

系统中不存在电源 #Power。

Power supply #Power is operational but disabled.

电源 #Power 操作正常但已被禁用。

Power supply #Power is operational.

电源 #Power 操作正常。

Power supply #Power is present in the system.

系统中存在电源 #Power。

Primary controller failed. Secondary controller is servicing I/O.

主控制器有故障。辅助控制器正为 I/O 提供服务。

Primary controller has stopped negotiation because of insufficient memory.

因为内存不够，主控制器已停止协商。

Probe Agent command error!

Probe Agent （探测代理）命令错误！
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Progress not available

进度不可用

Raid Controller is back online.

RAID 控制器已恢复联机。

Read config file error

读取配置文件时出错。

Rebuild or check operations have completed with error － Drive Failure.

重建或检查操作已完成，但有错误 － 驱动器故障。

Rebuild or check operations have completed with error － Job Terminated.

重建或检查操作已完成，但有错误 － 作业已被终止。

Rebuild or check operations have completed with error － System Drive Failure.

重建或检查操作已完成，但有错误 － 系统驱动器故障。

Rebuild or check operations have completed with error － Unknown causes.

重建或检查操作已完成，但有错误 － 原因未知。

Rebuild or check operations have completed.

重建或检查操作已完成。

Received command to establish redundancy with secondary controller.

已收到用辅助控制器重建冗余的命令。

Received command to return control to primary controller.

已收到恢复主控制器控制的命令。

Received first ping after successful negotiation.

已收到协商成功后的第一次 ping。

Received the first ping from secondary controller.

已收到来自辅助控制器的第一次 ping。

Redundant Array State Change: Controllers back in redundancy mode!

冗余阵列状况变化：控制器已回到冗余模式！

Redundant Array State Change: Primary controller failed! Replace the Primary Controller.

冗余阵列状况变化：主控制器有故障！请更换主控制器。

Redundant Array State Change: Secondary controller failed! Replace the Secondary 
Controller.

冗余阵列状况变化：辅助控制器有故障！请更换辅助控制器。
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Remove the package @PKG_NAME@ and then try to install this package

删除软件包 @PKG_NAME@，然后尝试安装该软件包。

Removed a failed primary controller.

已卸下一个故障主控制器。

Removed a failed secondary controller.

已卸下一个故障辅助控制器。

Reselect Timeout(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O 
module, cable, controller, or HBA.

重新选择超时 (SCSI 信道 %d, SCSI ID %d, 目标 Lun %d)。 I/O 模块、电缆、控制器或 HBA 
可能发生了故障。

Restoring control to primary controller.

恢复主控制器的控制。

Retry the configuration operation after the update is complete.

在完成更新后重试配置操作。

SAF-TE card Channel:Target firmware has been updated.

SAF-TE 卡 Channel:Target 固件已被更新。

SAF-TE card Channel:Target global status has been updated.

SAF-TE 卡 Channel:Target 全局状态已被更新。

SAF-TE card Channel:Target slot perform status has been updated.

SAF-TE 卡 Channel:Target 插槽性能状态已被更新。

SAF-TE card Channel:Target slot status has been updated.

SAF-TE 卡 Channel:Target 插槽状态已被更新。

Save a Copy in server.

在服务器中保存副本。

Saving configuration information; please waitÖ

正在保存配置信息；请稍候 ...

Scan SCSI Drive information.

扫描 SCSI 驱动器信息。

Scan SCSI Drive Successful. Informational message.

扫描 SCSI 驱动器已成功。信息性消息。

Scheduled parity check could not be started on logical drive LogicalDrive.
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无法在逻辑驱动器 LogicalDrive 上开始调度的奇偶校验。

Scheduled parity check has completed on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验。

Scheduled parity check has started on logical drive LogicalDrive.

已在逻辑驱动器 LogicalDrive 上开始调度的奇偶校验。

Scheduled parity check on logical drive LogicalDrive completed with error － Drive Failure.

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验，但有错误 － 驱动器故障。

Scheduled parity check on logical drive LogicalDrive completed with error － Job 
Terminated.

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验，但有错误 － 作业已被终止。

Scheduled parity check on logical drive LogicalDrive completed with error － System Drive 
Failure.

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验，但有错误 － 系统驱动器故障。

Scheduled parity check on logical drive LogicalDrive completed with error － Unknown 
causes.

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验，但有错误 － 原因未知。

Scheduled parity check skipped to next schedule due to incompletion of previous check.

由于没有完成前一次校验，调度的奇偶校验已跳到下一次调度。

SCSI Aborted Command(Ch:%d,Id:%d). Informational message. Drive might be failing or 
defective slot.

SCSI 已放弃命令 (Ch:%d,Id:%d)。信息性消息。驱动器可能有故障或插槽有缺陷。

SCSI Bus Device Reset(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of 
I/O module, cable, or HBA.

SCSI 总线设备重置 (SCSI 信道 %d, SCSI ID %d, 目标 Lun %d)。I/O 模块、电缆或 HBA 可能
发生了故障。

SCSI Bus Reset Issued(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace 
as required.

已发出 SCSI 总线重置 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行
更换。

SCSI Bus Reset(SCSI Channel %d, SCSI ID %d, Target LUN %d). Possible failure of I/O 
module, cable, or HBA.

SCSI 总线重置 (SCSI 信道 %d, SCSI ID %d, 目标 Lun %d)。I/O 模块、电缆或 HBA 可能发生
了故障。

SCSI Channel Failure － (Ch:%d,Id:%d) Replace defective I/O or drive module.
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SCSI 信道故障 － (Ch:%d,Id:%d) 请更换有缺陷的 I/O 或驱动器模块。

SCSI Channel Failure － Fibre Loop Connection Failure Check drive path. Possible cable or 
module failure.

SCSI 信道故障 － 光纤环路连接故障。请检查驱动器路径。可能有电缆或模块故障。

SCSI Channel Failure － General. Check drive path.

SCSI 信道故障 － 一般。请检查驱动器路径。

SCSI Channel Failure － Redundant Loop/Path Failure. Check drive path. Possible cable or 
module failure.

SCSI 信道故障 － 冗余环路 / 路径故障。请检查驱动器路径。可能有电缆或模块故障。

SCSI Channel Failure(Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

SCSI 信道故障 ( 逻辑驱动器 LogicalDrive, 信道 :Channel,Id:Target,Lun:Lun)。

SCSI Channel Restored － Fibre Loop Connection Restored. Informational message.

已恢复 SCSI 信道 － 已恢复光纤环路连接。信息性消息。

SCSI Channel Restored － Redundant Path Restored. Informational message.

已恢复 SCSI 信道故障 － 已恢复冗余路径。信息性消息。

SCSI Drive Failed. Replace defective drive.

SCSI 驱动器有故障。请更换有缺陷的驱动器。

Secondary controller has failed.

辅助控制器有故障。

Select a Product ID before downloading firmware.

在下载固件之前请选择产品 ID。

Select either AM or PM.

选择 AM 或 PM。

Select only ONE logical drive!

仅可以选择一个逻辑驱动器！

Select only one row to edit it.

仅可以选择一行进行编辑。

Select only one row to remove it.

仅可以选择一行进行删除。

Select the agent before clicking Remove.

在单击 Remove 之前请选择代理。
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Select the agent item before clicking Edit.

在单击 Edit 之前请选择代理项目。

Select the Channel/ID of the drive you want to scan

请选择要扫描的驱动器的信道 /ID。

Select the firmware file before downloading it

选择要下载的固件文件。

Select the Logical Drive(s)

选择逻辑驱动器。

Select the server item before clicking Edit.

在单击 Edit 之前请选择服务器项目。

Select the server item before clicking Remove.

在单击 Remove 之前请选择服务器项目。

Select the Starting Day.

选择起始日期。

Select Timeout(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random drives, 
possible I/O module or cable failure.

选择超时 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。如果是随机驱动器，则有可能是有 
I/O 模块故障或电缆故障。

Server failed the operation due to insufficient memory.

由于内存不够，服务器没能完成操作。

Server Name is empty

服务器名称是空的。

Server Not managed!

服务器未受管理！

Set configuration failed!

设定配置失败。

Slot #Slot has had a device Name.

插槽 #Slot 已有一个设备 Name。

SMART Predictable Failure Detected Ch:%d,Id:%d). Informational message. Drive might be 
failing.

检测到 SMART 可预测故障 (Ch:%d,Id:%d)。信息性消息。驱动器可能会出现故障。
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SMTP From address format is wrong or empty.

SMTP From 地址格式错误或者是空的。

SMTP From address format is wrong.

SMTP From 地址格式错误。

SMTP Server address is empty.

SMTP Server 地址是空的。

Specify how often you want the parity checked.

请指定奇偶校验的频率。

Standard Configuration options provide a group of basic default RAID sets whereby the 
drive size, quantity, and assignments are preconfigured.

标准配置选项提供一组基本的默认 RAID 集，其中驱动器大小、数量和分配已经过预先配置。

Standard Configuration will replace the existing configuration.

标准配置将替换现有的配置。

Standard Host LUN mapping created successfully!

标准主机 LUN 映射创建成功！

Standard Host LUN mapping deleted successfully!

标准主机 LUN 映射删除成功！

Standard maps are available to all connected hosts in certain configurations.

在特定配置中，标准映射可用于所有所连接的主机。

Standby rebuild operation completed with an unknown error.

备用重建操作已完成，但有未知错误。

Standby rebuild operation in progress.

正在进行备用重建操作。

Starting Dynamic Growth.

开始动态增长。

Startup state of the secondary controller.

辅助控制器的启动状况。

Successful negotiation between both controllers.

两个控制器之间协商成功。

Successful startup. Both controllers have entered redundancy modes.

启动成功。两个控制器已进入冗余模式。
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SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run.The Console will try to find it in 
/usr/java, /usr/jre,/usr/local/java, or /usr/local/jre. If you installed the JRE in a 
directory other than one mentioned above, make a link.

SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run.The Console will try to find it in 
/usr/java, /usr/jre,/usr/local/java, or /usr/local/jre. 如果是在上述目录以外的某个目录中
安装了 JRE，则须进行链接。

System ID is empty.

系统 ID 是空的。

Tape operation has stopped because an error occurred while reading or writing data, which 
the drive cannot correct.  

磁带操作已停止，因为在读取或写入数据过程中出现了驱动器无法纠正的错误。  

TapeAlert notification. Device [Channel:Target].  

TapeAlert 通知。设备 [Channel:Target]。  

Target HW Error Reported((Ch:%d,Id:%d). Likely poorly seated or defective drive. Possible 
defective drive slot.

报告目标 HW （硬件）错误 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。驱动器插槽可能

有缺陷。

Target Media Error Reported(Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

报告目标介质错误 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。驱动器插槽可能有缺陷。

Target Timed-out(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

目标超时 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

Temperature Alert. Check room temperature, clogged or restricted airflow. Correct as 
necessary.

温度警示。检查室内温度，看空气流通是否受到阻挡或限制。进行必要的更正。

Temperature Back to Normal. Informational message.

温度恢复正常。信息性消息。

Temperature change from TemperatureC to TemperatureC.

温度从 TemperatureC 变为 TemperatureC。

The changer mechanism is having difficulty communicating with the tape drive. Turn the 
autoloader off then on and restart the operation. If problem persists, call the tape drive 
supplier helpline.

更换器机制与磁带驱动器通信时遇到困难。关闭然后打开自动加载器，重新开始操作。如果问
题仍存在，请与磁带驱动器供应商帮助热线联系。
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The client receives events only when it is running. Are you sure you want to exit?

客户端只会在正在运行时接收事件。确实要退出吗？

The configuration has been updated.

配置已得到更新。

The configuration was successfully updated. If new logical drives were created, the server 
may need to be rebooted.

配置更新成功。如果创建了新的逻辑驱动器，则可能需要重新引导服务器。

The Content of Periodic Trap cannot be \"Event\". Please select another one.

Content of Periodic Trap （周期陷阱的内容）不可是 \"Event\" （事件）。请另行选择。

The Controller devices list changed.

控制器设备列表已更改。

The controller needs to be reset for the new firmware to take effect. Do you want to reset 
the controller?

必须重置控制器，以便新的固件生效。是否要重置控制器？

The controller parameters have been updated.

控制器参数已得到更新。

The current user is ssconfig; you cannot log in again.

当前的用户是 ssconfig ；您无法再次登录。

The device does not belong to the same HBA card. The operations cannot continue.

设备不属于同一 HBA 卡。操作无法继续。

The device resource cannot be locked for exclusive use. Check to see if some applications 
are currently accessing the resource. If so, close those applications and try the operation 
again.

无法将设备资源锁定为独占使用。请检查某些应程序当前是否正在访问资源。如果是这样的

话，请关闭这些应用程序，然后重试操作。

The drive can no longer write data to the tape.

驱动器无法继续向磁带写入数据。

The drive letter (mounted point) cannot be assigned.

无法分配驱动器号 （安装点）。

The encrypt key is empty.

密钥是空的。

The encrypt key you entered includes extra space in the beginning or at the end, which can 
cause encryption errors. Do you want to continue
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您输入的密钥在前面或后面包含多余的空格，这可能会导致加密错误。要继续吗？

The firmware does not support multiple IP assignment mechanisms.

固件不支持多重 IP 分配机制。

The firmware download failed because you have tried to use the incorrect firmware for this 
tape drive. Obtain the correct firmware and try again.

固件下载失败，因为您试图为该磁带驱动器使用不正确的固件。请获取正确的固件，然后重

试。

The IP Address cannot be empty.

IP 地址不得空白。

The last cleaning cartridge used in the tape drive has worn out. Discard the worn out 
cleaning cartridge, wait for the current operation to finish, and then use a new cleaning 
cartridge.

最后在磁带驱动器中使用的清洁磁带已磨损。扔掉磨损的清洁磁带，等待当前的操作结束，然
后使用新的清洁磁带。

The LD# is moved up after you delete the LD, so it may not be consistent with the LD# 
shown in the RS-232 terminal window.

删除逻辑驱动器后 LD# 上移，所以可能与 RS-232 终端窗口上所显示的 LD# 不一致。

The length of the encrypt key must be greater than 8 characters.

密钥的长度必须大于 8 个字符。

The Mail Server field cannot be empty.

Mail Server （邮件服务器）字段不能为空。

The media has exceeded its specified life. The tape cartridge has reached the end of its 
useful life. Copy any data you need to another tape. Discard the old tape.

介质的指定寿命已尽。盒带的使用寿命已尽。须将所有所需要的数据复制到另一盒磁带。扔掉

旧的磁带。

The memory allocation Failed.

内存分配失败。

The mount point (drive letter) cannot be written into file (registry).

无法将安装点 （驱动器号）写入文件 （注册表）。

The operation failed because the autoloader door is open. Clear any obstructions from the 
autoloader door, eject the magazine, and then insert it again. If the fault does not clear, turn 
the autoloader off and then on again.

操作失败，因为自动加载器门已打开。清理自动加载器门旁边的障碍物，弹出介质盒，然后重

新插入。如果没有清除故障，请将自动加载器关闭然后重新开启。
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The operation failed because the tape in the drive has snapped. Discard the old tape. 
Restart the operation with a different tape.

操作失败，因为驱动器中的磁带已被扯断。扔掉旧的磁带。请用一盒不同的磁带重新开始
操作。

The Selected Device list is empty!

Selected Device （选定驱动器）列表是空的！

The server already exists!

服务器已经存在！

The Server Name cannot be empty or only contain any extra spaces

服务器名称不得是空的，也不得仅包含多余空格。

The set configuration Failed.

设定配置失败。

The tape cartridge is not data grade. Any data you backup to the tape is at risk. The drive 
has not been able to read the MRS stripes. Replace the cartridge with a data-grade tape.

盒带不是数据级的。您备份到磁带的所有数据都有危险。驱动器未能读取 MRS 带区。请用一
盒数据级磁带替换这盒磁带。

The tape drive has a hardware fault, which is not read/write related. Turn the tape drive off 
and then on again and restart the operation. If the problem persists, call the tape drive 
supplier helpline.

磁带驱动器有硬件故障，该故障与读写无关。关闭然后打开磁带驱动器，重新开始操作。如果

问题仍存在，请与磁带供应商帮助热线联系。

The tape drive has a hardware fault. Eject the tape or magazine, reset the drive (hold the 
unload button down for 5 seconds), and restart the operation.

磁带驱动器有硬件故障。弹出磁带或介质盒，重置驱动器 （按下卸载按钮，保持 5 秒钟），然

后重新开始操作。

The tape drive has a problem with the SCSI interface. Check the cables and cable 
connections and restart the operation.

磁带驱动器有 SCSI 接口故障。请检查电缆和电缆连接，然后重新开始操作。

The tape drive is due for routine cleaning. Wait for the current operation to finish and then 
use a cleaning cartridge.

应当对磁带驱动器进行例行清洁了。等待当前的操作结束，然后使用清洁磁带。

The tape drive is having problems reading data.No data has been lost, but there has been a 
reduction in the capacity of the tape.

磁带驱动器有读取数据问题。没有丢失任何数据，但磁带容量减少。
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The tape drive needs cleaning. If the operation has stopped, eject the tape and clean the 
drive. If the operation has not stopped, wait for it to finish and then clean the drive.

磁带驱动器需要清洁。如果操作已停止，则弹出磁带并清洁驱动器。如果操作尚未停止，则等
待操作结束，然后清洁驱动器。

The tape in the drive is a cleaning cartridge. If you want to backup or restore, insert a data-
grade tape.

驱动器中的磁带是一盘清洁磁带。如果想要进行备份或恢复，请插入一盘数据级磁带。

The tape is damaged or the drive is faulty. The drive can no longer read data from the tape. 
Call the tape supplier helpline.  

磁带已损坏，或驱动器有故障。驱动器无法继续从磁带读取数据。

请打电话给磁带供应商帮助热线。  

The tape is from a faulty batch or the tape drive is faulty. Use a good tape to test the drive. 
If the problem persists, call the tape drive supplier helpline.

磁带有问题，或驱动器有故障。请使用好磁带来测试驱动器。如果问题仍存在，请与磁带供应
商帮助热线联系。

The tape operation failed. Eject and then reinsert the tape or magazine.

磁带操作失败。弹出然后重新插入磁带或介质盒。

The WWN must be a Hex string that is less than 17 characters.

WWN 必须是一个小于 17 个字符的十六进制字符串。

There are no available disks to configure.

没有可配置的磁盘。

There are no logical drives to manage.

没有可管理的逻辑驱动器。

There are not enough available disks to add a new LD.

没有足够的可用磁盘，无法添加新的逻辑驱动器。

There is a problem with the autoloader mechanism. Loader mechanism has detected a 
hardware fault.

自动加载器机制有问题。加载器机制已检测到一个硬件故障。

There is no spare or replacement drive. Rebuild cannot continue.

没有任何备用或替换用驱动器。无法继续重建。

This Configuration Will Overwrite the Existing Configuration. All Previous Configuration 
Information and Data Will Be Lost.

本配置将覆写现有配置。所有以前的配置信息和数据都将丢失。

This operation will add to the existing configuration.
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此操作将添加到现有配置。

This operation will delete the fibre map.

此操作将删除光纤映射。

This operation will erase any existing configuration and data.

此操作将删除所有的现有配置和数据。

This operation will result in the loss of current controller settings and data on ALL of the 
logical drives. Are you sure you want to restore factory defaults?

该操作将导致所有逻辑驱动器上的现有控制器设置丢失。确实要恢复工厂默认值吗？

This operation will result in the loss of data on ALL of the modified partitions. Do you 
want to continue?

该操作将导致所有已修改分区上的数据丢失。要继续吗？

To find out the java version currently installed, type 搄 ava-versionî

要确定当前安装的 Java 版本，请键入 “java-version”

Trap information has been modified. Do you want to save it?

陷阱信息已被修改。是否保存更改？

Unable to allocate memory for array inquiry. Unable to monitor this array.

无法为阵列查询分配内存。无法监控该阵列。

Unable to determine local host, terminating!

无法确定本地主机，正在终止！

Unable to eject cartridge because the tape drive is in use. Wait until the operation is 
complete before ejecting the cartridge.

因为磁带驱动器正在使用中，无法将介质盒弹出。请等待，直到操作完成，然后再将介质盒

弹出。

Unable to inquire card. Array error.

无法查询卡。阵列错误。

Unable to inquire SAF-TE device. SAF-TE monitoring for this enclosure disabled.

无法查询 SAF-TE 设备。对该机箱的 SAF-TE 监控已被禁用。

Unable to inquire tape device. This device willbe removed.

无法查询磁带设备。将会删除此设备。

Unable to inquire target devices. Device and SAF-TE monitoring disabled.

无法查询目标设备。设备和 SAF-TE 监控已被禁用。

Unable to issue Self-Reliability Query on device at [Channel:Target].
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无法对位于 [Channel:Target] 的设备发出 Self-Reliability Query （自我可靠性查询）。

Unable to open bindings file -or- no bindings present. Check Bindings file.

无法打开绑定文件 － 或不存在任何绑定。请检查绑定文件。

Unable to open I/O transport layer

无法打开 I/O 传输层

Unable to query TapeAlert log data. TapeAlert monitoring disabled for this device.

无法查询 TapeAlert 日志数据。对该设备的 TapeAlert 监控已被禁用。

Unable to read enclosure environmental status.

无法读取机箱环境状态。

Unable to send login info to the server.

无法将登录信息发送到服务器。

Undefined Error(Ch:%d,Id:%d). Contact technical support.

未定义错误 (Ch:%d,id:%d)。请与技术支持联系。

Unexpected Disconnect(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. 
Replace as required.

意外中断 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

Unexpected Sense Data Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

从目标接收到意外的传感数据 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。驱动器插槽可
能有缺陷。

Unexpected Unit Attention Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

从目标接收到意外单元强调 (Ch:%d,Id:%d)。服务器可能安装不当或有缺陷。驱动器插槽可能
有缺陷。

Unknown redundancy state.

未知冗余状况。

UNMAPPED LUN, NOT AVAILABLE TO HOST

未映射 LUN，对主机不可用

Username is empty.

用户名是空的。

Waiting for debounce ping.

正在等待抖动消除 ping。
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Write config file error.

写入配置文件时出错。

Wrong Fax number format.

传真号码格式错误。

Wrong Phone number format.

电话号码格式错误。

You must first delete the host mapping for the partitions whose index number is greater 
before you can change this partition.

必须首先删除索引号较大的分区的主机映射，然后才可以更改该分区。

You must first delete the host mapping for the partitions whose index number is greater or 
equal before you can delete this partition.

必须首先删除索引号较大的分区的主机映射，然后才可以更改该分区。

You must first delete the host mapping for this logical drive before you can delete it.

必须首先删除该逻辑驱动器的主机映射，然后才可以将其删除。

You must first delete the host mapping of the last partition before you can add a new 
partition.

必须首先删除最后一个分区的主机映射，然后才可以添加新的分区。

You selected “Event“ as the Trap Type, therefore, you must select at lease one Active trap 
event.

您选择了 “Event” 作为陷阱类型，因此必须至少选择一个 Active （活动）陷阱事件。 

You selected “My SMTP server needs authorization,“ therefore, you must enter a Password.

您选择了 “My SMTP server needs authorization （我的 SMTP 服务器需要授权）”，因此必

须输入一个密码。

You selected “My SMTP server needs authorization,“ therefore, you must enter a Username.

您选择了 “My SMTP server needs authorization （我的 SMTP 服务器需要授权）”，因此必
须输入一个用户名。

You selected “use encrypt,“ therefore, you must enter an encrypt key.

您选择了 “use encrypt”，因此必须输入一个密钥。
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词汇表

本附录列出缩略语并定义文档中出现的 RAID 术语。其中还包括对磁盘驱动器、逻辑驱
动器和冗余控制器的操作状况的定义。 

缩略语
ANSI 美国国家标准学会

CH 信道

CISPR 国际无线电干扰特别委员会

EMU 事件监控单元

FC-AL 光纤信道仲裁环路 FC-AL 作为环路或光纤实施。环路可包括达 126 个节点，可通
过仅一台或两台服务器访问这些节点。 

FRU 现场可替换单元

GB 千兆字节 （吉字节）。 10 亿 （1,000,000,000）字节。 

GBIC 千兆位接口转换器可热交换的输入 / 输出设备，能插入千兆位以太网端口或光纤
信道。

HBA 主机总线适配器

ID 标识号

IEC 国际电工技术委员会

JBOD 简单磁盘捆绑 (Just a Bunch of Disks) （阵列单元，带驱动器、没有控制器）

LAN 局域网

LD 逻辑驱动器

LUN 逻辑单元号。主要和次要设备号构成与计算机连接的特定设备的逻辑单元编号
顺序。
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LVD 低噪音、低功率、低振幅信令系统，实现支持的服务器和存储设备之间的数据通
信。 LVD 信令技术使用两根电线在铜线上传送一个信号，需要的电缆长度不应超
过 25 米 （82 英尺）。 

MB 兆字节。百万字节 (1,000,000) 或字符的数据。 

NVRAM 非易失性随机存取内存。一个配备有电池的存储单元；因此即使在主电源切断
后，数据仍然保持完整无损。

PID 辅助控制器标识号

RAID 独立磁盘的冗余阵列。一种配置，其中多个驱动器组合成单个虚拟驱动器以提高
性能和可靠性。

SAN 存储区域网络。存储设备和服务器的高速度、实行开放标准的可缩放网络，提供
对数据的加速访问。

SCSI 小型计算机系统接口。磁盘和磁带设备与工作站连接的行业标准。

SES SCSI 机箱服务驱动程序。与 SCSI Enclosure Services 设备的接口。这些设备能感
知和监控机箱内的物理状况，并且使访问机箱的状态报告和配置特性 （如机箱上
的标示器 LED 指示灯）成为可能。

SID 辅助控制器标识号

S.M.A.R.T. 自行监控分析和报告技术。这是 IDE/ATA 和 SCSI 两种硬盘驱动器的行业标准可
靠性预测标示。带 SMART 标示的硬盘驱动器能提供某些硬盘故障的早期警告，
因此能保护关键性数据。 

SMTP 简单邮件传输协议。在服务器之间或从邮件客户机向邮件服务器发送电子邮件的
协议。然后可以用使用 POP 或 IMAP 的电子邮件客户机检索邮件消息。 

SNMP 简单网络管理协议。管理复杂网络的一组协议。 SNMP 向网络的不同部分发送消
息 （称为协议数据单元，简称 PDU）。符合 SNMP 标准的设备 （称为代理）在
管理信息库 (MIB) 中存储与它们自己有关的数据，然后将数据返回给 SNMP 请求
者。 

WWN 全球广域名称。用以标识阵列系统和使用 Solaris 操作环境的系统中的阵列卷的
编号。
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名词术语

LUN 屏蔽 使管理员能将 HBA 动态地映射到指定 LUN 的特性。这就提供了个别服务器或多
台服务器对个别驱动器或多个驱动器的访问，并能禁止非期望的服务器对同样这
些驱动器的访问。

LUN 映射 改变虚拟 LUN 从存储器呈现给服务器的能力。这样做的益处包括服务器从 SAN 
启动而不需要本地磁盘驱动器。每台服务器需要 LUN 0 来启动。

N 端口 点对点或光纤连接中的光纤信道端口。

RAID 独立磁盘的冗余阵列。一种配置，即将两个或更多的磁盘驱动器配置为协作以提
供更多的磁盘存储空间、更好的性能以及 / 或者数据冗余备份。这些特性的各种
组合，是通过经过定义的 RAID 级别加以说明的。有关 RAID 级别的详细描述，
请参阅第 181 页的 “RAID 基本知识”。

背景率 背景率是分配给阵列管理活动 （如重建故障驱动器、检查奇偶校验、初始化）的
可用阵列控制器 CPU 时间的百分比。如果 background rate 设置为 100%，阵列
管理活动比其他系统活动具有更高的优先级。如果为 0%，则只有在阵列控制器上
没有其他活动时才会进行阵列管理活动。

备用驱动器 标为备用的驱动器，在与逻辑驱动器相关的物理驱动器发生故障后用以支持自动
重建数据。对于要替换其他驱动器的备用驱动器，其大小必须至少与故障驱动器
的大小相等。另外，故障驱动器本身也必须来自 RAID 1、 3、 5 或 1+0。

重建 重建磁盘是在磁盘故障以前重构磁盘上数据的过程。重建操作只能在具有数据冗
余的阵列上执行。 

请参阅第 292 页的 “自动重建”以获得更多有关重建的信息。要获得有关重建率
的信息，请参阅第 289 页的 “背景率”。 

带区大小 这是在逻辑驱动器中每个物理驱动器上进行带区化的数据量 （以千字节计）。数
值为 8 千字节的增量，范围从 8 至 64 千字节。一般情况下，大的带区对于具有基
本顺序读取的系统更有效。

要改变现有驱动器上的带区大小，需要对数据备份、重新定义带区大小、重新配
置存储器并重新存储所有数据。

带区化 在逻辑驱动器中所有不同的 SCSI 驱动器上存储顺序进入的数据块。例如，在逻
辑驱动器中有三个 SCSI 驱动器，数据会按以下方式存储：

数据块 1 在 SCSI 驱动器 1

数据块 2 在 SCSI 驱动器 2

数据块 3 在 SCSI 驱动器 3

数据块 4 在 SCSI 驱动器 1

数据块 5 在 SCSI 驱动器 2，等等。

数据的这个写方法能增加磁盘系统的吞吐量，因为多个驱动器同时在工作、检索
并存储。 RAID 0、 3、 5、 1+ 0 全都采用带区化。
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带外 指不在数据通路中的连接和设备。 

读策略 读策略说明如下：

如果指定 No Cache 读策略，控制器不在读高速缓冲存储器中存储数据。

Normal 指定当前控制器不对当前驱动器使用预读高速缓存。

将读策略设为 Read Ahead，控制器将自动读取多个相邻的数据块。对于顺序读
取应用，这是最有效的。

分区 磁盘存储空间的一部分，也称作系统驱动器或 LUN，这在主机看来是单独的物理
驱动器。逻辑驱动器可以位于一个或多个物理驱动器上。 

高速缓存 允许数据存储在磁盘上预先指定的区域或 RAM （随机存取内存）。高速缓存用
于加快 RAID 系统、磁盘驱动器、计算机和服务器或其他外围设备的操作。 

故障转移 容错系统的一种操作模式：一个组件发生故障时，其功能由冗余组件承担执行。 

光纤网 在一个或多个交换机上构建的光纤信道网络。 

光纤信道 部署在各种各样硬件之上物有所值的千兆位通信链接。

回写高速缓存 这是一项高速缓存写策略，阵列控制器接收将写入磁盘的数据，将数据存储在内
存缓冲区中，并立即向主机操作环境发送信号，表示写操作已完成，不必等待数
据实际写入磁盘驱动器。在很短时间内，当控制器不繁忙时，控制器即将数据写
入磁盘驱动器。

回写高速缓存功能提高了写操作的性能和控制器卡的吞吐量。然而，由于在发生
电源故障情况下有丢失数据的危险，使用回写高速缓存的存储系统配备有 UPS 或
电池备用高速缓存。 UPS 提供足够长时间的电源，使高速缓冲存储中的所有数据
能够写入磁盘驱动器。使用电池备用高速缓存，电池能够提供电源让内存数据保
留长达 48 小时。

伙伴组 一对互连的控制器单元。与这对控制器单元互连的扩展单元也可以是伙伴组的一
部分。

镜像 (RAID 1) 写入一个磁盘驱动器的数据同时写入另一个磁盘驱动器。如果一个磁盘发生故
障，可使用另一个磁盘运行系统并重构故障磁盘。磁盘镜像的主要长处在于 100% 
数据冗余。因为镜像了磁盘，如果有一个磁盘出故障就无关紧要。所有时候，两
个磁盘都包含相同的数据，哪一个都可以起操作盘的作用。

磁盘镜像提供 100% 数据冗余，但由于需要复制系统中的每个驱动器，因而代价
昂贵。

卷 也称为逻辑单元号或 LUN。卷是一个驱动器或能组合成一个数据存储单元的多个
驱动器。

可热交换 （的） 当系统保持通电并可操作时，取出并替换现场可替换单元 (FRU) 的这种能力。
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跨越 磁盘跨越利用固件的带区化功能，在两个本来是独立的 RAID 逻辑驱动器上进行
数据带区化。跨越的这两个逻辑驱动器作为一个逻辑驱动器呈现给操作环境。这
样做的长处在于：

支持组合容错逻辑驱动器中两个驱动器同时发生故障 （前提为每个逻辑驱动器中
有一个驱动器故障）。

由于增加了主轴数量而提高了性能。

其缺点在于：由于各个逻辑驱动器分别处理容错而增加了冗余 RAID 级别的 
RAID 总开销。

逻辑驱动器 一个独立物理驱动器阵列，在主机看来就像一个大驱动器。

奇偶校验 检查容错阵列 （RAID 1、 3、 5 和 6 或 1+0）上冗余数据完整性的过程。逻辑驱
动器上的奇偶校验过程重新计算每个逻辑驱动器的 RAID 带区集数据带区的奇偶
校验，并将其与存储的奇偶校验比较。如果发现差异，则报告错误，新的正确奇
偶校验替代存储的奇偶校验。

热备用 （驱动器） RAID 1 或 RAID 5 配置中的驱动器不包含任何数据，在另一个驱动器故障时起备
用作用。 

容错 处理内部硬件问题而并不中断数据可用性的能力；常用方法是在检测到故障时使
用已联机的备份系统。许多存储系统使用 RAID 架构给予在单个磁盘驱动器故障
时防止丢失数据的保护，从而提供容错。使用 RAID 1 （镜像）、 RAID 3 或 5
（带奇偶校验的带区化）或 RAID 6 或 1+0 （镜像和带区化）技术，阵列控制器
可以重构故障驱动器的数据，并将它写入备用或替换用驱动器。

容错逻辑驱动器 在单个驱动器故障情况下，通过使用 RAID 1、3、5 或 6（也称为 RAID 1+0）提
供数据保护的逻辑驱动器。

物理阵列 物理阵列是 Configuration Service 中参与一个或多个逻辑驱动器的一组物理驱动
器。如果一组物理驱动器配置为并不使用物理驱动器总容量的逻辑驱动器，
Configuration Service 要求同一个驱动器物理阵列与在创建使用其余容量的其余
任何逻辑驱动器中一起使用。

当剩余的驱动器容量是在多个物理驱动器上而后者已被用于创建一个逻辑驱动器
时，在 New Configuration 窗口中， Add Disk 按钮更改为 Add Array。鉴于物
理驱动器已被分片，就不得不将其作为一个阵列来选择。无法对其分别进行选
择。

现用 / 现用控制器 一对组件，例如在两者正常工作时共享一项或一组任务的容错存储系统中的存储
控制器。当其中一个组件发生故障时，另一个承担起整个负载。双现用控制器连
接同一组设备，提供的 I/O 性能和容错组合能力比单个控制器高。 

写策略 用以控制系统写操作的高速缓存写策略。写策略选项包括回写和直写高速缓存。

信道 在存储设备和存储控制器或 I/O 适配器之间用以传输数据并控制信息的任何通
路。也指磁盘阵列控制器上的一个 SCSI 总线。各个磁盘阵列控制器提供至少一
个信道。 
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直写高速缓存 一项高速缓存写策略，阵列控制器在向主机操作环境发送信号表示过程已完成之
前，即将数据写入磁盘驱动器。直写高速缓存的写操作和吞吐量性能比回写高速
缓存低；但是，在发生电源故障情况下丢失数据的危险也极小。

终端器 用于结束 SCSI 总线的部件。终端器通过吸收无线电频率信号来防止能量反射回
电缆线路。 

状况 磁盘驱动器、逻辑驱动器或冗余控制器的当前操作状态。存储系统在其非易失性
内存中存储驱动器、逻辑驱动器和冗余控制器的状况。该信息在系统供电中断时
仍保留。

自动重建 在驱动器发生故障后自动重构数据并写入备用驱动器的过程。手动安装新的驱动
器以替代故障驱动器后，也会进行自动重建。若重建进程因重置而中断，请使用 
Array Administration → Rebuild 来重新启动重建进程。

组 组是新的数据对象，允许在单个类别下包含多台服务器，与域的概念相似，允许
用户在 Configuration Service 内组织服务器。代之于所有受管服务器的线性树，
Configuration Service 操作员可以将服务器组织成相似的集或组。

组不是必需的。例如，可以配置 Configuration Service 为无组而有 15 台服务器，
或者一个组其下有 10 台服务器而顶层另有 5 台服务器。 Configuration Service 
允许任何组合。

许可的组数和组内服务器的数量仅受到可用系统内存的限制。如果服务器是一个
组成员而用户从组列表框删除了该组， Configuration Service 将组内的服务器重
新分配给无组类。 Configuration Service 自动地重新映射主窗口的树。
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Managed Servers 列表 , 179, 226
Server List Setup 窗口 , 226
Server List Setup 功能 , 207, 212
Server List Setup 命令 , 178
Server List Setup 图标 , 34
Server Login 窗口 , 43
Server Name 字段 , 38
Server Setup 窗口 , 178, 212, 226
View Server 窗口 , 98
View Server 命令 , 98
编辑 , 178
服务器的 TCP/IP 地址 , 38
服务器列表设置过程 , 37
服务器设置 , 226
更改分配 , 46
管理 , 42
库存 , 94
设置以发送陷阱 , 214
使用终端手动删除管理服务器 , 47
添加到 Managed Servers 列表 , 37
添加服务器属性 , 38
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通过控制台分配给控制器 , 44
组织到组中 , 41

服务器不响应 , 223

服务器分组 , 41

复制
成员驱动器 , 156

G
GBIC

定义 , 287

格式 , 56

更改控制器参数 , 165
Cache 选项卡

优化 , 168
更改设置按钮 , 166

更改信道设置窗口 , 166

更改主机 LUN 分配 , 75

工具条图标 , 34

固件
升级

SAF-TE 设备 , 164
SES 设备 , 164
控制器 , 159
硬盘驱动器 , 163

故障检修 , 223
Java 版本 , 224
另请参阅 错误代码

另请参阅错误消息

故障驱动器重建 , 131

管理工具组 , 56

H
HBA

双端口
Configuration Service 主窗口 , 98

HBA 设备

手动添加 , 82

Host I/F 选项卡 , 172

Host LUN Assignments 框 , 76
HP OpenView, 211, 218

故障检修 , 228
警告 , 214

红色设备状态项目 , 91

忽略了 ssmon 密码 , 39

环境
未报告警报 , 229
状况 , 108

黄色设备状态项目 , 91

恢复
逻辑驱动器配置 , 135

恢复逻辑驱动器配置 , 135

灰色设备状态项目 , 91

回写高速缓存
定义 , 290

I
IBM NetView, 214

IP 地址

群集配置 , 207
用于陷阱 , 216
在 DHCP 环境中已更改 , 226

Issue Controller Reset 复选框 , 174, 176

J
Java

版本
检查 , 224

JBOD
单总线配置 , 197
更换故障驱动器 , 202
监控 , 197, 203
升级 SAF-TE 设备的固件 , 201
升级硬盘驱动器上的固件 , 200
双总线配置 , 198

简单邮件传输协议 (SMTP), 214

监控过程 , 94

将分区映射到 LUN 的说明 , 186

警告
New Configuration, 66

镜像 (RAID 1), 290
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卷标
自动写入 , 71

K
可用 SCSI ID 列表框 , 167

可用文档 , xx

控制器
参数

更改 , 165
重新设置 , 138
更改服务器分配 , 46
恢复联机 , 139
静音 , 138
事件错误 , 249
通过控制台分配管理服务器 , 44
选择服务器来管理 , 44

控制器参数
保存更改 , 176

控制台
Configuration Service

安装在 Windows 上 , 19
在 Linux 操作环境上安装 , 25
在 Solaris 操作环境上安装 , 8

Windows 安装 , 19
Windows 要求 , 17
电子邮件设置 , 212
平台 , 2
设备未显示 , 228
运行缓慢 , 229

跨越 , 291

扩展
分区 , 153
逻辑驱动器的容量 , 153

L
Linux 操作环境

/etc/init.d/ssagent start/stop, 27, 28
/opt/SUNWsscs/ssconsole 目录 , 29
passwd 命令 , 29
ps -e | grep ss 用于获得进程号 , 28
service ssagent status, 28

SNMP 陷阱 , 217
sstrapd, 28
创建用户 / 密码 , 28
启动 / 停止代理 , 27
使用 rpm 卸装 , 30
停止控制台 , 33
系统要求 , 23
卸装 , 30
用户 / 密码 , 28

LUN, 55
Host LUN Assignments 框 , 76
LUN 详细信息 , 100
定义 , 183
更改主机 LUN 分配 , 74
删除 , 76
添加 , 75

LUN Filter Properties, 84

LUN 分配

最大 , 60, 69
最多 , 74

LUN 过滤器

访问 LUN Filter 视图 , 81
概述 , 79
将逻辑驱动器映射到主机 , 85
删除标准映射 , 84
手动添加 HBA 设备 , 82

LUNs Per Host 字段 , 172

联机帮助 , 91
为 Linux 指定浏览器 , 26
为 Solaris 指定浏览器 , 11

联机文档 , xxi

浏览器要求
通过 Web 管理存储设备 , 124

轮询
设备的状态更改 , 48

逻辑卷
创建 , 72, 144
定义 , 182
列出的逻辑驱动器 , 225

逻辑驱动器
Partitions 框 , 75
View Logical Drive 窗口 , 107
View Logical Drive 命令 , 106
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保存配置 , 53
创建分区 , 149
定义 , 182, 291
各 RAID 级别的驱动器最大数量 , 68
恢复配置 , 135
扩展容量 , 153
驱动器分配 , 184
容量超过 253 GB, 66
删除 , 146
删除分区 , 151
添加 , 142
添加 SCSI 驱动器 , 155
最大数量 , 60

逻辑驱动器号码 , 148

M
Major 字段 , 232

Managed Servers 列表设置 , 42

Max Queued IO Count 字段 , 172
MIB, 219
Microsoft Cluster Server (MSCS), 203

Minor 字段 , 233

mountall 命令 , 55

密码
Linux 操作环境

创建 , 29
Solaris 操作环境

创建 , 14
Windows

创建 , 20

N
Network 选项卡 , 175

New Configuration 窗口

Add Disk 按钮 , 291

newfs 命令 , 55

NT 群集选项 , 61
NTFS, 205

内存
要求

Configuration Service Console, 6, 23
Windows 上的 Configuration Service 

Console, 17
代理 , 6, 24

O
Out-of-Band Agent preferred over In-Band 复选框 , 122

P
performance statistics, 140

Physical Drive Standby State 窗口 , 177
pkgrm, 15

Power Up SCSI Reset 字段 , 171

Product ID 列表框 , 163

配置
Change Host LUN Assignments 窗口 , 75
clear 按钮 , 74
Confirm Configuration Operation 窗口 , 62
Custom Configuration, 62
Custom Configure, 62
Custom Configure 命令 , 165, 177
Load Configuration Confirmation 窗口 , 137
Load Configuration 窗口 , 136
Logical Drive Partitions 框 , 75
New Configuration, 66
New Configuration 警告 , 66
New Configuration 选项 , 64
NT 群集选项 , 61
Saveset Description 选项卡 , 136
Security Configuration 窗口 , 216
Security 选项卡 , 216
Standard Configuration 窗口 , 61
保存 , 53, 76
保存逻辑驱动器配置 , 76
标准配置 , 60
恢复 , 135
加载 , 135
逻辑驱动器

保存 , 53
清除 , 74
设置陷阱 , 215
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使用备用驱动器复选框 , 61
新

使用之前 , 64
选择 Configuration File 窗口 , 135
选择 RAID 级别 , 64
验证 , 51
注销 ssconfig, 74
注意 , 59

Q
启动

Configuration Service, 32

奇偶校验 , 128, 291
调度 , 129

启用动态 IP 分配 , 175

驱动器
Physical Drive Standby State 窗口 , 177
重建 , 133
复制并替换 , 156
扫描新的 , 158
实现 / 更改备用 , 177

驱动器重建 , 131, 132

取消映射
LUN, 76

全局备用驱动器
定义 , 182
与本地备用驱动器比较 , 195

全球广域名称
定义 , 288
在 Linux 中确定 , 210
在 Microsoft Windows NT/2000 中确定 , 210
在 Solaris OE 中确定 , 209

群集配置
CLUSTER.TXT, 206
IP 地址 , 207
Microsoft Cluster Server 软件 , 204
规划 , 203
启动 Configuration Service, 204, 206
设置 , 204
要求 , 204

R
RAID

Enclosure Info 选项卡窗口 , 102
RAID 控制器参数 , 102, 105
View Controller Configuration 命令 , 99
术语概述 , 181

RAID 词汇表 , 287

RAID 级别
RAID 0, 188
RAID 1, 188
RAID 1(0+1), 190
RAID 1+0 (10), 193
RAID 3, 191
RAID 3+0 (30), 193
RAID 5, 192
RAID 5+0 (50), 193
定义 , 289
分配给逻辑驱动器 , 61
支持的磁盘 / 逻辑驱动器的范围 , 187

Random I/O 参数的优化设置 , 168

Rebuild 窗口 , 133, 134

Redundancy 选项卡 , 174

Redundant Deassert Reset 字段 , 174

Redundant Force Pri Fail 字段 , 174

Redundant Force Sec Fail 字段 , 174

Report 图标 , 35

report 选项 , 114, 120

Reset 按钮 , 229
alarm state 框 , 108

rpm, 30

RS 232 选项卡 , 167
RSAGENT.DLL, 227

RST_OID.MIB 文件 , 218, 227

容错 , 291

容量
扩展 , 153
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S
SAF-TE 轮询时间长度 （秒）字段 , 171

Save Configuration 窗口 , 53, 54

Save Configuration 功能 , 53, 77

Save Report File 窗口 , 114

Save Report 命令 , 114

Saveset Description 选项卡 , 136

SCSI I/O 超时 （秒）字段 , 171

SCSI Motor Spin Up 字段 , 171

SCSI 驱动器

添加到逻辑驱动器 , 155

SCSI 信道

定义 , 183

Select Controller Progress 窗口 , 133

Server List Setup 窗口 , 178

Server Setup 窗口 , 179

Service Configuration 窗口 , 215
SES

定义 , 288

Set Controller Config 字段 , 174

Severity 字段 , 231

SMART Drive 字段 , 107

SMART 监控

启用 , 49

SMTP 电子邮件消息 , 211
SN#, 90
SNMP

MIB 变量的对象标识符 , 221
V1, 220
安全性 , 220
代理和管理器 , 219
服务选项 , 6, 18, 24
工作方式 , 218
管理信息库 , 219
请求类型 , 220
软件模型 , 219
协议数据单元 (PDU), 220
识别对象 , 219

SNMP 陷阱

设置 , 214
消息说明 , 218

Solaris
Configuration Service

安装在 , 8, 25
ssserver, 12, 28

Solaris 操作环境
/etc/init.d/ssagent start/stop, 12
/kernel/drv/sd.conf, 11
/opt/SUNWsscs/ssconsole 目录 , 14
passwd 命令 , 14
pkgrm 用于卸装 , 15
ps -e | grep ss 用于获得进程号 , 12
rstrapd, 227
SNMP 陷阱 , 217
sstrapd, 12
创建用户 / 密码 , 13
逻辑驱动器不存在 , 228
启动 / 停止代理 , 12
停止控制台 , 33
系统要求 , 5
卸装 , 15
用户 / 密码 , 13
支持的版本 , 2

sscsagt.cfg.tar, 15
sscscon.cfg.tar, 15
ssserver, 12, 28
sstrapd, 12, 28

sstrapd 守护程序 , 217, 218

Standard Configuration 图标 , 35
SUNWscsd, 8, 25
SUNWscsu, 8, 25

SuperFlex 存储阵列 , 205

扫描
驱动器 , 158

删除 , 151
分区 , 151
逻辑驱动器 , 146

设备
重建 , 132
未在控制台显示 , 228
详细视图信息 , 96
状态 , 91

社区字符串
检查 , 215

升级
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固件
SAF-TE 设备 , 164
SES 设备 , 164
控制器 , 159
硬盘驱动器 , 163

事件日志 , 110
错误代码 , 231
Event Log 窗口 , 111
Event Log 图标 , 34
eventlog.txt, 110, 111
Save Event Log 图标 , 34
事件记录字段 , 113
事件日志文件 , 111
严重级别 , 113

事件消息
严重级别 , 40

使用备用驱动器复选框 , 61

树视图 , 91

T
Tag Count Per drive 字段 , 171
TCP/IP, 17

建立连接 , 94
网络接口

要求 , 5, 23
探测 , 98

添加
SCSI 驱动器到逻辑驱动器 , 155
服务器 , 37
逻辑驱动器 , 142
新设备

探测 , 98
主机 LUN, 75

添加服务器属性参数 , 38

通过 Web 管理存储设备 , 124

图标
工具条

Custom Configuration, 35
带有盘式卫星天线的服务器 , 51
工具条

保存报告 , 35
保存事件日志 , 34
标准配置 , 35

服务器列表设置 , 34
事件日志 , 34

状态 , 91

V
View CD-ROM 窗口 , 106, 107

View 菜单，详细信息 , 96

View Enclosure 窗口 , 108

View Enclosure 命令 , 108
View FRU, 109

View FRU 窗口 , 109

View Report 命令 , 120

View Tape 窗口 , 107

W
Windows

2000 分区 , 57
NT 分区 , 56
Windows NT, 203
创建 NT 用户 , 21
创建 Win2000 用户 , 22
创建系统用户 / 密码 , 20
代理安装 , 19
代理要求 , 17
控制台安装 , 19
控制台要求 , 17
启动 / 停止代理 , 20
系统要求 , 17
卸装

Configuration Service, 22
用户 / 密码 , 20

Write a new label to the new LD 复选框 , 71
WWN

定义 , 288

网络
DHCP, 175
RAAP, 175
静态 IP, 175

文档
本书的组织结构 , xvii
使用 UNIX 命令 , xix
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文档意见 , xxi

物理驱动器
显示在 Configuration Service 主窗口中 , 36

物理设备
Physical Drives 选项卡 , 101
View Physical Device 窗口 , 107
查看物理驱动器 , 106

物理阵列 , 291

X
系统用户密码的使用 , 39

陷阱
Community Name 对话框 , 216
传输控制协议 (TCP), 218
Internet 协议 (IP), 218
IP 地址格式 , 216
Microsoft SNMP Properties 窗口 , 216
OID （对象标识符） , 218
Service Configuration 窗口 , 216
SNMP 陷阱消息 , 218
Trap Destinations 列表 , 216
Traps 选项卡 , 216
服务器地址和名称 , 218
事件日期 , 218
事件时间 , 218
事件严重性 , 218
网卡名称 , 218
未从服务器接收 , 226
陷阱接收者设置 , 216
在 Linux 上 , 217
在 Solaris 上 , 217

陷阱设置 , 214

陷阱守护程序
故障检修 , 228

陷阱消息 , 218

消息变量 , 253

消息术语 , 253

写策略
定义 , 291

卸装
Configuration Service, 15, 30

Linux 操作环境 , 30

Solaris 操作环境 , 15
Windows, 22

信道模式列表框 , 166

选项卡
说明的 , 36

选择 Configuration File 窗口 , 53, 77

Y
验证配置 , 51

严重级别 （事件） , 113

要求
安装

Linux 操作环境上的 Configuration Service 
Agent, 24

Linux 操作环境上的 Configuration Service 
Console, 23

Solaris 操作环境上的 Configuration Service 
Agent, 6

Solaris 操作环境上的 Configuration Service 
Console, 6

Windows 上的 Configuration Service 
Agent, 18

Windows 上的 Configuration Service 
Console, 17

内存
Linux 操作环境上的 Configuration Service 

Agent, 24
Solaris 操作环境上的 Configuration Service 

Agent, 6, 18
Windows 上的 Configuration Service 

Agent, 18

意见
发送给制造商 , xxii

硬盘驱动器
显示在 Configuration Service 主窗口中 , 36

Z
在开始安装 Configuration Service 之前

步骤 , 3

阵列管理控制器分配 , 44

直写高速缓存
定义 , 292
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主窗口 , 89

主机 ID
在 Fibre 配置中更改 , 167

主机 LUN
删除 , 76
添加 , 75

注销 , 43

装入配置，请参阅恢复逻辑驱动器配置

状态
电池 , 100
设备 , 91
组 , 92

自动重建 , 131
定义 , 292

紫色设备状态图标
设备状态状况 , 91

组
View Group 窗口 , 97
View Group 命令 , 97
定义 , 292
符号颜色 , 92
颜色 , 93
状态 , 92
组名称 , 37
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